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PC*MILER® Product Line 

 END-USER LICENSE AGREEMENT 
 
1. Grant of License:  Subject to the terms, conditions, use limitations and payment of fees as 
set forth herein, ALK Technologies, Inc. (“ALK”) grants the end-user (“you”) a license to install 
and use the PC*MILER solution(s) (including traffic data subscriptions) you have purchased 
(“PC*MILER”) on a single personal computer.  The PC*MILER software, data and 
documentation are provided for your personal, internal use only and not for resale.  They are 
protected by copyright held by ALK and its licensors and are subject to the following terms and 
conditions which are agreed to by you, on the one hand, and ALK and its licensors (including 
their licensors and suppliers) on the other hand. 

 
2. Title:  You acknowledge that the PC*MILER computer programs, data, concepts, 
graphics, documentation, manuals and other material by, developed by or licensed to ALK, 
including but not limited to program output (together, “program materials”), are the exclusive 
property of ALK or its licensors.  You do not secure title to any PC*MILER program materials by 
virtue of this license. 
 
3. Copies:  You may make one (1) copy of the PC*MILER program materials, provided you 
retain such copy in your possession and use it solely for backup purposes.  You agree to 
reproduce the copyright and other proprietary rights notices of ALK and its licensors on such a 
copy.  Otherwise, you agree not to copy, reverse engineer, interrogate or decode any PC*MILER 
program materials or attempt to defeat protection provided by ALK for preventing unauthorized 
copying or use of PC*MILER or to derive any source code or algorithms therefrom.  You 
acknowledge that unauthorized use or reproduction of copies of any program materials or 
unauthorized transfer of any copy of the program materials is a serious crime and is grounds for 
suit for damages, injunctive relief and attorneys' fees. 
 
4. Limitations on Transfer:  This license is granted to you by ALK.  You may not directly or 
indirectly lease, sublicense, sell or otherwise transfer PC*MILER or any PC*MILER program 
materials to third parties, or offer information services to third parties utilizing the PC*MILER 
program materials without ALK's prior written consent. To comply with this limitation, you must 
uninstall PC*MILER from your computer prior to selling or transferring that computer to a third 
party. 
 
5. Limitations on Network Access:  You may not allow end-users or software applications 
on other computers or devices to directly or indirectly access this copy of PC*MILER via any 
type of computer or communications network (including but not limited to local area networks, 
wide area networks, intranets, extranets, the internet, virtual private networks, Wi-Fi, Bluetooth, 
and cellular and satellite communications systems), using middleware (including but not limited 
to Citrix MetaFrame and Microsoft Terminal Server) or otherwise (including but not limited to 
access through PC*MILER connectivity products), or install or use PC*MILER on a network file 
server, without first notifying ALK, executing a written supplemental license agreement, and 
paying the license fee that corresponds to the number and types of uses to which access is to be 
allowed. 
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6. Limitations on Data Extraction:   You may extract data (including but not limited to 
program output such as distances, maps, and driving directions) from PC*MILER and use it in 
other applications on the same computer on which PC*MILER is legally licensed and installed.  
You may not transfer data extracted from PC*MILER onto any other computer or device unless 
you have licensed PC*MILER for that computer or device. 

 
7. Limitations on Mobile Communications:  Without limiting the generality of the foregoing, 
you may not transmit PC*MILER street-level driving directions through mobile communications 
systems such as Qualcomm, satellite, or cellular services or to mobile devices such as computers, 
handhelds, pagers, or telephones without first executing a written supplemental license agreement 
with ALK and paying the license fee that corresponds to the number and types of devices and 
systems to and through which transmission is to be permitted. 
 
8.  Limitations on Disclosure: You may disclose PC*MILER distances to trading partners for 
specific origin-destination moves for which you provide transportation services and use 
PC*MILER distances as a basis for payment.  You may not make any other disclosure of 
PC*MILER programs and materials, including but not limited to program output, to anyone 
outside the legal entity that paid for and holds this license, without prior written permission of 
ALK.  You acknowledge that the PC*MILER programs and materials by, developed by or 
licensed to ALK are very valuable to ALK and its licensors, and their use or disclosure to third 
parties except as permitted by this license or by a written supplemental license agreement with 
ALK is strictly prohibited. 
 
9.  Security:  You agree to take reasonable and prudent steps to safeguard the security of the 
PC*MILER program materials and to notify ALK immediately if you become aware of the theft 
or unauthorized possession, use, transfer or sale of the PC*MILER program materials licensed to 
you by ALK. 

 
10.  Acceptance:  You are deemed to have accepted the PC*MILER program materials upon 
receipt.  
 
11. Warranties:  ALK represents and warrants that:  
 

A. For ninety (90) days from date of purchase, PC*MILER, when delivered and properly 
installed, will function substantially according to its specifications on a computer 
purchased independently by you. 
 

B. For ninety (90) days from date of purchase, the software media on which ALK 
provides PC*MILER to you will function substantially free of errors and defects.  
ALK will replace defective media during the warranty period at no charge to you 
unless the defect is the result of accident, abuse, or misapplication of the product.  
 

C. THE FOREGOING WARRANTIES ARE IN LIEU OF ALL OTHER 
WARRANTIES EXPRESS OR IMPLIED, INCLUDING WITHOUT LIMITING 
THE GENERALITY OF THE FOREGOING ANY WARRANTY OF 
MERCHANTABILITY OR FITNESS FOR A PARTICULAR USE.  THE 
PC*MILER PROGRAM, DATA AND DOCUMENTATION IS SOLD "AS IS". IN 
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NO EVENT SHALL ALK OR ITS LICENSORS BE LIABLE FOR ANY 
INDIRECT, SPECIAL OR CONSEQUENTIAL DAMAGES SUCH AS, BUT NOT 
LIMITED TO, LOSS IN CONNECTION WITH OR ARISING OUT OF THE 
EXISTENCE OF THE FURNISHING, FUNCTIONING OR USE OF ANY ITEM OF 
SOFTWARE, DATA OR SERVICES PROVIDED FOR IN THIS AGREEMENT.  IN 
THE EVENT THAT A COURT OF PROPER JURISDICTION DETERMINES 
THAT THE DAMAGE LIMITATIONS SET FORTH ABOVE ARE ILLEGAL OR 
UNENFORCEABLE THEN, IN NO EVENT SHALL DAMAGES EXCEED THE 
CONTRACT PRICE.  THIS WARRANTY SHALL NOT ACCRUE TO THE 
BENEFIT OF THIRD PARTIES OR ASSIGNEES. 

 
12. Disclaimer: The data may contain inaccurate, incomplete or untimely information due to 
the passage of time, changing circumstances, sources used and the nature of collecting 
comprehensive geographic data, any of which may lead to incorrect results.  PC*MILER’s 
suggested routings and traffic data are provided without a warranty of any kind.  The user 
assumes full responsibility for any delay, expense, loss or damage that may occur as a result of 
their use.  The user shall have no recourse against Canada, whether by way of any suit or action, 
for any loss, liability, damage or cost that may occur at any time, by reason of possession or use 
of Natural Resources Canada data. 
 
13.  Termination:  This Agreement will terminate immediately upon any of the following 
events: 
 

A. If you seek an order for relief under the bankruptcy laws of the United States or 
similar laws of any other jurisdiction, or a composition with or assignment for the 
benefit of creditors, or dissolution or liquidation, or if proceedings under any 
bankruptcy or insolvency law are commenced against you and are not discharged 
within thirty (30) calendar days. 

 
B. If you materially breach any terms, conditions, use limitations, payment obligations, or 

any other terms of this Agreement. 
 
C. Upon expiration of any written supplemental license agreement between you and ALK 

of which this license is a part. 
 

14. Obligations on Termination:  Termination or expiration of this Agreement shall not be 
construed to release you from any obligations that existed prior to the date of such termination or 
expiration. 
 
15. Hold Harmless and Indemnity:  To the maximum extent permitted by applicable law, you 
agree: 

 
A. to hold harmless and indemnify ALK and its subsidiaries, affiliates, officers, agents, 

licensors, co-branders or other partners, and employees from and against any third 
party claim (other than a third party claim for Intellectual Property Rights) arising 
from or in any way related to your use of PC*MILER, including any liability or 
expense arising from all claims, losses, damages (actual and/or consequential), suits, 
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judgments, litigation costs and attorneys' fees, of every kind and nature. ALK shall use 
good faith efforts to provide you with written notice of such claim, suit or action; and 

 
B. to indemnify Canada and its officers, employees, agents and contractors from all 

claims alleging loss, costs, expenses, damages or injuries (including injuries resulting 
in death) arising out of your possession or use of Natural Resources Canada data. 

 
16. Canada: DISCLOSURE FOR PRODUCTS CONTAINING CANADIAN POSTAL 
CODE AND/OR CANADIAN STREET-LEVEL DATA:  Based on Computer File(s) licensed 
from Statistics Canada. © Copyright, HER MAJESTY THE QUEEN IN RIGHT OF CANADA, 
as represented by the Minister of Industry, Statistics Canada 2003-2011.   ALK Technologies, 
Inc. is an Authorized User of selected Statistics Canada Computer File(s) and Distributor of 
derived Information Products under Licensing Agreement 6147.  No confidential information 
about an individual, family, household, organisation or business has been obtained from Statistics 
Canada. 
 
17. Disclosure for products containing Historical or Real-time Traffic data:  traffic data, 
including historical traffic data, is licensed as a subscription service which must be renewed 
annually for continued use.   ALK and its licensor(s) will use commercially reasonable efforts to 
make traffic data available at least 99.5% of the time each calendar month, excluding minor 
performance or technical issues as well as downtime attributable to necessary maintenance, and 
Force Majeure. 
 
18. Limitations on Export: You hereby expressly agree not to export PC*MILER, in whole or 
in part, or any data derived therefrom, in violation of any export laws or regulations of the United 
States. 

 
19. Miscellaneous:  This Agreement shall be construed and applied in accordance with 
the laws of the State of New Jersey.  The Courts of the State of New Jersey shall be the 
exclusive forum for all actions or interpretation pertaining to this Agreement.  Any 
amendments or addenda to this Agreement shall be in writing executed by all parties hereto.  
This is the entire Agreement between the parties and supersedes any prior or 
contemporaneous agreements or understandings.  Should any provision of this Agreement be 
found to be illegal or unenforceable, then only so much of this Agreement as shall be illegal 
or unenforceable shall be stricken and the balance of this Agreement shall remain in full 
force and effect. 
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                        Introduction 
 

 
Welcome to ALK's PC*MILER®|Rail!  By purchasing PC*MILER|Rail, you 
have invested in a high-quality, user-friendly software package for determining 
railroad routes and mileage. 
 
Before you go any further, please read the license agreement beginning on page i.  
It explains ALK's copyrights as well as the terms of your agreement with ALK 
Technologies to license the use of PC*MILER|Rail software.  Unless you have a 
multi-user license, this copy of PC*MILER|Rail may only be installed on one 
single-user personal computer at a time.  
 
We advise you to make one backup copy of the software in case you need it, but 
DO NOT MAKE ANY ADDITIONAL COPIES OF THE CD-ROMS OR THIS 
DOCUMENTATION.  UNLESS YOU HAVE A MULTI-USER LICENSE, 
INSTALLATION OF PC*MILER|Rail ON MORE THAN ONE MACHINE IS A 
VIOLATION OF THE LICENSE AGREEMENT THAT YOU ACCEPTED UPON 
OPENING OR USING THE PC*MILER|Rail PROGRAM CD-ROMS.  Violating the 
license agreement is against the law, and ALK Technologies, Inc. will take proper 
legal action against any illegal use of the PC*MILER|Rail software. 
 

1.1  What Is PC*MILER|Rail? 

PC*MILER|Rail is point-to-point rail routing and mileage software.  Its powerful 
North American rail network contains over 240,000 miles of rail line, 49,678 
active freight stations, 765 rail carriers, and 4085 unique junction 
interchanges.  PC*MILER|Rail provides rail routes and mileage for rate 
determination and negotiation, equipment management, rail car mileage auditing, 
and carrier selection. 
 
Through ALK’s close working relationship with all major railroads, 
PC*MILER|Rail features the industry-leading electronic representation of current 
North American railroad routes and mileage.  For over 30 years, ALK’s 
railroad database has proven to be an accurate source for determining the 
routes and mileage used in processing the U.S. Surface Transportation 
Board’s Carload Waybill Sample.  It has also been used in numerous traffic 
diversion studies and in a variety of costing applications.  ALK’s railroad 
database is widely used by virtually all major railroads and rail car lessors.  
 
PC*MILER|Rail generates routes and determines mileage between any two rail-
served locations in North America.  Each location can be identified by station 
name and state abbreviation or by commonly used geographic codes.  With 
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PC*MILER|Rail you can quickly calculate the Shortest route (least distance) 
and/or the Practical route (based on historical operations) between any two points.  
You may specify interline junctions or let PC*MILER|Rail choose junctions by 
weighing location versus gateway importance.  A new Fuel Surcharge routing 
option is provided to accommodate the recent Surface Transportation Board 
ruling on mileage-based fuel surcharge calculations. Routings for Intermodal, 
Coal/Bulk and multi-level Auto Rack trains are also included. 
 
PC*MILER|Rail can also be used in conjunction with ALK’s PC*MILER|Rail-
Connect to generate mileages from within Microsoft® Excel®, display “pin maps” 
for integrated real time mapping, and provide seamless integration with other 
Windows-based transportation and logistics software.  An optional batch 
processing module, PC*MILER|Rail-BatchPro, enables quick processing and 
summarizing of large volumes of car location messages (CLM’s), SPLC codes or 
origin-destination pairs.   
 

1.2  Additional PC*MILER|Rail Solutions 

PC*MILER|Rail can be used on its own as a standalone product, or in 
conjunction with the following connectivity and batch processing applications: 
 
PC*MILER|Rail-Connect seamlessly interfaces PC*MILER|Rail routes, 
mileages and reports with transportation management software systems and third-
party software. Within other software applications, users can calculate 
PC*MILER|Rail mileage for an origin/destination pair of locations with 
intermediate stop-off points, display maps, run state-by-state mileage breakdowns 
and generate detailed station reports.  It also allows access to mileage and 
mapping information from within Microsoft® Excel®. 
 
PC*MILER|Rail-BatchPro enables users to quickly summarize empty, loaded, 
and total mileages by equipment ID, railroad, or state and province for a large 
number of rail movements.  Large volumes of origin/destination locations can be 
processed using a variety of geographic codes (identifiers) including station 
name/state abbreviation, SPLC, FSAC, ERPC (3-3-3) and R260. 
 
PC*MILER|Rail-TCP/IP provides an interface to PC*MILER|Rail-Connect trip 
calculation functions on Windows personal computers from any other computer 
platform over a TCP/IP network. 
 
PC*MILER|Rail Stations Geocode Files include a complete list of all 
PC*MILER|Rail freight stations by serving carrier and  contains Station 
Name/ST, SPLC, FSAC, 3-3-3, and R260 code information.  There are two 
versions of this file: one with latitude/longitude information and one without. 
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1.3  Recent New Features and Enhancements 

New features and enhancements in PC*MILER|Rail 20 include: 
 
 NEW!... Option to Change the Map Dataset.  The PC*MILER|Rail 

industry-standard rail network database is updated annually to include the 
most current data available for each version release, and three additional 
updates to the base data are provided throughout the year.  In previous 
versions, when users downloaded an update, the download process would 
overwrite their previous dataset with the new data.  Beginning in Version 20, 
each update is downloaded to a separate folder and users can choose which 
dataset to use at any time.  The active dataset will always be displayed in the 
title bar of the application window, for example “PC*MILER|Rail 
20.0_Base”.  See section 5.12. 

 NEW!...  Option to Disable “Check For Updates”.  The “Check For 
Updates” feature in the Help menu searches via the internet for any available 
updates that have not been installed to your version of PC*MILER|Rail.  This 
functionality can now be disabled by changing a line in the pcrwin.ini file that 
resides in your PC*MILER|Rail installation folder.  See section 2.13. 

 NEW!... Option to Save Window Position on Exit.  A new option in the 
Windows menu, when selected, saves the position of the PC*MILER|Rail 
application window on exit.  See section 3.7. 

 
 ENHANCED!… Up-to-Date Rail Network Data Reflects the Latest 

Changes in the Industry.  The PC*MILER|Rail industry-standard rail 
network database is updated annually to include the most current data 
available.  Throughout the year, ALK Technologies’ team of network editors 
and Geographic Information System (GIS) specialists gathers new data and 
incorporates customer feedback.  Version 20 data updates include the 
following additions and deletions: 

- Over 240,000 total miles of rail line 

- 49,678 active freight stations, including 245 new stations since Version 
19.0 

- 765 rail carriers, including a total of 24 new carriers since Version 19.0 
(listed below)  with 5 new carriers added since v19.3 (bolded below): 

 
New Rail Carriers Added in Version 20 

RRN SCAC RAILROAD NAME 
15 MAUP MANATEE COUNTY PORT AUTHORITY 

37 SC SANTA CRUZ AND MONTEREY BAY RAILWAY COMPANY 

41 AWRY ADAMS WARNOCK RAILWAY, INC. 

58 KGTR KINGMAN TERMINAL RAILROAD, LLC 

140 BTR BOUNDARY TRAIL RAILWAY COMPANY INC. 
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148 CHB CLEVELAND HARBOR BELT RAILROAD, LLC 

164 AIKR AIKEN RAILWAY COMPANY, LLC 

167 CLCY CHESSIE LOGISTICS CO., LLC 

181 TLE MIDWEST RAIL, LLC DBA TOLEDO, LAKE ERIE AND WESTERN RAILWAY 

206 BDR MCM RAIL SERVICES, LLC D/B/A BALTIMORE INDUSTRIAL RAILROAD 

215 CPR CATERPARROTT RAILNET, LLC 

275 LCRI LONG CREEK RAILROAD COMPANY INC 

338 MAN MANNING RAIL, INC 

348 NFTS THE NELSON AND FT. SHEPPARD RAILWAY CORPORATION 

363 LLR LAKE LINE RAILROAD INC. 

422 RPP RUSK, PALESTINE, & PACIFIC RAILROAD, LLC 

483 BHR BROOKHAVEN RAIL, LLC 

527 RVT ROGUE VALLEY TERMINAL RAILROAD CORPORATION 

573 TRV TORCH RIVER RAIL INC. 

581 CCH COLUMBUS & CHATTAHOOCHEE RAILROAD, INC 

596 SAC SAN ANTONIO CENTRAL RAILROAD, LLC 

662 LVSW LONGVIEW SWITCHING COMPANY 

836 HTR HEART OF TEXAS RAILROAD, LP 

988 OHIO OHIO TERMINAL RAILWAY COMPANY 

 
- 4,085 unique junction interchanges 

- Updated station locations 
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             Getting Started 
 

 

Before installing PC*MILER|Rail, please make sure that you have the required 
hardware and software configuration.  
 
NOTE: PC*MILER|Rail is a standalone product.  The underlying data that the 
application uses is installed along with the product.  The data is stored in binary 
format that only the product can read.  No other database application is required 
to run PC*MILER|Rail.  
 

2.1  System Requirements 

 
Environment:  Stand-alone or networked personal computers 

(LANs and Server/Thin Client Networks) 

Platforms:  PC/LAN Windows® (2003, Vista, XP, Server 2008 and 
Windows 7, includes 64-bit support running in 32-bit 
compatibility mode)  NOTE: Windows 95, Windows 
98 and  Windows 2000 will not be supported.  We are 
strongly recommending that you upgrade your 
operating system. 

 Citrix Metaframe and Windows Terminal Services 

 TCP/IP functionality for use with other platforms 
 

Requirements:  PC with a minimum 700 MHz processor (1-2 GHz 
recommended)  

 60 MB hard disk space and 512 MB of RAM 
  
For PC*MILER|Rail-Connect: 
 Additional 10 MB hard disk space 
 Microsoft Excel  
 A development system for the PC*MILER|Connect 

interface. (Interface definitions for Borland C++ 4.0 
and Visual Basic 3.0 are currently supported, although 
many other systems can also utilize the DLL.) 

These additional components will also be installed: 
 Microsoft Visual C++ 2005 Redistributable Package 

(x86) -  Disk space 6 MB 
 WindowsInstaller-KB884016-v2-x86.exe (x86) – Disk 

2 C
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space 2 MB 
 .NET dotnetfx.exe (x86) – Disk space 280 MB 
 
For PC*MILER|Rail-BatchPro: 
 Additional 5 MB hard disk space 
 
For PC*MILER|Rail-TCP/IP: 
 Additional 2 MB hard disk space 
 PC with 1.5-2 GHz processor and TCP/IP capability 
 UNIX or other host with TCP/IP capability 
 Physical connection (cable) 
 Client software on the UNIX or other host (sample 

PERL application provided) 
 

Other 
Requirements: 

 CD/DVD Drive 
 Screen Resolution 800x600 
 Color Quality Settings Supported: 16-bit and 32-bit 
   (8-bit not supported) 
 Internet Connection for License Activation 
   (manual license activation also available) 
 Email Address for License Activation 
   (manual license activation also available) 
 

Microsoft Windows 
Update 
Requirements 

The following service pack updates are required for 
Windows users. You can access these updates by 
regularly using the Windows Update feature or by going 
directly to Microsoft’s website.  The following 
requirements are the minimum level of maintenance 
needed to run PC*MILER. 
 Windows XP Service Pack 2 
 Windows Server 2003 Service Pack 1 
 

2.2  General Licensing Information 

Single-User License 

A single-user license can be installed to only one PC locally. 
 

Additional Copy License 

Users can install PC*MILER|Rail locally onto additional PC’s by purchasing 
additional copy licenses. If you purchase five copy licenses, you can install 
PC*MILER|Rail locally onto five additional PC’s or workstations. If you are 
installing onto a desktop PC and a laptop, two licenses are needed. 
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Multi-User License 

A multi-user license can be installed to a server environment, on the computer 
that will be sharing the licenses to other computers. It allows “x” number of 
concurrent workstation connections to PC*MILER|Rail at a time. For example, a 
5-User License allows PC*MILER|Rail to be installed on a central server or PC 
with as many workstation PCs as you want to have access, but it only allows five 
users to access PC*MILER|Rail at a time. 

 
Enterprise License 

An Enterprise License allows you to install PC*MILER|Rail on any combination 
of end-user PCs or workstations without limitations.  It’s a cost-effective 
installation and licensing solution for larger enterprises with several users.  It does 
not require license activation but requires signing an enterprise supplemental 
license agreement directly with ALK. 
 

2.3  Installation Types 

Non-Network (Local) Installations 
A non-network installation allows you to install PC*MILER|Rail to a PC or 
workstation locally, not onto a server environment to be shared with other 
computers. 
 
Network Installation 
A networked installation allows you to install PC*MILER|Rail on network file 
servers where each end-user can save their own option settings or can share 
option settings that are stored on the server. 
 
Citrix/Terminal Services Installation 
PC*MILER|Rail can be installed onto a Citrix Server or Terminal Services 
environment, if you have purchased a license to do so.  Each end-user must have a 
license to gain access. 
 
Trial Installation 
A trial installation is a 15-day license to access PC*MILER|Rail features and 
data. 
 

2.4  Important Notes 

PC*MILER|Rail Interfaces 
For those who are interfacing any PC*MILER|Rail component to a third-party 
system, please contact the vendor directly to make sure that the interface to this 
new version of PC*MILER|Rail is updated and complete before you install. 
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Website Support Center 
Please check ALK’s Website Support Center for posted updates and patches.  Go 
to www.alk.com/support. 
 
Microsoft Vista and Windows 7 Users 
Your license must be installed and activated using an Administrator Account.  
Once installed, you do not need to “Run as an Administrator” provided you install 
to the recommended default directory or to another directory that doesn’t require 
useres to “Run as an Administrator”. 
 
Data Execution Prevention (DEP) Setting 
On some versions of Windows, DEP might close PC*MILER|Rail without any 
type of error message.  If that happens, do the following: open the Windows Start 
menu and go to Settings > Control Panel > System and Security > System > 
Advanced System Settings > Advanced tab > Performance Setting > Data 
Execution Prevention tab.  Select “Turn on DEP for essential Windows 
programs and services only”. 
 

2.5  Single User Installation  

NOTE: Have your Product Key Code on hand before beginning the installation 
process. It will be emailed to you from alkservices@alk.com in an email titled, 
“PC*MILER Software Order…” (Enterprise License customers excluded, see 
note in Step 4 below). “Single” will be included in the above Product Key email 
signifying that you have purchased a single-user license. If this is not listed, 
please contact a PC*MILER Sales Representative to purchase the correct license. 
 

BEFORE INSTALLING, please double-check that the emailed Product Key 
Code(s) lists all purchased components. For example, the code shown below 
unlocks the following components: PC*MILER|Rail, PC*MILER|Rail-Connect, 
and PC*MILER|Rail-BatchPro. 
Order #: SO-000000001 
Product Order #: PC*MILER|Rail 20 
Date: 9/16/2013 10:33 AM 
Product Key Code: 3QYKJ-V2KJ7-KJ2F5-82KJ2-KJ2F2 
== PC*MILER|Rail 20 (Single), BatchPro, Connect 

 
UNINSTALLING AN OLDER VERSION: If you need to uninstall a previous 
version of PC*MILER|Rail on the computer that you are now installing to, you 
must uninstall the previous version before installing PC*MILER|Rail 20. If you 
do not need to uninstall, it is possible to have both versions  
of the desktop program installed on the same system. Please note that 
PC*MILER|Rail-Connect will be updated to the new version. 
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To install your single-user version of PC*MILER|Rail, follow these steps: 
 

1. First start Windows, then place the PC*MILER|Rail Install DVD into your 
CD/DVD drive and the installation will start automatically.  If it does not start 
automatically, click on the Windows Start menu, select Run… then type: 
“d:\setup.exe” and click OK.  (If your CD/DVD drive is not your D drive, 
substitute the letter that designates your CD/DVD drive.) 

IMPORTANT NOTE for Windows 7 Users:  You will need to install 
PC*MILER|Rail as an administrator. If you are not the designated 
administrator on your computer, you will receive a warning message.  Once 
the application is installed, you won’t have to “Run as an Administrator” to 
use it provided you install to the default directory or to another directory that 
does not require the user to be an administrator.   

To install as an administrator, cancel the installation if necessary (click 
Cancel and then Finish) and then follow these steps: 1) Open Windows 
Explorer and navigate to the installation folder on your CD/DVD drive (for 
example, D:\Rail_20_0);  2) Right-click on the setup.exe file in the 
installation folder and select “Run as administrator”;  3) If the install doesn’t 
begin automatically, double-click on the setup.exe file to start the installation 
process again. 

2. A Welcome screen will open initializing the installation. Click Next to review 
the terms and conditions of the End-User License Agreement.  To continue 
installing, you must accept the terms of the license agreement by clicking the 
Yes button. If No is selected, the setup will not continue. 

3. When prompted, enter your User Name and Company Name.  Click Next to 
continue. 

4. Enter your Product Key Code. This 25-character code will be emailed to you 
from alkservices@alk.com in an email titled, “PC*MILER Software Order…” 
The code can be copied and pasted.  If typing the Product Key Code, dashes 
are not required – dashes, spaces, or no spaces are all acceptable.  Click Next 
when finished. 

NOTE: As a convenience to our Enterprise License customers, your Product 
Key Code is hard-coded into the installation for you and is valid for each 
install. 

5. Step 5A: 

Next, the Select Features dialog box will open listing the PC*MILER|Rail 
Solutions that were purchased.  By default, the products that were purchased 
should already be checked.  Clear the checks next to any components that you 
don’t want to install. 



 
  

 

 PC*MILER|Rail User’s Guide 10 

 
NOTE:  If you have a Multi-User Product Key Code and need to perform a 
Single-User install, please contact PC*MILER Sales to purchase the correct 
license. 

Step 5B: 

Below the list of products in the Select Features dialog box, you will see the 
Destination Folder that defines where all components will be installed.  To 
install to the default directory (recommended), do not make any changes and 
click Next. 
 
To install to a location other than the default, click Browse to select another 
folder.   Be sure to add “Pcrwin20” to the end of the new path. For example: 
C:\Apps\PCRWin20.  If you don’t, PC*MILER|Rail will install to the root of 
the specified directory. Click Next when finished. 
 

6. Next, a dialog box will open titled Start Copying Files, listing the installation 
settings that will be used to copy files onto the workstation. To change any 
setting, select Back. If you are satisfied with the settings, click Next to 
continue.  

If you have a previous version of PC*MILER|Rail-Connect installed, an alert 
will appear on the screen with the following message: “The install found a 
previous version of Connect. These files will be renamed with a .bak 
extension.” If both products were previously installed on the computer you are 
now installing to, two dialog boxes will open. Click OK in the dialog box(es) 
to continue. 

7. Follow through with the rest of the installation.  This may take some time 
depending on the speed of the computer you are installing to.  Do not exit or 
reboot the computer during the installation.  If any error messages appear, 
please contact Technical Support.   

8. When the installation is complete, you will be prompted to view the 
ReadMe.txt and to activate your license.  Leave these boxes checked and 
click Finish to proceed.  When the ReadMe opens, review the information 
presented, and then close the window when finished. 

NOTE: ALK provides a 15-day temporary license prior to completing the 
activation process. If you make a second attempt to install on the same 
computer, you will lose this 15-day temporary license. If you experience an 
activation error and need access  to PC*MILER|Rail before Technical 
Support is available, please do not attempt a second install without assistance. 
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9. License Activation: 

If you are an Enterprise License Customer, you can bypass the next license 
activation steps of the install (Steps 10 and 11) because you are already 
activated and registered with ALK.  To continue, answer No in the License 
Status window, then click the arrow next to Continue in the right hand 
column to complete the installation. Proceed to Step 12. 
 
If you are not an Enterprise License Customer, the License Status Screen 
will open to activate your license.  If the computer you are installing to has an 
Internet connection and you have a valid email address, the license activation 
process will automatically initiate.  In the License Status Window, click on 
the arrow next to Activate in the right hand column to begin the Automatic 
Desktop Activation.  Review the information on the screen then click Next to 
continue.  Internet license activation is available 24 hours a day. 
 

NOTE: If you don’t have an active Internet connection or email address, 
please contact Technical Support during business hours for assistance.    

10. When prompted, enter your email address.  Click Next to continue. 

11. When the activation process is complete, a message on the screen will say 
“License Activated Successfully”.  Click Finish to continue.  When the 
License Status window reopens, verify that the License Status in the left- 
hand column says Licensed.  Click the arrow next to Continue in the right- 
hand column to complete the activation process. 

If you activated your license using Automatic Desktop Activation, an email 
titled, “PC*MILER|Rail 20 Activation Code for Product XXXXX...” will be 
sent to the email used in Step 10 from alkservices@alk.com. If you activated 
your license automatically and LICENSED is in the Status field of the License 
Status Window, no further action is necessary with the activation code listed 
in the email. If LICENSED is NOT in the Status field of the License Status 
Window, please activate your license with the new activation code listed in 
the email. To do so, click Activate, then check the Activate Manually box 
and click Next. In the Enter Activation Code field, enter in the activation code 
from the email. 

12. To start PC*MILER|Rail once the installation is complete, click the 
PC*MILER|Rail icon on your desktop or click the Windows Start button 
and select All Programs (or the equivalent in your version of Windows) > 
PCMILER Rail 20 > PCMILER Rail 20 or the PC*MILER|Rail Solution 
you installed. 
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2.6  Multi-User Network Installation 

NOTE: Have your Product Key Code on hand before beginning the installation 
process. It will be emailed to you from alkservices@alk.com in an email titled 
“PC*MILER Software Order…” (Enterprise License customers excluded, see 
note in Step 5 below.) “(X-User)” will be included in the Product Key email, 
signifying that you have purchased a multi-user license. If this is not listed, please 
contact a PC*MILER Sales Representative to purchase the correct license. 
 
BEFORE INSTALLING, please double-check that the emailed Product Key 
Code(s) lists all purchased components. For example, the code shown below 
unlocks these components: PC*MILER|Rail and PC*MILER|Rail-Connect. 
Order #: SO-000000001 
Product Order #: PC*MILER|Rail 20 
Date: 9/16/2013 10:33 AM 
Product Key Code: 3QYKJ-V2KJ7-KJ2F5-82KJ2-KJ2F2 
== PC*MILER|Rail (XX-User), Connect 
 
ADDITIONAL NOTES: 
 You have two options for launching the installation (setup.exe): 1) You can 

do a ‘From Console’ installation, running the setup.exe directly on the 
server’s console or from a simulated console session like Remote Desktop; or 
2) You can do a ‘From Workstation’ installation, running the setup.exe on a 
workstation connected to the server and redirecting the installation to install 
PC*MILER|Rail 20 onto your server. 

 There is an activation requirement that you share the top level of the 
PC*MILER|Rail Installation (‘Pcrwin20’ folder) with full control for all 
users. After activation, you minimally need to grant read/write permissions to 
all network users. 

 If you need to uninstall a previous version of PC*MILER|Rail on the 
computer that you ar enow installing to, you must uninstall the previous 
version before installing PC*MILER|Rail 20.  If you do not need to uninstall, 
it is possible to have both versions of the desktop program installed on the 
same system.  Please note that PC*MILER|Rail-Connect will be updated to 
the new version. 

 
To install PC*MILER|Rail 20 on a network, follow these steps: 
 
1. First start Windows and create a new folder on the server called Pcrwin20. 

Right-click on this folder and select Properties > Sharing, then click 
Permissions and give Full Control to everyone. (If full control is an issue, 
you can reduce your selection to Change and Read after activating your 
installation). Click Apply, then OK to continue 

NOTE:  Mapped drives are NOT recommended!   
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NOTE Also:  Common mistakes that will lead to a license activation failure 
are: 1) Not sharing the ‘Pcrwin20’ folder with full control for all users (Step 1 
above); and 2) Not directing the installation to this shared ‘Pcrwin20’ folder 
in step 6B below. For example, during a ‘From Console’ or a ‘From 
Workstation’ install, if you create and share the folder E:\Apps\Pcrwin20 on 
your server, you must change the Destination Folder from C:\Alk 
Technologies\Pcrwin20 to E:\Apps\Pcrwin20 or \\Server\pcrwin20 during step 
6B below. 

 
2. Place the PC*MILER Install DVD into the CD/DVD drive and the 

installation will start automatically.  If it does not start automatically, click on 
the Windows Start menu, select Run… then type: “d:\setup.exe” and click 
OK.  (If your CD/DVD is not the D drive, substitute the letter that designates 
your CD/DVD drive.) 

IMPORTANT NOTE for Windows 7 Users:  You will need to install 
PC*MILER|Rail as an administrator. If you are not the designated 
administrator on your computer, you will receive a warning message.  Once 
the application is installed, you won’t have to “Run as an Administrator” to 
use it provided you install to the default directory or to another directory that 
does not require the user to be an administrator.   
 
To install as an administrator, cancel the installation if necessary (click 
Cancel and then Finish) and then follow these steps: 1) Open Windows 
Explorer and navigate to the installation folder on your CD/DVD drive (for 
example, D:\Rail_20_0); 2) Right-click on the setup.exe file in the installation 
folder and select “Run as administrator”; 3) Now double-click on the 
setup.exe file to start the installation process again.  Depending on permission 
settings, these steps may need to be performed on workstations as well. 

 
3. A Welcome screen will open initializing the installation. Click Next to review 

the terms and conditions of the End-User License Agreement. To continue 
installing,  you must accept the terms of the license agreement by clicking the 
Yes button. If No is selected, the setup will not continue. 

 
4. When prompted, enter a User Name and Company Name and click Next. 

5. Enter your Product Key Code.*  This 25-character code will be emailed from 
alkservices@alk.com in an email titled “PC*MILER Software Order…”  The 
code can be copied and pasted.  If typing the Product Key Code, dashes are 
not required – dashes, spaces, or no spaces are all acceptable.  Click Next 
when ready. 

 

*NOTE: As a convenience to Enterprise License customers, the Product Key Code is hard-
coded into the installation for you and is valid for each install. 
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6. STEP 6A.   

Next, the Select Components dialog box will open listing the PC*MILER 
Solutions that were purchased.  By default, products that were purchased 
should already be checked. Clear the checks next to any components that you 
do not want to install. 
 
NOTE: If you are not able to maximize the installation window once 
minimized, go to the Task Manager to do so. Open the Task Manager, go to 
the Applications tab, select the PC*MILER Install in the list, and click the 
Switch To button to maximize the install again. 

NOTE: For Non-Enterprise users, if you uncheck Multi-User in the list of 
components, it will not be possible for you to activate your install without 
contacting Technical Support. 

STEP 6B.  

Below the list of products in the Select Features dialog box you will see the 
Destination Folder that defines where all components will be installed.  Click 
Browse to select the newly created shared directory (…\Pcrwin20) that you 
created in Step 1.  If you skipped Step 1, you MUST minimize the install 
and share your destination folder, giving Full Control for all users.  Click 
Next to continue.   

7. An additional screen will open verifying the install location. Please verify that 
the newly created shared directory on the server has been chosen. To 
change any setting, select Back. If you are satisfied with the settings, click 
Next to continue. 

 
If you have chosen to install to the default directory, a dialog box will appear 
asking you to confirm this location. Please make sure this folder is shared 
with full access rights to each workstation. Otherwise, click No and change 
the install destination. 

 
NOTE: Full access rights must be applied to the default directory.  

8. Next, a dialog box will open titled Start Copying Files, listing the installation 
settings that will be used to copy files onto the workstation. To change any 
setting, select Back. If you are satisfied with the settings, click Next to 
continue. 

 
If you have a previous version of PC*MILER|Rail-Connect installed, an alert 
will appear on the screen with the following message: “The install found a 
previous version of Connect. These files will be renamed with a .bak 
extension.” If both products were previously installed on the computer you are 
now installing to, two dialog boxes will open. Click OK in the alert 
window(s) to continue.  
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9. Next, a dialog box will open prompting you to enter the “UNC Path To Your 
Server”. If you know the name of your server, type in \\ServerName\Pcrwin20\ 
where “Pcrwin20” is the Share name from Step 1 or 6 above (trailing backslash 
is required) - then skip to Step 11. If you do NOT know the name of your 
server and cannot enter it, leave the UNC Path box blank and click Next. 
 
TIP: To determine the server name, right mouse click the My Computer icon 
and choose “Properties” from the menu that pops up (or left click Start > 
Settings >  Control Panel > System), then click the Computer Name tab. Copy 
the value up to but not including the first period (.) in the name if the name 
contains periods. For “From Console” installations, it’s best to do a 
copy/paste to avoid typos. 

 
10. In the next screen you will be asked if you are installing ‘“Remotely from 

Workstation” or “Directly on Server”. Choose “Remotely from Workstation” 
if you are on a PC that is connected to your server. Choose “Directly on 
Server” if you are installing from the Server’s Console or a simulated Console 
Session like a Remote Desktop. Click Next after making your choice. 
 
NOTE: For the “Remotely from Workstation” installation you will only need 
to click OK in the UNC Path Screen that pops up. 

IMPORTANT NOTE: For “Directly on Server” installation, you will need to 
change computers. Leave your console session and walk to another PC. On 
that second PC, browse over to your server to the Pcrwin20 folder (or other 
share name created in Step 1 or 6 above), and run (double-click) Uncpath.exe. 
Click OK in the screen that pops up, and then walk back to your console 
session and press OK. 
 

11. Complete the rest of the installation. This may take some time depending on 
the  speed of the computer you are installing to. Do not exit or reboot the 
computer  during the installation. If any error messages appear, contact 
Technical Support. 

 
NOTE: You may see the message, “Launching Vcerdist_x86.exe. Please 
wait…” This is part of the installation and may take some time to complete. 

12. When the installation is complete, you will be prompted to view the 
ReadMe.txt and to activate your license. Leave these boxes checked and 
click Finish to proceed.  When the ReadMe opens, review the information 
presented and then close the window when finished. 
 
NOTE: ALK provides a 15-day temporary license prior to completing the 
activation. If you make a second attempt to install, you will lose this 
temporary license.  If you  experience an activation error and need 
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access to PC*MILER|Rail before Technical Support is available, please do 
not attempt a second install without assistance. 

13. To activate your license: 

If you are an Enterprise License customer, you can bypass the next license 
activation steps of the install (steps 14 and 15) because you are already 
activated and registered with ALK.  To continue, answer No in the License 
Status window.  Click the arrow next to Continue in the right hand column to 
complete the installation process.  Proceed to Step 16.  

If you are NOT an Enterprise License customer, the License Status 
window will open to activate your license.  If the computer you are installing 
to has an Internet connection and you have a valid email address, the license 
activation process will automatically initiate.  In the License Status window, 
click on the arrow next to Activate in the right hand column to begin the 
Automatic Desktop Activation.  Review the information on the screen, then 
click Next to continue.  Internet license activation is available 24 hours a day. 
 
NOTE: If you don’t have an active Internet connection or email address, 
please contact Technical Support.    

 
14. When prompted, enter your email address.  Click Next to continue. 

 
15. When the activation process is complete, you will receive a message on the 

screen saying “Desktop License Activated Successfully.”  Click Finish to 
continue. When the License Status window reopens, verify that your license 
status in the left-hand column says Licensed.  Click the arrow next to 
Continue in the right-hand column to complete the activation process. 

16. CRITICAL STEP, DO NOT SKIP! If you activated your license using 
Automatic  Desktop Activation, an email will be sent from 
alkservices@alk.com titled “PC*MILER Activation Code for Product...” to 
the email address that was entered during the activation processes.  
 
 If you activated your license automatically and LICENSED is in the 

Status field of the License Status Window, attached to this email is 
your license file (net.lic). Net.lic holds the license or user count for your 
installation. Until you save this net.lic to …\\server\pcrwin20\ (replace 
existing file), you will have only a single user installation.   

 
After saving the net.lic file, click on Start > Programs > PCMILER Rail 
20 > License Status. Please check that the user count listed matches the 
purchased amount. For example, you will see “1 of 5” or “1 of 10” at the 
top of the screen. Also check that the License Status says LICENSED. If 
assistance is needed, please contact Technical Support during business 
hours.  
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 If LICENSED is NOT in the Status field of the License Status 
Window, please activate your license with the new activation code listed 
in the email. To do so, click Activate, then check the Activate Manually 
box and click Next. In the Enter Activation Code field, enter in the 
activation code from the email. 

 If you are an Enterprise Customer: If your License Status is not 
“LICENSED” close the License Status screen by pressing Continue. 
Click Start > Programs > PCMILER Rail 20 > License Status. Your 
status should now be LICENSED. 

 
17. After installing and activating PC*MILER|Rail to the Server, you’ll need to 

run the <server>\Pcrwin20\setup.exe on each individual PC or 
workstation.  To do this, click on the Windows Start menu, select Run then 
enter the path to the PC*MILER|Rail 20 Network setup.exe on the network.  
The default location is…\Pcrwin20\Network. Example:\\mainsrv\pcrwin20\ 
network\seteup.exe 

Workstation Setup Options – During the workstation setup you will be 
asked what type of setting you would like each to use.  The options are: 

 Local Setting – Allows each workstation to customize default options 
and settings within the application. 

 Network Settings – Provides each workstation the same default 
options and settings within the application.  

 
NOTE: Enterprise customers only. If your workstation’s license failed to self-
activate, you can correct the issue by running the License Status Screen twice.  
To  do so, click Start > Programs > PCMILER Rail 20 > License Status, and 
then click Continue to close the screen. Next, click Start > Programs > 
PCMILER Rail 20 > License Status a second time and your License Status 
should be LICENSED. 

2.7  Citrix and Terminal Services Installations 

NOTE: Have your Product Key Code on hand before beginning the installation 
process. It will be emailed to you from alkservices@alk.com in an email titled, 
“PC*MILER Software Order…” (Enterprise License customers excluded, see 
note in Step 7 below).  “Citrix/Terminal Services” will be included in the above 
Product Key email signifying that you have purchased a Citrix or Terminal 
Services license. If this is not listed, please contact an ALK Sales Representative 
to purchase the correct license. 

NOTE: Before installing, please double-check that the emailed Product Key 
Code(s) lists all purchased components.  For example, the code below unlocks the 
following component: PC*MILER|Rail-BatchPro. 



 
  

 

 PC*MILER|Rail User’s Guide 18 

Order #: SO-000000001 
Product Order #: PC*MILER|Rail 20 
Date: 9/16/2013 10:33 AM 
Product Key Code: 3QYKJ-V2KJ7-KJ2F5-82KJ2-KJ2F2 
== PC*MILER|Rail 20 (Citrix/Term Server), BatchPro. 

NOTE: If you need to uninstall a previous version of PC*MILER|Rail on the 
computer that you are now installing to, you must uninstall the previous version 
before installing PC*MILER|Rail 20.  If you do not need to uninstall, it is 
possible to have both versions of the desktop program installed on the same 
system.  Please note that PC*MILER|Rail-Connect will be updated to the new 
version.  

NOTE: Steps 1 and 2 are not required for Windows Server 2003 installs, please 
skip to Step 3. If you are not installing to Windows Server 2003, please start at 
Step 1. 
 
1. First, go to the Windows Start menu, then Settings > Control Panel > Add 

or Remove Programs. 

2. In the Add or Remove Programs dialog box, choose Add New Programs > 
CD or Floppy option.  This will put the Citrix/Terminal Server into Install 
Mode. 

3. Insert the PC*MILER Install DVD into the CD/DVD.  Click Next for 
Windows to detect the DVD.   

4. Windows will attempt to locate the setup.exe on the DVD.  If it does not, 
click Browse, locate the CD/DVD drive and select the setup.exe.  Click 
Finish. 

 

IMPORTANT NOTE for Windows 7 Users:  You will need to install 
PC*MILER|Rail as an administrator. If you are not the designated 
administrator on your computer, you will receive a warning message.  Once 
the application is installed, you won’t have to “Run as an Administrator” to 
use it provided you install to the default directory or to another directory that 
does not require the user to be an administrator.   

To install as an administrator, cancel the installation if necessary (click 
Cancel and then Finish) and then follow these steps: 1) Open Windows 
Explorer and navigate to the installation folder on your CD/DVD drive (for 
example, D:\Rail_20_0); 2) Right-click on the setup.exe file in the installation 
folder and select “Run as administrator”; 3) Now double-click on the 
setup.exe file to start the installation process again. 

5. A Welcome screen will open initializing the installation, click Next to review 
the terms and conditions of the End-User License Agreement.  To continue 
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installing, you must accept the terms of the license agreement by clicking the 
Yes button.  If No is selected, the setup will not continue. 

6. When prompted, enter your User Name and Company Name.  Click Next 
when finished. 

7. Enter your Product Key Code.*  This 25-character code will have been 
emailed from alkservices@alk.com in a message entitled “PC*MILER 
Software Order…”  The code can be copied and pasted.  If typing the Product 
Key Code, dashes, spaces, or no spaces are all acceptable.  Click Next when 
finished. 

 

NOTE:  You need a unique Product Key Code for each individual server you 
are installing to. 

NOTE:  As a convenience to our Enterprise License customers, the Product 
Key Code is hard-coded into the installation and is valid for each install. 

8. STEP 8A: 

Next, the Select Components dialog box will open listing the 
PC*MILER|Rail Solutions that were purchased.  By default, products that 
were purchased should already be checked. Clear the checks next to any 
components that you do not want to install. 
 

NOTE: Enterprise License customers must uncheck the Multi-user 
component if it is checked. 
 
STEP 8B: 

Below the list of products in the Select Components dialog box, you will see 
the Destination Folder that defines where all components will be installed on 
the computer that you are installing to.  To install to the default directory 
(recommended), do not make any changes and click Next. 

If you decide to install to a different location other than the default, click 
Browse to select a directory.  Be sure to add “Pcrwin20” to the end of the 
new path.  For example: d:\apps\Pcrwin20.  If you don’t, PC*MILER|Rail will 
install to the root of the specified directory.  Click Next when finished. 
 

9. Next, a dialog box will open titled “Start Copying Files”, listing the 
installation settings that will be used to copy files onto the workstation. To 
change any setting, select Back. If you are satisfied with the settings, click 
Next to continue 

 
If you have a previous version of PC*MILER|Rail-Connect installed, an alert 
will appear on the screen with the following message: “The install found a 
previous version of Connect. These files will be rename with a .bak 
extension.” If both products were previously installed on the computer you are 
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installing to, two dialog boxes will open. Click OK in each dialog box(es) to 
continue. 
 

10. Follow through with the rest of the installation.  This may take some time 
depending on the speed of the computer you are installing to.  Do not exit or 
reboot the computer during the installation.  If any error messages appear, 
please contact Technical Support. 
 

NOTE: You may see the message “Launching Vcredist_x86.exe. Please 
wait…” This is part of the installation and may take some time to complete.  

11. When the installation is complete, you will be prompted to view the 
ReadMe.txt and to activate your license.  Leave these boxes checked and 
click Finish to proceed.  When the ReadMe opens, review the information 
presented then close the window when finished. 

 

NOTE: ALK provides a 15-day temporary license prior to completing the 
activation process.  If you make a second attempt to install you will lose this 
15-day temporary license.  If you experience an activation error and need 
access to PC*MILER|Rail before Technical Support is available, please do 
not attempt a second install without assistance.     

12. License Activation: 

If you are an Enterprise License Customer, you can bypass the next license 
activation steps of the install (Steps 13 and 14) because you are already 
activated and registered with ALK.  To continue, answer No in the License 
Status window, then click the arrow next to Continue in the right-hand 
column to complete the installation.  

If you are NOT an Enterprise License Customer, the License Status 
screen will open to activate your license.  If the computer you are installing to 
has an Internet connection and you have a valid email address, the license 
activation process will automatically initiate.  In the License Status window, 
click on the arrow next to Activate in the right hand column to begin the 
Automatic Desktop Activation.  Review the information on the screen then 
click Next to continue.  Internet license activation is available 24 hours a day. 
 

NOTE: If you don’t have an active Internet connection or email address, 
please contact Technical Support during business hours for assistance.   

13. When prompted, enter your email address.  Click Next to continue. 

14. When the activation process is complete, you will receive a message on the 
screen saying “Desktop License Activated Successfully.”  Click Finish to 
continue.  When the License Status window reopens, verify that your license 
status in the left hand column says Licensed.  Click the arrow next to 
Continue in the right hand column to complete the activation process. 
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If you activated your license using Automatic Desktop Activation, an email 
titled, “PC*MILER Activation Code for Product XXXXX...” will be sent to 
the email used in Step 13 from alkservices@alk.com.  

If you activated your license automatically and LICENSED is in the Status of 
the License Status Window, no further action is necessary. If LICENSED is 
NOT in the Status field of the License Status Window, please activate your 
license with the new activation code listed in the email. To do so, click 
Activate, then check the Activate Manually box and click Next. In the Enter 
Activation Code field, enter in the activation code from the email. 
 

2.8  PC*MILER|Rail-Connect Add-In To Microsoft Excel 

If PC*MILER|Rail-Connect is installed, the following files are placed in your 
Excel folder in the PC*MILER|Rail directory (usually C:\ALK 
Technologies\Pcrwin20\Excel): 
 

pcrstest.xls       An Excel spreadsheet containing illustrative examples of 
pcrsrv32.dll calls (for mileage calculations). 

pcrss32.xla The PC*MILER|Rail-Connect Excel Add-In for route and 
mileage calculations. 

pcrmtest.xls An Excel spreadsheet containing illustrative examples of 
pcrmmp32.dll calls (for mapping calls). 

pcrmmp32.xla The PC*MILER|Rail-Connect Excel Add-In for mapping. 

  
Network Installation 
 
In order to use the server, xlsetup.exe must be run on each client machine.  To do 
this, first install PC*MILER|Rail-Connect to the network directory; then, from 
each workstation choose Start > Run… and enter the path of the xlsetup 
program.  For example, if PC*MILER|Rail is installed on the network drive n:\ in 
the Pcrwin20 directory, you would type: n:\Pcrwin20\excel\xlsetup.exe.  This 
will set up icons for the logging engine and on-line Help. 
 
Enabling the Excel Add-Ins 
 
There are two PC*MILER|Rail Add-Ins available for Microsoft Excel.  You must 
enable the Add-Ins manually from within Excel.  Excel can be configured to load 
the Add-Ins each time you open the program. 
Follow the steps below to set up the pcrss32.xla Add-In for mileage calculations.  
For setting up the Add-In for mapping, repeat with pcrmmp32.xla.   
 
If you are running Microsoft Office 2003 (or older): 
 

1. Start Excel.  
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2. In the Tools menu, select Add-Ins… > Browse.  

3. Navigate to the folder where PC*MILER|Rail is installed and open the Excel 
folder.  The default location of the Excel folder is … \ALK 
Technologies\PCRWINXX\Excel.  (“XX” refers to the PC*MILER|Rail 
version number, for example PCRWIN20 for PC*MILER|Rail 20.  

4. In the …\Excel folder, click on the PCRSS32.XLA file, then click OK.  

5. If you're installing from the network, a dialog box will appear that says "Copy 
'PCRSS32.XLA' to Microsoft Excel Add-In Library?"  You can choose Yes 
to make a local copy or No if you don't wish to.  In either case 
PC*MILER|Rail-Spreadsheets will install properly. 

6. In the Add-Ins dialog box, “PC*MILER|Rail-Spreadsheets” will appear in the 
list of products with a check next to it. Click OK to continue.  The 
PC*MILER|Rail-Connect Excel functions are now ready to be used and will 
be available every time you start Excel. 

If you are running Microsoft Office 2007 (or newer): 
 

1. Click the Microsoft symbol in the upper left hand corner of the Excel window. 

2. In the list that opens, at the bottom click on the Excel Options button. 

3. In the dialog box that opens, in the left hand column menu click on Add-Ins. 

4. In the right hand side of the dialog box, there's a drop down menu next to 
“Manage”.  Scroll that drop down menu and choose Excel Add-Ins.  Click the 
Go button to continue. 

5. In the Add-Ins dialog box that opens, click Browse and navigate to the folder 
where PC*MILER|Rail is installed and go to the Excel folder.  The default 
location of the Excel folder is …\ALKTechnologies\ 
PCRWINXX\Excel. (“XX” refers to the PC*MILER|Rail version number, for 
example PCRWIN20 for PC*MILER|Rail 20.) 

6. In the …\Excel folder, click on the PCRSS32.XLA file, then click OK. 

7. In the Add-Ins dialog box, “PC*MILER|Rail-Spreadsheets” will appear in the 
list of products with a check next to it. 

8. Click OK to continue. 

9. Next, you must enable Macros in Office 2007.  To do so, click on the 
Microsoft symbol in the upper left hand corner of the screen. 

10. In the list that opens, at the bottom click on the Excel Options button. 

11. In the dialog box that opens, in the left hand column menu listing click on 
Trust Center. 
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12. In the left hand column, click on Add-Ins and uncheck each box on the right 
side of the window. 

13. In the left hand column, click on Macro Settings. In the right hand side of the 
window, under the question "For macros in documents not in a trusted 
location", click the radio button next to the last option (Enable all macros).  
At the bottom, leave the box checked next to "Trust access to the VBA project 
object model." 

14. Click OK at the bottom of the dialog box to exit. The PC*MILER|Rail-
Connect Excel functions are now ready to be used and will be available every 
time you start Excel. 

2.9  Adding a New Product To Your PC*MILER|Rail Installation 

You may find that you want to purchase an additional PC*MILER|Rail Solution 
sometime after the initial installation of PC*MILER|Rail.  To purchase and install 
an additional product at a later time, follow these steps: 

 
First, call PC*MILER Sales at 800.377.6453 (or 1.609.683.0220 outside of the 
U.S.), 9:00am-5:00 pm EST, Monday-Friday to purchase the product and obtain a 
new Product Key Code to license and install the new solution(s). 
 
To add the new product to your installation, follow the steps below: 
 
Single-User Standalone and Multi-User Network Install: 

1.   Insert the PC*MILER|Rail Install DVD into the CD/DVD drive. 

2.  In the Installation Wizard, choose “Modify” and click Next. 

3.   Keep the User Name and Company Name as is and click Next. 

4.   Replace the existing Product Key Code with your NEW Product Key Code 
and click Next to continue. 

5.   In the Select Components dialog box, make sure ALL new and existing 
products are checked. 

6.   Follow through with the rest of the installation.  You must reactivate your 
license. 

 
Multi-User Network Installs – Steps for Individual Workstation Set-ups: 

1.  Browse to the shared \pcrwin20 folder on your Server. 

2.  Double-click on the Network folder and run setup.exe. 

3.  Choose “Reinstall Network Components”. 

4.  Follow through with the rest of the installation.   
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2.10  Deactivating and Uninstalling Your License 

You must fully deactivate your product license and uninstall all PC*MILER|Rail 
components, including local, network, enterprise, or server installations if you 
are: 
 

 Moving any PC*MILER|Rail installation to a new computer; 
 Reformatting a computer that PC*MILER|Rail is currently installed to; 
 Returning the product; 
 Reinstalling on the same PC. 
 
You have two options for deactivating your license and uninstalling:  1) If 
you have an Internet connection on the computer where PC*MILER|Rail is 
installed, the deactivation process can be done automatically; or 2) If there is no 
Internet connection, a manual deactivation process is available.   
Please follow the instructions below: 
 
1. Deactivation 

 
Automatic Deactivation: 
If you have an available Internet connection, go to the Windows Start menu, 
then Programs > PCMILER-Rail 20 > License Status and click on the arrow 
next to Deactivate. Another dialog box will open, click Next and the 
deactivation process will automatically begin.  If the Deactivation Code 
appears on the screen, please write down the code for your records.   
 

Manual Deactivation: 

For manual deactivation (those without an Internet connection), go to the 
Windows Start menu, then Programs > PCMILER-Rail 20 > License Status 
and click on the arrow next to Deactivate. The Deactivation Verification 
Code dialog box will appear.  
 
Before clicking OK, you must provide ALK with the code that appears in the 
window, as it is required as proof of deactivation.  Please write down the code 
for your records.  If you are returning the product, you must include this 
Deactivation Code on the provided Return Form.  Click OK when finished. 
 
NOTE: The Deactivation Code is not programmatically recorded during the 
manual deactivation process. Please write down the code.  It will also be 
written to ...\pcrwin20\alk_da.dat; do not delete this file. 

2. Next, go to My Computer > Control Panel > Add/Remove Products to 
uninstall all PC*MILER|Rail components. 

 
3. In the Add/Remove Products window, highlight PC*MILER|Rail 20 in the list 

of software applications – scroll the list if necessary – and proceed with the 
program removal. 
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2.11  Technical Support Options 

ALK Technologies offers free technical support to all users of PC*MILER|Rail 
and related products.  If you have any questions about PC*MILER|Rail or 
problems with the software that can’t be resolved using the product user’s guides 
or online Help, contact ALK Technologies. 
 
Hours: 9:00am - 5:00pm, Mon-Fri, Eastern Standard Time 

Phone: 1.800.377.6453, ext. 2 or 1.609.683.0220, ext. 2 

Email: pcmrail@alk.com (or use the Email Technical Support option 
in the Help menu); or 
raildata@alk.com for all data-related feedback and questions 

Please include your Product Key Code and product version 
number (e.g. 20.0.1) in all correspondence.  To find this 
information, go to the Help menu > About. 

Fax: 1.609.252.8108   ATTN: PC*MILER|Rail Technical Support 

Web Site: www.alk.com (click Support > PC*MILER|Rail) 
 

2.12  Email Us Your Data Corrections 

Simply select Email Data Correction in the Help menu or email us at 
raildata@alk.com to inform ALK Technologies about any data errors that you 
may encounter while using PC*MILER|Rail.  ALK values your input and will 
incorporate any errors you report into future releases of the software. 
 

2.13  Check for Updates 

Select Check for Updates in the Help menu to check via the internet for any 
available updates to PC*MILER|Rail (patches or quarterly data updates).  If no 
updates are available, a message to that effect will be displayed.  If there are 
updates, a list will be returned and you will have the option to download them. 
 
To disable this functionality, locate the pcrwin.ini file in your PC*MILER|Rail 
installation folder (the default location is C:\ALK Technologies\PCRWIN20).  
Open this file using a text editor such as Notepad or Wordpad (in Windows 
Explorer click with the right mouse button), and you will see the following line in 
the [OPTIONS] section: 
 
CheckForUpdatesAllowed=TRUE 
 
Simply change “=TRUE” to “=FALSE” and save the file to disable updates.  This 
line can be changed back to TRUE at any time. 
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2.14  PC*MILER|Rail Help Files 

PC*MILER|Rail includes a complete system of on-line Help that can be accessed 
through the Help menu or Help button on the tool bar in the main application 
window, or by clicking on any Help button in a dialog box or window.  
PC*MILER|Rail Help buttons are context-sensitive, so the topic invoked with a 
button will pertain to the open dialog box.  From there you can search further. 
 
From the Help menu, selecting Contents will open a help window with two panes.  
The left pane will display a Contents tab that lists topics of general interest.  Click 
on the plus sign ( + ) next to any topic to see the “pages” underneath.  Double-
click on any page to open it in the right pane of the help window.  The Index tab 
displays a scrollable index of key words or phrases.  Use the Search tab to search 
for all instances of a keyword. 
 
To access help for PC*MILER|Rail BatchPro or Connect, click the Windows 
Start menu and select Programs (or the equivalent in your version of Windows) 
> PCMILER Rail 20 > and open the BatchPro or Connect folder. 
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           Menus and the Tool Bar 
 
 

Each menu option available in PC*MILER|Rail is briefly described below.  Tool 
bar buttons and shortcut keys that can be used instead of a menu option are shown 
where available.   
 

 
 
 

3.1  File Menu     

 
New Route 
 

 
 

Open a route entry window for a new route. 
 

Duplicate Route Duplicate the active route window for easy route 
comparisons. 

Open Route... 
 

 
 

Open a previously saved route. 
 

Close Close the active route (the route won’t be saved). 
 

Close All > Routes: Close all open routes without saving. 
Reports: Close all open reports without saving. 
 

AutoRouter                         F6 
 

 
 

Open the AutoRouter to run a route using 
PC*MILER|Rail’s AutoRouter. 
 

Save Route 
 

 
 

Save the active route with the current filename. 
 

Save Route As... 
 

Save the active route with a new user-specified 
file name. 
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Save Report As… Save the active report with a new user-specified 
file name. 
 

Print … 
 

 
 

Print the contents of the active window. This 
option will say “Print Report”, “Print Route”, or 
“Print Map”, depending on which window is 
active. 
 

Page Setup... Open the Page Setup dialog box to control print 
options. 
 

Exit                             Alt + F4 Exit PC*MILER|Rail, returning to the Desktop.  
When you exit, all active windows are saved as 
they appear on your screen for the next time 
PC*MILER|Rail is opened. 
 

3.2  Edit Menu      

 
Copy Map/Report/Routes/ 
AutoRoutes 
 

Copy the active report, route(s) or map to the 
clipboard for use with other programs such as 
Microsoft Word. Depending on which window is 
active, this option will say Copy Map, Capy 
Report, Copy AutoRoutes, or Copy Route. 
 

Insert Stop                          F7 Insert a stop above the one that is highlighted on 
the stop list in the active route entry or 
AutoRouter window. 
 

Delete Stop                         F8 Delete the stop that is highlighted on the stop list 
in the active route entry or AutoRouter window. 
 

Delete All Stops        Alt + F8 Delete all stops in the route entry or the 
AutoRouter window. 

 

3.3  Map Menu 

 
TIP: You can also open a Map menu by clicking the right mouse button when your cursor 
is inside the map window. 

 
Zoom In 
 

 
 

Zoom in by a factor of two; can be repeated for 
closer views; increases detail. 
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Zoom Out 
 

 
 

Zoom out by a factor of two; can be repeated; 
decreases detail. 
 

Frame > 
 

 
 

Frame US Window, NA Window, or Routes; 
when checked, Auto Frame Route 
automatically frames all routes when they are 
generated. 

 
Features... Invoke the Features dialog box to control which 

features are drawn on the map. 
 

Redraw Redraw the current display in the map window. 

Railroads… Open the Railroad Display Control dialog box to 
indicate which railroads should be drawn on the 
map.  This dialog can also be used to frame 
specific railroads and show track ownership. 
 

Pick/Label > 
 

 

 

 

 
 

Pick Stops: Enable user to select stops with the 
mouse for route entry. 

Label Stations: Enable user to label and hide 
locations with the mouse. 

Label RRs: Enable user to label and hide 
railroads with the mouse. 

Clear Labels: Delete all labels that have been 
added manually. 

 
Detail > Add to, reduce, or return to the default number of 

links and place names drawn on the map (choose 
More, Less, or Default).  Show rail curves in 
more detail by drawing them using "shape points" 
instead of angles (select Use Shape Points). 
 

Station Labels > Specify how stations are labeled: using either 
their Station ST name or SPLC. 
 

Legends > Show/Hide the Route Legend, Carrier Legend, 
and Scale of Miles (choose one or more). 
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3.4  Route Menu 

     
Run                                     F10 Generate the route entered in the currently active 

route entry window. 
 

Options                               F4 Open the Options dialog box to assign a name to a 
route and to select a route type, route formula, and 
terminal switch inclusion or exclusion.  You can 
also assign an automatic header to reports using 
this dialog box. 
   

Default Options… Open the Default Options dialog box to change 
the default settings for routing options.  All the 
available options are the same as in the Options 
dialog box. 
 

3.5  Reports Menu     

 
Detailed Report                   F5 
 

 
 

Generate a Detailed Report for the route in the 
active window. 
 

Key Station Report    Alt + F5 
 

 
 

Generate a Key Station Report for the route in the 
active window. 
 

Detailed Geocode Report 
 

                                          Ctrl + F5 

Generate a Detailed Geocode Report for the route 
in the active window. 

 
 
 

3.6  Tools Menu    

 
Change Map Dataset Change the map dataset – see section 5.12. 

Datasets need to be downloaded first, using 
“Check For Updates” in the Help menu.  
  

Manage Custom Places    F2 Open the Custom Place Manager window, where 
you can add custom station names to the 
database. 
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Manage Junction 
Avoid/Favors  
                                    Alt + F2 
 

Open the Avoid/Favor Junctions in AutoRouter 
dialog box to designate junction interchange 
preferences for interline routes. 
 

Tool Bar > Large Buttons: Switch to large buttons on the 
tool bar.  Large buttons display text that indicates 
what they are used for. 
 
Small Buttons: Switch to small buttons on the 
tool bar.  This ensures that the whole tool bar 
will be displayed on your screen. 
 
None: Hide the tool bar. 
 

3.7  Windows Menu     

 
Default Window > Choose whether the AutoRouter or single route 

entry window should open automatically when 
PC*MILER|Rail is started. 

Default Window Position > Save on Exit: The next time PC*MILER|Rail is 
started, the application window will open in the 
same position on your monitor as when it was 
last closed. 

Centered: The PC*MILER|Rail application 
window will always open in a centered position 
on your monitor. 
 

Cascade Cascade all windows from the upper left corner 
of the program window. 
 

Tile Organize all open windows in a side-by-side 
"tile" arrangement. 

Arrange Icons Arrange the icons representing minimized 
windows in the lower left corner of the program 
window. 

1 AutoRouter Activate the AutoRouter window and bring it to 
the front. 

2 Map – Track Ownership Activate the map window and bring it to the 
front. 
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3.8  The Help Menu     

 
Content Open PC*MILER|Rail's on-line Help. 

 

Topic Look Up                    F1 
 

 
 

Open Help for the open dialog box or window. 
 

Menus Open the Menu Reference section of Help. 
 

Keyboard Open a list of function keys in PC*MILER|Rail. 
 

State Names…                   F3 Open a reference table of official 
state/province/estado abbreviations.  
 

Railroads > Open a reference table of railroad names and 
abbreviations, sorted by SCAC or railroad name. 
Choose Sorted by SCAC or Sorted by RR.  
 

Fuel Surcharge… 
 

Open a reference list of railroads that use 
Practical mileage vs. those that use Shortest 
mileage for fuel surcharge calculation. 
 

Email Technical Support Send an email to PC*MILER|Rail Technical 
Support. 
 

Email Data Correction Report an error in the database.  All data 
corrections will be sent to the ALK data team for 
review and inclusion in future releases. 
 

Check For Updates Check if there are updates available and download 
them.  See section 2.13. 
 

About... Display general information about 
PC*MILER|Rail, including version number, serial 
number and name of the licensed user of the 
program. 
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3.9  PC*MILER|Rail Shortcut Keys 

Keystrokes in PC*MILER|Rail that provide shortcuts to various menu options 
and features are listed below. 
 

Key(s) Function 
 

F1 Invoke the Topic Look Up in on-line Help 

F2 Invoke the Custom Place Manager 

Alt-F2 Invoke the Avoid/Favor Junctions dialog box 

F3 Display a scrollable list of state abbreviations 

Alt-F3 Display a list of railroad names and abbreviations sorted by SCAC 

Ctl-F3 Display a list of railroad names and abbreviations sorted by name 

F4 Invoke the Options dialog box for the active route 

Alt-F4 Exit PC*MILER|Rail 

Ctrl-F4 Close the active route entry window or AutoRouter window 

F5 Display the Detailed Report for the active route  

Alt-F5 Display the Key Station Report for the active route 

Ctrl-F5 Display the Detailed Geocode Report for the active route 

F6 Open or activate the AutoRouter window 

F7 Insert a stop above the one highlighted on the stop list 

F8 Delete the stop that is highlighted on the stop list 

Alt-F8 Delete all stops in the single route entry window 

F9 Display the map window 

F10 Generate routes and distances ("Run")   
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Two Sample Routes:  
A First Look at PC*MILER|Rail 

 
 

To open PC*MILER|Rail, double-click on the PC*MILER|Rail icon that was 
placed on your desktop during installation.   
 
 
 

The AutoRouter window will be open in the main application window:  
 
 

 
PC*MILER|Rail Main Screen – Initial View 

 

 
PC*MILER|Rail features two basic methods of route entry: 
 

 Single Route Entry: If you know a route and simply want to generate the 
mileage, you can enter the sequence of locations and railroads manually in 
the single route entry window (File menu > New Route).   

 AutoRouter: If you want PC*MILER|Rail to suggest possible junctions 
and connecting railroads between two points, you can use the AutoRouter 
feature to use preferred routes (File menu > AutoRouter). 

Both types of route entry are briefly described in this chapter using sample routes.  
For more detailed instructions, see Chapter 5, Basic Features of PC*MILER|Rail. 
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4.1  Single Route Entry Window: Atlanta, GA to Rahway, NJ 

If you know a route and simply want to generate mileage, select New Route from 
the File menu, then enter the origin in the Station ST or the Geocode field in the 
route entry window that opens.  To do this, first select the type of code to be used 
in the top left corner of the window, then click on an entry field and begin typing.   
 
For this sample route we’ll go with the default code type (SPLC).  Type “atlanta 
ga” in the Station ST field (no comma – if you enter a comma you’ll get a 
“Not Found” error message), then press the <Enter> key on your keyboard.  
Highlight the CSXT option on the pick list that pops up and click OK. 
 
Now enter the intermediate stops and destination in the same way.  
PC*MILER|Rail always considers the last stop on the list as the destination of 
your route.  Let’s enter baltimore md, trenton nj, and rahway nj in that order, 
and CSXT as the railroad for the whole route.  
 

 

 
Pick List of Railroads Serving Atlanta, GA  

 
 

 
Route From Atlanta, GA to Rahway, NJ – CSXT   
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After entering the route, click on the Options button to see the various routing 
options. Using the Options dialog box, you can change the parameters used for 
route calculation, assign a name to the route, and use the report memo area to 
include a customized note on printed reports. 

 

 
Options Dialog Box  

 
 
For this route, we’ll use PC*MILER|Rail’s default options and only change the 
route name.  Type “Atlanta-Rahway” in the Route Name field, then click OK to 
close the dialog box. 
 
To run the route, click on the Run button or press the F10 key.  Mileage appears 
in the route entry window when processing has finished.  To print the contents of 
this window, select Print Route from the File menu while the window is active. 

 
 

 
Generated Mileage From Atlanta, GA to Rahway, NJ – CSXT   

 
 

To clear the route entry window and begin entering another route, select the Edit 
menu > Delete All Stops.  Or you could choose New Route from the File menu to 
open a new route entry window, keeping the route from Atlanta to Rahway open.  
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4.2  Using the AutoRouter: Atlanta, GA to El Paso, TX 

To access the AutoRouter, choose File menu > AutoRouter or simply click the 
AutoRouter window to activate it if it is already open.  The AutoRouter feature is 
a valuable tool for determining which railroads serve the origin or destination, 
and how they connect via intermediate junctions.  It enables you to set customized 
railroad routing preferences and get back several routes to choose from.  
 
For the purposes of the example below, click on the Options button, set the Route 
Formula to Intermodal, and then click OK to return to the AutoRouter. 
 
For a route between Atlanta and El Paso, type “atlanta ga” as the origin in the 
Station ST field (no comma, entering a comma will return a “Not Found” 
message) and press the <Enter> key on your keyboard.  Choose CSXT from the 
pick list that opens.  Railroads that actually serve the origin will appear in the 
Origin RR’s scroll list below, where you can choose to include or exclude each 
one.  (Note that Amtrak, whenever it appears, is always turned off by default.)  
 
NOTE: The number of routes generated is affected by the Include/Exclude 
options in the Options dialog.  See section 5.10, Routing Options.  
 

 

 
AutoRouter Window  

 
 
Next, enter “el paso tx” as the destination, and choose BNSF from the pick list that 
appears. 
   
After the origin, destination and potential serving railroads are entered, feasible 
routings may be generated by either clicking on the Run button or pressing the 
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F10 key.  You’ll see these routes listed in the lower right section of the dialog box 
when processing has finished. 
 

 
AutoRouter Window With Generated Routes, Atlanta – El Paso  

 
 
To review a route or edit its options and re-run, either double-click on it or 
highlight it in the list and press <Enter>.  The route will be drawn on the map, 
and a route entry window will open that displays the intermediate stops, railroads 
used, and mileage for this route.  The Norfolk Southern route shown below is the 
first one on the list of possible routes from Atlanta to El Paso.   
 
You can edit the options for this route the way you would in any single route 
entry window (click the Options button – see section 5.10).  This can be 
especially useful when the AutoRouter is relied on to generate a valid junction 
interchange and the route then needs to be re-run for Fuel Surcharge mileage. 
 

 
Norfolk Southern Route Generated By the AutoRouter 
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To review or edit another route from Atlanta to El Paso, activate the AutoRouter 
window and double-click on another route listing. 
   
Once back in the AutoRouter, you have the option to click Clear All to start over 
with another origin and destination. To display all the generated routes on the 
map, click the Show All button. 
 

4.3  A Brief Look at Maps and Reports 

To see a map of the route you selected in the AutoRouter, click on the Map 
button on the tool bar or select Map from the Windows menu. 
 
 

 
Framed Route in the Map Window  

 
 
Three reports are also available in the Reports menu: 
 
 Detailed Report: To view more detailed information about the route, select 

the Detailed Report.  Make sure the route entry window for this route is active 
when you do this (the title bar should not be gray).  The Detailed Report lists 
every location on the route, along with leg and cumulative mileage between the 
origin and destination.  
 

 Key Station Report: The Key Station Report lists only major locations.   
 

 Detailed Geocode Report: The Detailed Geocode Report includes the same 
information as the Detailed Report but also lists geographic codes for each 
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stop.  The types of codes listed are SPLCs, 3-3-3s, and R260 (see sections 
5.4.1 through 5.4.5 for a full description of PC*MILER|Rail geocodes). 

 
All three reports include mileage breakdowns by state/province/estado and railroad 
at the end of the report, and may be generated when using single route entry or the 
AutoRouter.  You can print the open report or map by clicking on the Print 
button on the tool bar while the report window is active.  In order to open a 
report, you need to minimize or close any other report that is open. 
 
For detailed descriptions of reports and maps, see Chapters 6 and 7. 
 
NOTE:  In order to open a report, you need to minimize or close other reports. 
All three reports may also be generated when using the single route entry method.  
To print a report, click on the Print button on the tool bar while the report 
window is active. 
 
TIP: You can view a report for any AutoRouter route without opening a separate 
route entry window first.  Simply highlight the route on the list in the AutoRouter 
window, then click on the right mouse button. Select Detailed Report, Key State 
Report, or Detailed Geocode Report from the menu that pops up. 
 
TIP: If your windows are disorganized and you don’t see the one you need, you 
can open the Windows menu and select that window from the menu.  
 
The sections following contain more detailed information about 
PC*MILER|Rail route entry, options, maps and reports. 
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         Basic Features of PC*MILER|Rail 
 
 

This chapter describes how PC*MILER|Rail determines routes and mileage, 
explains how railroad families are used in PC*MILER|Rail, and provides detailed 
descriptions of location entry, routing options, and how to save and load 
generated routes.  
 

5.1  About Railroad Routes  

A railroad route is identified by the following components: an origin, an optional 
sequence of intermediate points, a destination, and the railroads that connect them.  
There are two types of routes: single line and inter-line. 
 
Single line routes include an origin location, a destination location, and a single rail 
carrier serving them both.  Inter-line routes occur when different railroads serve 
the origin and destination points, or another railroad must be used to "bridge" the 
origin and destination carrier(s).  Inter-line routes require the entry of one or more 
railroad-to-railroad junction locations. 
 
Between any two rail points in North America, there are a large number of possible 
routes (traffic between Atlanta and Dallas could go via New Orleans, Memphis, or 
conceivably even via Chicago).  Realistically, there are a limited number of feasible 
or practical routings based on which railroads serve the points, their operations, and 
the junctions at which they interchange cars. 
 
When the same railroad serves both the origin and destination, a single line route is 
usually most practical.  While in some cases inter-line routes may be valid 
alternatives to competing single-line routes, they require coordinated effort between 
multiple railroads to interchange traffic and share the responsibility/revenue of the 
shipment.  In other cases, no single-line route exists and one or more inter-line 
routes are the only way to get between the origin and destination. 
 
In the U.S. and Canada, there are about 7,500 route-miles where railroads operate 
primarily in one direction over a rail line, with traffic in the opposite direction 
moving over an alternate route.  Beginning in Version 17, directional routes are 
reflected in PC*MILER|Rail’s routing and mapping.  As an example, in the 
following screenshot, southbound UP traffic from Chicago to Houston moves via 
Shreveport, LA, whereas the northbound traffic moves via Little Rock, AR.  
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Choosing a Destination Railroad  

 
 

5.2  PC*MILER|Rail Route Calculation  

PC*MILER|Rail uses a minimum impedance routing program for computing 
routes.  The link impedance used in route calculations is derived as distance 
multiplied by a cost factor, which essentially corresponds to route quality.  High 
density mainlines are given a lower link cost, while medium density mainline, 
medium density branchline, and low density branchline have higher cost factors.  
The minimum impedance route between any two nodes (geographic locations) on 
ALK’s Rail Network is the sequence of links whose impedance sum is less than 
that of any other sequence of links.  
 
PC*MILER|Rail routes can be run in Single Route entry mode (the user specifies 
railroads and junctions manually) or using the AutoRouter to calculate all 
possible routes between locations.  For interline routes calculated from the 
AutoRouter, junction interchange impedances are added to link impedances.  The 
junction impedance for the forwarding and receiving railroads is based on the 
historic volume of traffic interchanged at that junction to/from those railroads. 
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Link costs and junction costs may be different for each of the PC*MILER|Rail 
routing types. Additionally, the link costs are adjusted to accommodate any 
directional routing arrangements. 
 
All the various cost factors have been derived from extensive research using 
railroad timetables, maps provided by railroads, the Official Railway Guide, 
Official Railroad Station List, Railroad Atlas, and county maps.  ALK has 
periodically updated these costs over the years to maintain a good match with 
current realistic routes. 
 
PC*MILER|Rail includes six different routing formulas: Practical, Shortest, 
Intermodal, Coal/Bulk, Auto Rack, and Fuel Surcharge.  See section 5.10, 
Route Options, for a description of routing formulas and other options. 
 

5.3  About Railroad Families  

PC*MILER|Rail groups combinations of separate but affiliated railroads (CN-
CBNS, UP-BLR, etc.) into railroad "families".   
 
In a single route entry window, you can choose whether to find the best route over 
an individual railroad (Non-Familized) or over the railroad and its family members 
(Familized).  Familized is the default option.   
 
To change from familized to non-familized mode, click on the Options button in 
the route entry window, then click on Non-Familized and click OK. 
 
The AutoRouter always uses the entire North American railroad network to find the 
best route, hence Familized is the only option when using the AutoRouter.  
 
An example of familized versus non-familized routing is the following scenario: 
suppose you want to obtain miles from Kansas City MO to Saltillo, CU on the 
Kansas City Southern (KCS) and the Kansas City Southern de Mexico (KCSM) 
system.   
 
If you use the Familized setting in Single Route mode and enter the origin location 
with KCS in the RR field, PC*MILER|Rail will use both the KCS and KCSM 
networks (owned jointly by Kansas City Southern) to find the best route.  
  
For example, when you enter Saltillo, CU as the destination, a pick list enables you 
to choose a destination railroad, as shown below, and you do not need to enter a 
junction: 
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Pick List of Destination Railroads  

 
 

 
 

Familized Route – Kansas City, MO to Saltillo, CU 
 

 
If you were to enter this same origin with KCS specified as the origin railroad in 
Non-Familized mode, an error message would appear when you enter the 
destination: 
 

 
 
 
You could, however, choose to run a Non-Familized route and enter an 
appropriate intra-family railroad-to-railroad junction that KCS and KCSM use to 
interchange rail traffic as shown below.  See section 5.8.1, Using the Junction 
Helper, on finding available junctions on a route.  
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Non-Familized Route – Kansas City, MO to Saltillo, CU  

 
 
In most cases, PC*MILER|Rail users may wish to run routes over railroad 
families without having to choose an intra-family railroad-to-railroad junction.  
However, for some applications, such as car accounting or rate division 
calculations, entering the exact inter-carrier junction points is important so correct 
mileage by individual railroad may be calculated.   
 
For applications such as car accounting or interline settlement, knowing which 
railroad serves each location is very important.  If payments are split, the actual 
mileage over each individual railroad may be critical.  In this case especially, the 
user should use the non-Familized setting and explicitly enter the correct intra-
family railroad-to-railroad junction points using Single Route entry mode so that 
the mileage by individual railroad can be calculated. 
 

5.4  How To Enter Railroad Locations  

PC*MILER|Rail gives you two basic methods of route entry: 
 

 Single Route Entry: If you know a route and just want to get the mileage, 
you can enter a sequence of locations and railroads manually in a single 
route entry window (select File menu > New Route or click the New 
Route button on the tool bar).  A Junction Helper is available to provide a 
pick list of all junctions between specified railroads.  
  

 AutoRouter Entry: Alternatively, if you want PC*MILER|Rail to 
suggest possible junctions and connecting railroads between two points, 
you can use PC*MILER|Rail’s AutoRouter feature (select File menu > 
AutoRouter or click the AutoRouter button on the tool bar).   

 
For a detailed comparison of these two methods, see section 5.8, Single Route 
Entry, and section 5.9, Using the AutoRouter. 
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To generate routes and determine rail mileage using either of these methods, you 
must specify an origin and a destination, and optionally one or more intermediate 
locations using one of the geographic codes listed below (see sections 5.4.1 – 
5.4.5 below for descriptions). 

 
 Location Name and State/Province/Estado Abbreviation (Station ST) 

 Standard Point Location Code (SPLC) 

 Freight Station Accounting Code (FSAC) 

 Eastern Railroad President's Conference Codes (3-3-3) 

 Rule 260 Junction Codes (R260) 
 

NOTE:  Using single route entry, a railroad SCAC may also be entered along 
with any of these codes.  
 

 
5.4.1  Station Name and State Abbreviation 

 
Station names, as listed in the Centralized Station Master (CSM), are entered in 
the Station ST field in either the single route or AutoRouter window.  They are 
entered without a comma between the station name and state abbreviation (you 
will get an error message if a comma is entered). 
 
For spelling help or to search for a station name, type at least the first letter of the 
station, followed by an asterisk (*) and the state/province/estado abbreviation (do 
not include a comma after the location name), then press <Enter> on your 
keyboard; for example, “b* id”  or  “MO*PQ”.   
 
In the pick list of possible matches that pops up, highlight the correct location 
name and click OK (scroll the list if necessary to find the correct location name).  
Note that the type of code in the pick list will reflect which code is selected in the 
route entry window. 
 
If you are typing in the full station name, it must be entered exactly as it appears 
in the PC*MILER|Rail database (and as listed in the Centralized Station Master), 
otherwise an error message will be generated.  If the "Station Name Not Found" 
error message appears, do a search as described above.   
 
If you simply enter a station name and state abbreviation, the pick list that pops 
up will include a list of codes (appropriate to the type of code selected in the route 
entry window) and all railroads that serve the station that was entered. 
 
When entering a station name, you can use up to 20 characters, and 2 characters 
for the state abbreviation.  The name and state do not have to be separated by a 
space (although they can be), as the last two characters are always interpreted as 
the state/province/estado abbreviation.  (For a table of official state/province/ 
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estado abbreviations, select State Names… from the Help menu or press <F3>.)  
If a station name contains two or more words, they must be separated by spaces. 

 

 
Pick List of Matches for Search On “bo* id” 

 
 
Some examples of valid station name entries are: 
 

TEXARKANA    TX 

ST LOUIS     MO 

SALT LAKE CITUT 
 
Common abbreviations occurring in station names are: 
 
NORTH N BRIDGE BR MOUNTAIN MT 

SOUTH S FORT FT PARK PK 

EAST E JUNCTION JCT POINT PT 

WEST W MINE MIN SAINT ST 

 
 

5.4.2  Standard Point Location Codes (SPLC) 
 

Click on SPLC at the top of the route entry or AutoRouter window and type any 
valid 6-digit Standard Point Location Code (SPLC) in the Geocode entry field.  
Then press <Enter> to prompt PC*MILER|Rail to search for the corresponding 
station name.  If the search was successful, the SPLC and station name will then 
appear in the Geocode and Station ST fields. 
 
If more than one railroad serves the SPLC, a pick list will pop up as shown below.  
Scroll the list if necessary, highlight the correct location name and click OK, or 
double-click on it to select it.  
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TIP: When you enter a geographic code, entering a railroad's Standard Carrier 
Alpha Code (SCAC) along with the geocode may define the correct freight station 
immediately, or at least reduce the size of the pick list that is generated.  To do 
this, don’t press the <Enter> key after typing the SPLC code.  Instead, place your 
cursor in the RR field, click, type the railroad SCAC, and then press <Enter>.  
For a list of railroads and their SCAC’s, choose Railroads from the Help menu or 
see Appendix C and D at the end of this User’s Guide. 
 
 

 
Pick List Showing Multiple Railroads Serving Chicago, IL 

 
 
If you are unsure of the exact six digits of the SPLC or receive the message “No 
Matching Codes Found”, type at least the first three digits of the code 
immediately followed by an asterisk in the Geocode field and press <Enter> to 
invoke a pick list of matches.  For example, if you enter 503* as your SPLC, the 
pick list of freight stations shown below will pop up.  

 
 

 
Pick List of Matches For SPLC Search on “503*” 
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5.4.3  Freight Station Accounting Codes (FSAC) 
 

Entering Freight Station Accounting Codes (FSAC) is very similar to entering 
SPLC codes: click on FSAC at the top of the route entry or AutoRouter window, 
type the code in the Geocode entry field, then press <Enter>. 
   
However, FSACs are unique to a given railroad; the same 5-digit FSAC will refer 
to a completely different location on another railroad.  Therefore, the user should 
try to specify the desired railroad by entering that railroad's SCAC abbreviation in 
the RR field.   
 
For a list of railroads and their SCAC's, select Railroads in the Help menu or see 
Appendix C and D at the end of this User’s Guide. 
 
If you are unsure of a particular FSAC or if you receive a “No Matching Codes 
Found” message upon entering a code, type at least the first three digits of the 
code immediately followed by an asterisk and press <Enter>.  For example, 
entering 103* will pop up a pick list of matches as shown below. 
 
Scroll the list if necessary to find the FSAC for the station you want.  Highlight 
the correct station and click OK, or double-click on it to select it. 
 
 

 
Pick List For FSAC Search on “103*” 

 
 

5.4.4  Eastern Railroad President’s Conference Codes (3-3-3) 
 

An Eastern Railroad President's Conference Code (3-3-3) is similar to a 
station/state spelling, except that 3-3-3 codes are limited to nine characters and 
abbreviated in accordance with specific rules of Railinc and the National 
Industrial Transportation League (NITL).  These requirements are published in 
the Rail User's Manual by the NITL (1700 N. Moore St., Arlington VA). 
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For help with 3-3-3 code entry, click on 3-3-3 at the top of the single route entry 
window or the AutoRouter, then type at least two letters of the 3-3-3 code in the 
Geocode entry field, followed immediately by an asterisk and the 
state/province/estado abbreviation.  Press <Enter> to invoke a pick list:  
 
 

 
Pick List For 3-3-3 Code Search on “sa* tx” 

 
 
Scroll the list if necessary to find the station you want.  Highlight the correct 
station and click OK, or double-click on it to select it. 
 
For station names of nine or fewer characters, the normal spelling is used in 3-3-3 
codes.  For longer station names or multiple-word names, abbreviations for 
common words as well as a 3-3-3 spelling convention are used.  In all cases, the 
two-letter state/province/estado abbreviation is required, with or without a space 
before it.  For example: 
 

SANTA FE     NM . . . becomes . . . SANFE    NM 

FORT WAYNE   IN . . . becomes . . . FTWAYNE  IN 

SALT LAKE CITUT . . . becomes . . . SALLAKCITUT  
 
 

5.4.5  Rule 260 Junction Codes 
 

Rule 260 codes represent officially designated locations where two or more 
railroads interchange traffic with each other.  They are abbreviated by unique 5- 
character alpha codes designated by Railinc.   
 
To enter a Rule 260 code, click on R260, then type the full code in the Geocode 
field. To invoke a pick list of database matches, type at least one letter followed 
by an asterisk.   
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Examples of Rule 260 entries are: 
 

KANCY KCITY STRTR CHI* 
B*   BUFF BUTLR 

 
 

REMINDER:  Specifying a railroad in the RR field will limit the search to only 
those junction points served by that railroad. 

 

 
Pick List For Rule 260 Code Search on “b*” 

 
 

5.4.6  Inserting and Deleting Stations 
 

In the single route entry window, freight stations may be inserted and deleted 
anywhere in the list of stops.  Use the <F7> key to insert a station above the 
highlighted line, or the <F8> key to delete the highlighted line.  (You could also 
use the Edit menu.)  Use the arrow keys to move from stop to stop on the list.     
 
To delete all stops, press the <ALT><F8> keys simultaneously or select Delete 
All Stops from the Edit menu. 
 

5.5  Common Route Entry Error Messages  

NOTE:  For a complete list of all error codes you may encounter, see Appendix F 
(includes possible solutions to correct the problem). 
 
The most common error messages that are returned when freight station and 
junction locations are entered are listed below.   
 
 No valid routes generated: This message is returned when the AutoRouter is 

unable to find feasible routes between the origin and destination entered with 
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the current settings.  Try changing the Terminal Switch RR’s option in the 
Options dialog box to Include. 

 Station name not found.  This message is returned when an incorrect station 
name is entered but the state abbreviation is valid, or when you use a comma 
between the station and state abbreviation (remove the comma and try again in 
this case).  The station name spelling should match the Centralized Station 
Master registered name. Try using the spelling helper: type at least one letter 
of the station name, followed by an asterisk and the two-letter state 
abbreviation, then press <Enter>.  You may also contact ALK Technologies 
to obtain a list of registered names. 

 State abbreviation not found: Occurs in three situations: 1) an incorrect state 
abbreviation is entered with the correct station name; 2) both the station and state 
names are entered incorrectly; or 3) just the station name is entered without a state 
abbreviation.  For a list of valid state abbreviations, press <F3>.   

NOTE: The last two characters of a station name/state entry are always 
recognized as the state abbreviation. 

 RR ‘X’ does not get to this location: (Single route entry window only) 
Occurs in three situations: 1) an invalid railroad SCAC is entered with a valid 
geocode or station/state name; 2) the railroad entered does not serve the 
geocode or station/state that was entered; or 3) the previous stop’s railroad 
does not get to the current stop.  See Appendix D and E for all valid railroads 
listed by SCAC and by full name. 

 Railroad stations are disconnected: (Single route entry window only) One 
stop entered for a railroad is separated physically from another stop on the 
same railroad.  Service by another railroad (often a member of the same 
railroad family) must be inserted into the route to connect the separated 
locations. This message may mean that stops have been deleted and re-
entered, resulting in a disjointed route definition.  Try using the Junction 
Helper (see section 5.8.1); or clear the screen by selecting Delete All Stops 
from the Edit menu, then re-enter and re-run the route. 
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5.6   Using Override Files For Recurring Data Errors, Custom 
Name Creation and Junction Interchange Preferences 

If you are experiencing recurring errors during route entry because the station or 
railroad you attempted to enter can’t be found in the PC*MILER|Rail database, 
there are override files you can use to correct this problem.  These text files are 
located in the RAILNET subdirectory of your PC*MILER|Rail installation (see 
Step 1 in the instructions below for the location of this folder). 
 
The data override files can be used whenever different codes or names for stations 
in the user’s database do not exactly match those registered with the Centralized 
Station Master files, the source for PC*MILER|Rail’s database.   
 
Additionally, the override feature allows users to run routes to new stations 
created after the latest release of PC*MILER|Rail, by using a neighboring station 
as a proxy to generate non-error routes with almost correct mileage. 
 
Override files can also be used to create custom location names (use the 
OVERRIDE.NAM file) and to edit or create junction interchange preferences for 
interline routing (use the OVERRIDE.JCT file).   
 
Each override file now includes instructions for its use, in comment lines 
beginning with the pound sign (#) at the top of the file.  Additionally, a text file 
containing examples for each override file is included with the PC*MILER|Rail 
installation.  This sample file is named “Example Override Data.txt” and is 
located in the …PCRWIN20\Railnet folder of your installation. 
 
There are six override files for six types of station and railroad input: 
 
OVERRIDE.ERP 
OVERRIDE.FSC 
OVERRIDE.NAM 
OVERRIDE.SCA 
OVERRIDE.SPL 
OVERRIDE.JCT   
 
These files are blank initially, and may be filled with records (rows of text) that 
you add in the correct format for each type.  The records you add will tell the 
PC*MILER|Rail program that “when this is entered, it means that”.  
 
The added records must include an input column and a translation column.  The 
input column contains an abbreviation or numerical configuration that a user 
might enter as a station location or railroad during route entry, and the translation 
column contains the valid entry for that location that PC*MILER|Rail will 
recognize because it matches what’s in the database. 
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Follow the steps below to add data to an override file:  
 
1. Find the Railnet folder in your PC*MILER|Rail installation.  For a typical 

installation, go to: 

C:\ALK Technologies\PCRWIN20\ Railnet;  

or if the installation location was customized, search for the 
PCRWIN20\Railnet folder on your computer using Windows Explorer. 

2. Right-click on one of the override files and select Open from the menu.   
(If you can do this successfully, skip to step 5 below; otherwise, continue to 
step 3.) 

 

 

 

 

 

 

 

 

 
3. If Windows does not recognize the file type, a prompt will appear that asks 

how you want to search for an application that will open the file.  Choose 
Select the program from a list. 
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4.  A list of applications will open.  Select Notepad or Wordpad. 
 

 
 
 

5. In the override file, type your entries, matching the column structure 
appropriate to the file type (see descriptions for each file type below). 

6. To save your changes, select Save from the File menu at the top of the 
Notepad or Wordpad window.  The stations, railroads and/or preferences you 
added will now be valid when you input them during route entry.   

 
 
Sample records for each file type are shown below.  Detailed instructions for 
adding entries are included at the top of each file, in lines preceded by the pound 
sign (#).  
 
OVERRIDE.SCA 
 
TFM KCSM; 
 
The format for the entry must be: old or custom RR (SCAC) in positions 1-4, a 
blank, the proxy SCAC (recognized by PC*MILER|Rail 20), and a semicolon at 
the end. 
 

OVERRIDE.FSC 
 
ABCD 10000 09999;   
 
The format for the entry must be: RR SCAC in positions 1-4, a blank, the new or 
custom 5-digit FSAC, a blank, the 5-digit proxy FSAC (recognized by 
PC*MILER|Rail 20), and a semicolon at the end. 
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OVERRIDE.SPL 
 
ABCD 110000 089999;   
 
The format for the entry must be: RR SCAC in positions 1-4, a blank, the new or 
custom 6-digit SPLC, a blank, the 6-digit proxy SPLC (recognized by 
PC*MILER|Rail 20), and a semicolon at the end. 
 

OVERRIDE.ERP 
 
PALMCV      PALMER   MA;  
HAGECSXT MD HAGERSTOWMD; 
SALT LAKEUT SALLAKCITUT; 
 
The format for the entry must be: 11-char ERPC/3-3-3 (new or custom code), a 
blank, the 11-char (including a 2-character state abbreviation in the last two 
places) proxy ERPC/3-3-3 (recognized by PC*MILER|Rail 20), and a semicolon 
at the end. 
 

OVERRIDE.NAM 
 
MOOJAW SK MOOSE JAW SK; 
YOYO IL   CHICAGO IL; 
 
The format for the entry must be: up to 22-char name (new or custom station 
name), a blank, the up to 22-char (including a 2-character state abbreviation in the 
last two places) proxy Station Name (recognized by PC*MILER|Rail 20), and a 
semicolon at the end.  See section 5.7 for an alternate way to create custom 
names. 
 
OVERRIDE.JCT 
 
BNSF CSXT BHAM  P A; 
BNSF CSXT BHAM  C A; 
BNSF NS   CHGO  I F; 
BNSF NS   CHGO  A F; 
 
The columns in this file from left to right are: 

- RR1, up to 4 characters followed by 1 blank  
- RR2, up to 4 characters followed by 1 blank  
- R260 junction code, up to 5 characters followed by 1 blank 
- Route type to which the preference will be applied (P=Practical, C=Coal/Bulk, 

I=Intermodal, A=Auto Racks), 1 character followed by 1 blank 
- Type of preference (A=Avoid, F=Favor), 1 character followed by a semicolon 
 
See section 5.11 for an alternate way to create junction interchange preferences. 
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5.7  Adding Custom Names to the Database 

PC*MILER|Rail gives you the ability to add custom station names to the 
database.  One way to do this would be to use the override files as described in 
section 5.6 above.  
 
Alternatively, to add custom names from within the user interface, select Manage 
Custom Places from the Tools menu.  Then, in the Custom Place Manager, do the 
following: 
 

1. Type a name in the Custom Name field; 

2. Type a station name and state abbreviation without a comma in the 
Station ST field, OR 

3. Select a type of geocode (SPLC or 3-3-3) under the Station/ST field, then 
enter a SPLC or 3-3-3 code in the Geocode field; 

4. Click Add to add the custom name to the PC*MILER|Rail database. 
 

 

 
Custom Place Manager 

 
 

5. To enter a custom place as the origin, destination, or intermediate stop on 
a route, type the custom name in the Station ST field (state abbreviation is 
not necessary) or type its SPLC or 3-3-3 code in the Geocode field and 
press <Enter>. 
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5.8  Single Route Entry 

PC*MILER|Rail gives you two basic methods of entering a route, single route 
entry and AutoRoute entry.  If you already know the route you want and just need 
to get the mileage, you’ll be entering a sequence of locations and railroads 
manually in a single route entry window.   
 
To open a single route window, select New Route from the File menu or click the 
New Route button on the tool bar.  The single route sequence is made up of an 
origin location and railroad, a destination location and railroad, and (optionally) 
intermediate locations or junctions that define the route for consideration. 
 
Except at the origin, PC*MILER|Rail requires an inbound and outbound railroad 
at each location entered.  PC*MILER|Rail automatically designates the inbound 
railroad (RR1) at each location (except the origin) as the outbound railroad 
(RR2) from the preceding location. 
 
To enter an origin, destination, or intermediate stop, type in each location in one 
of the formats described in section 5.4. (You can also enter stops in this window 
directly from the map by using the Pick Stops button – see section 6.2.2.)  Press 
<Enter> to bring up a pick list of railroads, or add a railroad abbreviation in the 
RR field first and press <Enter>.  
 
Note that the stop list displays the type of code for each location entered, 
represented by S (SPLC/Station-State), F (FSAC), E (ERPC), or R (Rule 260).   

 

To run a single route, you must specify each location where a change of 
railroads (or railroad families) occurs.  In the example shown below, 
PC*MILER|Rail would not permit Tacoma, WA to be entered on the second line 
because Norfolk Southern doesn't get there.   
 
 

 
 
 
 
 

Location Entry Error 
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In this instance, to get a list of valid railroad junctions between Norfolk Southern 
and a railroad that serves Tacoma, you would use the Junction Helper (see section 
5.8.1 below). 
   
REMINDER:  To see a list of railroads sorted by SCAC or railroad name, select 
Railroads in the Help menu or press the <Ctrl><F3> or <Alt><F3> keys 
simultaneously. Or, refer to Appendix C or D in this User’s Guide. 
 
To edit any entry, highlight it on the stop list, then type over it in the appropriate 
entry field above the list.   
 
Once you enter an origin and at least one subsequent stop, routes can be generated 
and mileage calculated by clicking on the Run button (or pressing the <F10> 
key).  The distance between each pair of locations as well as the cumulative 
distance along the route will be shown next to each stop. 
 
If the message “Railroad stations are disconnected” appears, one stop entered 
for a railroad is separated physically from another stop on the same railroad.  
Service by another railroad (often a member of the same railroad family) must be 
inserted into the route to connect the separated locations.  This message may 
mean that stops have been deleted and re-entered, resulting in a disjointed route 
definition.  Clear the screen by selecting Delete All Stops from the Edit menu.  
Re-enter the route and click on the Run button or press <F10> again. 
 

 

 
Route Generated in the Single Route Window 
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5.8.1  Using the Junction Helper 
 
A Junction Helper is available to provide you with a list of valid railroad 
junctions between two railroads when you enter a single route manually.   
 
The Junction Helper can only be used when entering a stop or destination (not an 
origin).  To invoke it, type a railroad abbreviation in the RR field and press 
<Enter>, then select the junction you want from the pick list and click OK. 
   
For example, if you enter Chicago, IL and CN as the origin location and railroad, 
you can then enter UP as the railroad for the next stop without specifying a 
location, and the Junction Helper will show you every junction available between 
CN and UP. 

 
 

 
 
 
 
 
 
 
 
 
 
 

Using the Junction Helper 
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5.9  Using the AutoRouter 

PC*MILER|Rail can automatically generate a list of valid railroad junction 
sequences between any two points in North America.  To use the AutoRouter, 
select AutoRouter from the Route menu or click the AutoRouter button on the 
tool bar to invoke the AutoRouter window. 
 
 

 
The AutoRouter Window 

 
 

To generate a route, first type in an origin and press <Enter> using any of the 
standard geocode formats as described in section 5.4.  PC*MILER|Rail then lists 
the railroads serving the origin under Orig RR’s (bottom left corner).  Railroads 
that do not have stations on the route from origin to destination are grayed out. 
 
To exclude a railroad that should not be considered for the origin of the route, 
double-click on it to remove the checkmark next to it, or highlight it and press 
<Enter> (scroll up and down the list if necessary).  Double-click again to replace 
the checkmark.  If you want to exclude all railroads on the origin list, click the All 
Off button underneath it.  (This is a toggle button, so it will read All On after you 
click it.  To include all railroads on the list, click All On.)  Railroads without 
active stations are displayed in a lighter font. By default, they are unchecked, as 
are Amtrak railroads. 
 
Now enter a destination in the same way as the origin, choosing which railroads 
to include and exclude from the Dest RR’s list.  You also have the option of 
entering one “via” location; that is, a freight station you wish your route to pass 
through.  (This will take extra time to process, as more calculations may be 
required.)  Click on the Run button to generate the route.  All possible routes will 
be listed under RRs and Junctions, along with the distance each route travels. 
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To edit your location entries, simply type over them in the entry fields.  The 
Clear All button will clear all entries so you can begin again. 
 
Typically, the number of routes generated will be a product of the number of 
railroads serving the origin times the number of railroads serving the destination.  
Exceptions occur when a railroad serves both origin and destination; it is unlikely 
that this railroad will participate in other inter-line routings.  Routes with the 
originating or terminating carrier having a switch move only (common with 
terminal railroads) may be included or excluded depending on whether Include or 
Exclude is chosen under Terminal Switch RRs in the Options dialog box (see 
section 5.10 below).  Exclude is the default option. 
 
The routes generated and kept will be listed in order of fewest junctions between 
railroads of different families and fewest total miles.  Routes are shown as a 
sequence of railroad SCACs and Rule 260 codes. 
 
 

 
Routes Generated in the AutoRouter 

 
 
To view any route in more detail, simply highlight it on the list and press 
<Enter>.  The route will appear in its own route entry window, and can be rerun 
and edited if desired.  It will also be added to the map in the map window when 
you do this.  To display all generated routes on the map, click the Show All 
button.  To bring the map window forward, click the Map button           on the 
application tool bar or use the Windows menu.  
 
Your route can also be saved (see section 5.13, Saving and Loading Routes). 
 
NOTE: Only eight route windows can be open at one time. 
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NOTE:  The routing algorithms used in PC*MILER|Rail are identical to those 
used in the traffic diversion studies for major railroad and government clients that 
ALK Technologies has produced since 1979.  The routes generated are listed in 
order of fewest junctions and least miles, and are not necessarily the best or most 
efficient routing options.  They are merely feasible, practical routings based on 
ALK’s observation of actual, historical traffic movements over many years. 
 
To see a report for one of the AutoRoutes without opening a route window first, 
highlight it on the list and click the right mouse button.  Then select Detailed Report, 
Key Station Report, or Detailed Geocode Report from the menu that pops up. 
   

5.10  Route Options 

PC*MILER|Rail gives you several options to choose from when running a route.  
The available options vary depending on whether you are using single route entry 
or the AutoRouter.  Route options affect how rail lines and junctions are selected 
for a route, total route mileage, and (with AutoRouting) the number of routes that 
are generated. 
  
To open the Options dialog box, click on the Options button in either the single 
route or AutoRouter window.  If an option is not available, it will be grayed out.  
The Options dialog box shown below was opened from the single route entry 
window, therefore the Terminal Switch RRs options are not active. 
 
 

 
Options Dialog Box 
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Use the Options dialog box as follows: 
 
 Route Name:  To give a route a custom name, type the name in this field.  

This name appears in the title bar of the route entry or AutoRouter window, 
on reports, and on the Route Legend in the map window. 

  
 Route Type:  Choose whether your route should run in Familized or Non-

Familized mode.  This option is only available for single route entry.  See 
Section 5.3, About Railroad Families, for more information. 

 
 Intermodal-Only Stations:  When generating Practical routes, this option 

indicates whether to Include or Exclude stations that provide only intermodal 
service.  Note that when the Intermodal route formula is selected (see 
below), excluding intermodal-only stations is not an option. 
 

 Report Memo:  The comments you type in this field will appear on reports. 
 

 Terminal Switch RR’s:  When using the AutoRouter, routes with the 
originating or terminating carrier having a switch move only (common with 
terminal railroads) may be included or excluded.  The default for this option is 
Exclude.  This option affects the number of routes that are generated. 
 

 Units:  Choose whether distances should be calculated in miles or 
kilometers. 
 

 Route Formula:  Six route formulas are available to generate routes:   
 

- Practical routings simulate the most likely movements of general 
merchandise train traffic. Main lines are prefered to branch lines. A 
Practical route can sometimes be more circuitous than the shortest 
possible route.   

- Shortest route calculations find the rail route with the least distance 
between the stops. In the Single Route entry mode, the shortest path 
within the railroad is determined for each segment. In AutoRouter, the 
shortest path across all North American railroads is calculated, 
irrespective of origin and destination railroad user choices. 

- Intermodal, Coal/Bulk, or Auto Racks may be used to determine the 
exceptional routings that these types of trains sometimes require. 

- Fuel Surcharge routing is essentially a combination of the Shortest and 
Practical route formulas (because some railroads use Shortest mileage and 
some use Practical mileage when figuring their fuel surcharges). It 
provides mileage suitable for calculating fuel surcharges in conformance 
with the recent Surface Transportation Board ruling STB Ex Parte No. 
661.   
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NOTE: Section 5.2, PC*MILER|Rail Route Calculation, provides some general 
information about how routes are calculated. 
 
When you have selected your options, click on OK to close the dialog box and 
save your choices.  Options must be re-selected for each route you run. 
 
 

5.10.1  Setting Your Own Default Options 
 
To set your own defaults for PC*MILER|Rail’s routing options, choose Default 
Options… from the Route menu.   
 
The Default Options dialog box is identical to the Options dialog box.  The 
settings you enter in the Default Options dialog box will remain in effect as 
defaults until the next time they are changed. 
 

5.11  Avoid or Favor Interchange Junctions in the AutoRouter 

PC*MILER|Rail users now have the ability to designate junction interchanges to 
be avoided or favored on a route.  These custom interline routing preferences are 
specified for the AutoRouter, and apply to both directions.  Preferences are stored 
in an “OVERRIDE.JCT” text file that may be viewed and edited, allowing the 
user to manually add a long list of junctions to be avoided or favored if desired 
(see section 5.6 on editing these files). 
 
 

 
Avoid/Favor Junctions in AutoRouter Dialog Box 
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The steps below provide an example of how to designate a junction to be avoided 
or favored in the AutoRouter.  This example uses the BNSF and CSXT railroads 
and Birmingham, AL as a junction to be avoided: 
 
1.  Select Tools menu > Manage Junction Avoid/Favors or simultaneously hit 

the <Ctrl> and <F2> keys on your keyboard to bring up the Avoid/Favor 
Junction in AutoRouter dialog box. 

 
2.  Enter “BNSF” as RR1 and “CSXT” as RR2. Note that either RR1 or RR2 can 

be the forwarding or receiving carrier. 
 

3.  The next step requires you to enter the R260 code and station name for the 
junction location that you wish to avoid or favor.  Click Find to bring up a 
pick list of all junction interchanges for RR1 and RR2.   

 
 Note that two out of the three input fields – RR1, RR2, and location (R260 or 

Station/ST) – must have an entry; otherwise an error message will be invoked. 
 
 

 
Pick List of R260 Station Names 

 
 
4.   Click OK to select the station highlighted at the top of the pick list, 

Birmingham, AL (BHAM).  Note that if the location-railroad combination 
you select were to duplicate a preference that already exists, an error message 
would be invoked. 

   
5.   Under the railroad and location, select Avoid and check Practical and 

Coal/Bulk to indicate the route type(s) that should avoid Birmingham as an 
interchange. 

 
6.   As the last step, click Add to add these new custom junction preferences (one 

for Practical routes and one for Coal/Bulk routes) and then click OK to exit 
the dialog box, saving your edits. 
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List of Custom Junctions To Be Avoided 

 
 
A generated route from Little Rock, AR to Jacksonville, FL is shown below.  This 
route uses BNSF as the Origin railroad and CSXT as the Destination railroad, and 
illustrates the effect of the new junction preferences.   
 
The first screenshot shows the route before the preferences were added; and the 
second screenshot shows how the route avoided Birmingham after that junction 
was designated to be avoided, routing through Memphis, TN instead.  
 
Before – Route Uses Birmingham, AL as an Interchange: 
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After – Route Uses Memphis, TN as an Interchange: 

 

 
 

 
To print the list of saved junction preferences, open the Avoid/Favor dialog box 
again and click the Print button.  To delete a preference, highlight it on the list 
and click Delete.  To delete all preferences on the list, click Delete All. 

 
 

 

Print and Delete Buttons 
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Here is an example of saved junction preferences as they appear in the 
OVERRIDE.JCT text file, usually found in C:\ALK Technologies\PCRWIN20\ 
Railnet (see section 5.6): 

 
BNSF CSXT BHAM  P A; 
BNSF CSXT BHAM  C A; 
BNSF NS   CHGO  I F; 
BNSF NS   CHGO  A F; 
 

The columns from left to right are:  
- RR1, up to 4 characters followed by 1 blank  
- RR2, up to 4 characters followed by 1 blank  
- R260 junction code, up to 5 characters followed by 1 blank 
- Route type to which the preference will be applied (P=Practical, C=Coal/Bulk, 

I=Intermodal, A=Auto Racks), 1 character followed by 1 blank 
- Type of preference (A=Avoid, F=Favor), 1 character followed by a semicolon 

 
NOTE:  As mentioned, an unlimited number of preferences may be added 
manually to this file, in the format shown above. 
 

5.12  Changing the Map Dataset 

The PC*MILER|Rail industry-standard rail network database is updated annually 
to include the most current data available for each version release, and three 
additional updates to the base data are provided throughout the year.  In previous 
versions, when users downloaded an update, the download process would 
overwrite their previous dataset with the new data.  Beginning in Version 20, each 
update is downloaded to a separate folder and users can choose which dataset to 
use at any time.  The active dataset will always be displayed in the title bar of the 
application window, for example “PC*MILER|Rail 20.0_Base”. 

To switch between datasets, in the PC*MILER|Rail application window select the 
Tools menu > Change Map Dataset >  and choose a set from the menu.  You will 
be prompted to close the PC*MILER|Rail application to apply the new dataset.  
Note that for a dataset to be available, it must have been downloaded using the 
“Check for Updates” tool in the Help menu.  

 

 

 

 

 

Switching the Map Dataset 
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5.13  Saving and Loading Routes 

Routes may be saved for future use and/or reference.  Saving routes enables you to 
create a library of standard routings that can be maintained over time and re-used.   
 
To save a route, choose Save Route As… from the File menu or click on the Save 
Route button on the tool bar to bring up the Save Route dialog box shown below. 
The format of this dialog box is a standard Windows feature for saving your files.   
 
 

 
Saving a Route 

 
 
Choose the drive and directory in which you want the file containing your route to 
be placed, and type a file name for the file in the File Name field.  Valid file names 
can be any length (though they are truncated when displayed in DOS).  Spaces, 
periods and other punctuation marks are not valid characters for the file name. 
 
To load a previously saved file, choose Open Route… from the File menu or click 
on the Open button on the tool bar.  This will bring up a dialog box similar to the 
one you used to save your route.  After choosing the drive and directory where your 
file is located, select your saved file from the File Name pick list or type the 
complete file name in the File Name field.  Then click on OK.   
 
All the settings used to create the file will be restored.  If the route was run and 
reports were created before it was saved, you do not need to rerun it in order to see 
reports and a map display of the route. 
 

5.14  Route Duplication 

In PC*MILER|Rail, whole routes – including all stops, carrier information and 
options – can now be duplicated without stop re-entry, making route comparisons 
easy and fast, as in the example below: 
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1. An initial route is run from Chicago, IL to Los Angeles, CA on the BNSF 
railroad: 

 

 
 

 
2. With the route entry window open, select  

Duplicate Route from the File menu to duplicate it. 
 
 
 
 
 
 
 
 
 
 
 
3. Click the Options button in the new route window, change the route type to 

Shortest, and click OK. 
  
 
 
 
  

 

 

 

 

 

 

 

 

 

4.  Run the new route. 
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Route Comparison on the Map: Practical vs. Shortest 

  
 

5.15  Printing Routes 

Generated routes can be printed.  To print, select Print Route… from the File menu 
when the route window is active or click the Print button on the tool bar.   
 
Route windows that can be printed include single route entry windows (all stops), 
the AutoRouter (the list of all generated routes), windows that display each 
individual AutoRouter route (all stops on each route), and the map window.  
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               Route Output 
 
 

Routes between stops are calculated by PC*MILER|Rail using one of six routing 
formulas (see section 5.10, Route Options).  After a route has been generated 
manually, leg and cumulative mileage appear in the single route entry window.  If 
a route has been run using the AutoRouter, you can see the mileage by double-
clicking on that route in the list of routes in the AutoRouter window.   

 
For every generated route, three reports are available that show you more detailed 
information.  Each route can also be drawn on the map in the map window.  This 
chapter describes the PC*MILER|Rail route reports and explains how to use the 
map window. 
 

6.1  Reports 

After running or loading a route, you can examine the route more closely by 
viewing the Detailed Route Report, the Key Station Report, and/or the Detailed 
Geocode Report.   
 
To view a report, the window containing the route must be active (the title bar 
of the window should not be gray; click on the window to activate it or select it 
from the Windows menu).  Also, any other reports that are open need to be 
closed or minimized. 
 
To see the Detailed Route Report, either click on the Detailed Report button on the 
tool bar, or choose Detailed Report from the Reports menu.   
 
The Detailed Route Report lists all points on the route, along with leg mileage and 
cumulative mileage between the origin and destination.  At the bottom of the report 
you’ll also see a summary of state mileage and a breakdown of mileage by railroad. 
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Detailed Route Report Showing Destination and State Mileage Summary 
 
 
To see the Key Station Report, either click on the Key Station Report button on 
the tool bar or choose Key Station Report from the Reports menu.   
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The Key Station Report includes user-specified stops and key stations on the 
route, with leg and cumulative mileage.  Like the Detailed Route Report, it also 
includes a breakdown of mileage by state and by railroad at the end of the report. 
SPLC, 3-3-3 (ERPC) and R260 codes are shown for each key station. 
 

 

 

Key Station Report 
 
 

To see the Detailed Geocode Report, either click on the Detailed Geocode 
Report button on the tool bar or choose Detailed Geocode Report from the 
Reports menu.  The Detailed Geocode Report includes the same information as 
the Detailed Route Report, but also lists geographic codes for each stop.  The 
types of codes listed are SPLCs, 3-3-3s, and R260s. 
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Detailed Geocode Report 
 

 
AutoRouter TIP: You can view a report for any AutoRouter route without 
opening a separate route entry window first.  Simply highlight the route on the list 
in the AutoRouter window, then click on the right mouse button and select 
Detailed Report, Key Station Report, or Detailed Geocode Report from the popup 
menu. 
 
 

 

 
 

 
6.1.1 Adjusting Column Width in Reports 

 
The width of columns in any report can be adjusted by clicking and dragging the 
column tabs.  The tabs are located directly beneath the window’s title bar.   
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6.1.2 Printing Reports 
 
To print a report, click on the Print button on the tool bar or select File menu > 
Print Report… The window containing the report must be active.   
 
 

6.1.3  Saving Reports 
 
To save a report, choose Save Report As… from the File menu while the window 
containing the report is active.  This will bring up the Save Report dialog box.  
You can save the report as a Microsoft Excel file, or as a text file. 
 
 

 

Saving a Report 
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6.2  Route Maps 

 

 
Routes Framed in the Map Window 

 
 
PC*MILER|Rail automatically draws each open route on a map in the map 
window.  This enables you to examine routes in detail, visually evaluate routing 
alternatives, and to perform a variety of "what-if" analyses.  To access the map 
window, either click on its icon (usually in the lower left corner of the program 
window) or select Map from the Windows menu. 
 
Options in the Map menu enable you to zoom in and out of the map display, to 
frame routes in the window, and to control such things as the level of detail and 
the number of routes, rail lines, place names and legends shown on the map.  In 
addition to generated routes, the PC*MILER|Rail map can display U.S., 
Canadian, and Mexican political boundaries, state/province/estado boundaries, 
station names, stops on routes, and railroads. 
 
 

6.2.1  First Run a Route 
 
To generate a visual display of a route, first run the route either as a single route  
or using the AutoRouter.  PC*MILER|Rail automatically generates a graphic 
display of each route that is run.  (If you used the AutoRouter, each route you 
open from the list of possible routes will be drawn.)  The maximum number of 
route windows that can be open simultaneously is eight. 
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Maximize the map window if it is minimized to see the map that displays the 
currently active route(s).  You can do this by double-clicking on the minimized 
map window or clicking on the Map button on the tool bar. 

 
 

6.2.2  Using the Map to Pick Stops 
 
If you are entering a route using single route entry window, you can pick stops 
directly from the map. 
   
TIP: When you pass the cursor over the map, its lat/long position is automatically 
tracked and appears in the status bar in the lower left corner of the program 
window. 
 
To pick a stop, first open the map window if it is minimized.  Next, click on the 
Pick Stops button on the tool bar or select the Pick/Label > Pick Stops option 
from the Map menu.  Now use the mouse to point to the location you wish to 
enter and click once.  If the cursor is near a station, that station name will be 
entered as a stop in the active route entry window.  
 
NOTE: If the AutoRouter is selected, then the stop is entered in the topmost 
route entry window.  This feature does not work within the AutoRouter window. 

 
 

6.2.3  Zoom Feature 
 
A special feature of PC*MILER|Rail’s map window is an automatic zoom option.  
When the cursor is placed inside the border of the map window, it becomes a 
cross (+).  You can then zoom into an area by either pressing the mouse button 
and dragging a box around the area, or by double-clicking on a particular 
location.  Double-clicking will zoom in by a factor of 2, and can be repeated for 
closer views.  The level of detail (number of links and place names) will adjust 
accordingly when Default > Detail is selected in the Map menu. 
 
Zooming in and out can also be accomplished by clicking on the Zoom In or 
Zoom Out buttons on the tool bar, or choosing Zoom In or Zoom Out from the 
Map menu.  These buttons zoom in or out by a factor of 2. 
 
 

6.2.4  Hiding, Displaying and Layering Map Features 
 
You can control what features are displayed and in what order features are drawn 
using the Map Features dialog box.  Choose Features... from the Map menu to 
bring up the Map Features dialog box. 
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The Map Features dialog box lists all features that can be drawn on the map.  
Checked features will be displayed on the map.  After highlighting a feature on 
the list, click Hide to remove the checkmark, or Show to make it reappear.  Use 
the Show All and Hide All buttons to hide or show all features.  Click on the 
Defaults button to return to the default setting (all features are displayed). 
 
 

 
Map Features Dialog Box 

 
 
TIP: You may also double-click on items in the Feature list to toggle between 
Show and Hide.  
 
The order (from bottom to top) in which the features appear in the dialog box 
determines the order in which they are drawn: items on the bottom of the list are 
drawn under the ones at the top.  Use the Raise, Lower, To Top, and To Bottom 
buttons to manipulate the list.  So, for example, if you highlight “Railroads” and 
then click on the To Top button, “Railroads” will move to the top of the list.  
When the map is redrawn the rail lines will be drawn last, on top of all other 
features.  Clicking on OK closes the Map Features box and redraws the map.   
 
To label specific stations and/or railroads without changing the level of detail 
shown on the whole map, use the Pick/Label option in the Map menu or the Label 
Stations and Label RR’s buttons on the tool bar (see section 6.2.5 below). 
 
Up to eight routes can be displayed in the map window at the same time.  You can 
select which routes to show and which to hide in the Map Features dialog box.  
Each route will be drawn in a different color, as indicated in the Route Legend. 
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6.2.5  Using the Mouse To Turn Map Labels On and Off 
 
Labeled stations and railroad shields can be added and deleted on the map using 
the mouse.  If you pass your cursor over the map without pressing the mouse 
button, you will notice that its latitude/longitude position is automatically tracked 
and appears in the status bar in the lower left corner of the program window.  
When the cursor stops at a station or railroad, the name is displayed in the status 
bar (even if stations are hidden from view).  
 
To label or hide a station, first click on the Label Stations button or select 
Pick/Label > Label Stations in the Map menu: 
 

 
 
Then click on any labeled station on the map to make it disappear.  Click again to 
make the label appear once more.  If you click on any point where a station is 
located, that station’s label will appear.   
 
To label a rail link with a shield or to hide a shield, first click on the Label 
Railroads button or select Map menu > Pick/Label > Label RRs.  Now you can 
click on any railroad shield on the map to make it disappear, or click any segment 
of a rail line to draw a shield. 

 
Use the Clear Labels button on the tool bar or select Map menu > Clear Labels > 
Pick/Label to delete all railroad shields and station labels you added manually. 
 
TIP 1: If you zoom out from an area that you have custom labeled as described 
above, the labels will disappear as the level of detail decreases.  When you zoom 
back in again, your labels will reappear. 
 
TIP 2: To show place names in areas surrounding the railroads that are drawn on 
the map, you need to check Label places not on RRs in the Railroad Display 
Control dialog box (see below). These places will show up as you zoom in closer. 
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6.2.6  Controlling the Display of Railroads 
 
You may wish to show some but not all railroads on a map.  To accomplish this, 
turn on “Railroads” in the Map Features dialog box.  Then choose Railroads… from 
the Map menu to bring up the Railroad Display Control dialog box. 
 
All available railroads and systems in North America are listed in the two pick 
lists.  All railroads will be drawn when “Railroads” is turned on in the Map 
Features dialog box and [All Railroads] appears in the list box under These 
carriers will be drawn. 
   
Click the Hide All button to exclude all railroads and systems.  Click All 
Railroads to draw all railroads and systems on the map.  To select an individual 
system or railroad to draw, highlight it in the pick list and then click on the 
>>Show>> button.  To take a railroad off the list of railroads to be drawn, 
highlight it in the list box and click on <<Hide<<. 
 
 

 
Railroad Display Control Dialog Box 

 
 

Some links on some rail lines are used by more than one system.  The purpose of the 
Available Systems pick list is to let you decide how these shared links will be 
displayed on the map.  
 
To illustrate how this works, let’s say that a link is used by CSXT, NS and CN.  If 
CN is above both NS and CSXT on the list, the link will be displayed on the map as 
belonging to CN (with CN represented by brown lines, it will be drawn with a brown 
line).  To change the order of the list, first highlight the system you want to 
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reposition.  Then use the Up and Down buttons to move it up or down one line, or 
use the Top and Bottom buttons to move it to the top or bottom of the list. This new 
order of systems in the pick list becomes the default setting for your current and 
future sessions of PC*MILER|Rail, until the next time you change the list order. 
 
Check Label places not on RRs to show place names in areas surrounding the 
railroads that are drawn on the map.  If this box is not checked, only freight stations 
on the route of the rail line will be drawn.  A different font is used for all place 
names in surrounding areas, to differentiate them from junctions on rail lines. 
 
If Display track ownership is checked, the colors used to draw rail lines on the 
map will reflect track ownership rather than trackage rights.  See section 6.2.7 
below. 
 
To frame a railroad in the map window, highlight it, click >>Show>> and check 
Frame carrier(s), then click OK. 

 
 

6.2.7  Legends 
 
There are three legends available in the map window: Railroad, Route and Scale 
of Miles.  All legends can be moved around within the map window by clicking 
and dragging.  They can be hidden or shown using the Legend option in the Map 
menu.  Check one or more legends in the sub-menu to display them.  When 
checked, the Carrier Legend appears when railroads are displayed, the Route 
Legend appears after a route is run, and the Scale of Miles legend always appears 
as part of the map. 
 

                                     

         Route Legend       Carrier Legend        Scale of Miles 
 
 
The Carrier Legend provides a key to the display of rail lines owned or operated 
through trackage or haulage rights.  Rail lines are drawn on the map in different 
colors that show which railroad holds the trackage rights on any given line.  
However, if Display track ownership is checked in the Railroad Display Control 
dialog, the colors will reflect ownership.  Note that a rail line drawn in yellow 
indicates joint ownership.  To see which railroads jointly own a line drawn in 
yellow, click on the Label Railroads button on the tool bar and then click on the 
line on the map. 
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6.2.8  Other Map Menu Options 
 

 
 
The Frame option selects an area of the map to frame in the map window.  
Choices are:  

 
 US Window frames the continental United States within the current window 

 NA Window frames the entire North American continent 

 All Routes frames all currently-displayed routes (using the Frame Routes 
button on the tool bar is another way to do this) 

 Auto Frame Routes, when checked, will frame all routes automatically as 
they are run, until it is turned off again. 

 
Redraw initiates a redraw of the current display.  
 
The Detail option controls the number of links and place names that are drawn on 
the map.  Choices are:  
 
 More can be used more than once to add links and place names 

 Less can be used more than once to decrease the number of links and place 
names 

 Default will return to the default number of links and place names.  The 
Default setting automatically increases the amount of detail when you zoom in 
on a particular area. 

 Use Shape Points, when selected, will display rail curves in more detail by 
drawing them using "shape points" instead of angles. 

 
TIP:  If you click the right mouse button with your cursor inside the map 
window, the Map menu will pop up. 
 
The Station Labels option lets you label stations on the map by either their 
Station ST (station name and state abbreviation) or SPLC. 
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6.2.9  Printing a Map    
 
To print a map that is currently displayed in the map window, choose Print Map... 
from the File menu or click on the Print button on the tool bar while the map 
window is active. 
 

 

 
 
 

6.2.10  Copying a Map to the Clipboard 
 
Maps can be copied to the clipboard for retrieval in other Windows programs.  To 
do this, choose Copy Map from the Edit menu while the map window is open 
and active.  When the map window is not active, the Copy option in the Edit 
menu will say “Copy Report”. 
 
 

 



 

 
 PC*MILER|Rail User’s Guide 86 

 
 

     About ALK Technologies, Inc. 
 
 

7.1  About ALK Technologies 

ALK Technologies, Inc., headquartered in Princeton, NJ, was founded in 1979 as 
a transportation industry pioneer. ALK harnesses the power of information 
technology to enhance transportation and mobility, supporting competitive 
advantage and improved quality of life. 
 
Today, ALK is a global leader in GeoLogistics™ and navigation software. 
GeoLogistics is our portfolio of specialized enterprise solutions for worldwide 
routing, mileage and mapping, used by customers in transportation, logistics, 
manufacturing, mobile workforce management and government. Our commercial 
trucking applications are relied upon by companies worldwide and our in-vehicle 
GPS navigation and route guidance solutions are among the most award-winning 
solutions in the world. 
 
We pride ourselves on being a market leader in transportation and travel 
technology. ALK's leadership in applying that technology to solve important 
problems continues as strongly today as when we began over 30 years ago. Now 
part of Trimble's (NASDAQ: TRMB) international Transportation and Logistics 
division, we remain committed to providing our customers with solutions that 
work for them to lower costs, improve service and safety and minimize harm to 
the environment. 
 
See section 7.2 below for an overview of ALK’s Enterprise Solutions.  For 
detailed product information, visit us at www.alk.com or www.pcmiler.com. 
  
 
 
 
 

 
 
 
 
 
 
 
 
 

7 C
h

ap
te

r 



  

 
 Chapter 7: About ALK Technologies, Inc. 87 

7.2  Enterprise Solutions from ALK Technologies 

Contact a PC*MILER Enterprise Solutions Sales Representative to find out how 
the following value-add on solutions can boost productivity, reduce out-of-route 
mileage and improve return on investment. 
 
 PC*MILER — PC*MILER is truck-specific, point to point routing, mileage 

and mapping software that the transportation and logistics industry depends 
on to succeed. Accuracy and reliability have positioned PC*MILER as the 
software used by 98 of the top 100 motor carriers, 46 of the top 50 freight 
transportation firms and 48 of the top 50 logistics companies in North 
America. The U.S. Department of Defense (DoD), the General Services 
Administration (GSA) and the Federal Motor Carrier Safety Administration 
(FMCSA) also rely on PC*MILER as their worldwide distance standard. 

 PC*MILER|Traffic – PC*MILER|Traffic calculates more accurate transit 
times and ETAs with real time, historical and predictive traffic speed data. It 
allows visualization of traffic trends directly on the PC*MILER map. 
PC*MILER|Traffic includes a “Fastest” routing type that optimizes overall 
transit time, taking into account real time traffic congestion and predictive 
traffic speeds, by the hour and by the day. 
 

 PC*MILER|Tolls — PC*MILER|Tolls calculates truck-specific toll costs 
based on a vehicle’s weight, axle count, trailer count, transaction type (cash or 
discount program), and time of day travel in the U.S. and Canada. It is driven 
by the same technology and map dataset as ALK's industry-standard 
PC*MILER routing, mileage and mapping software. When generating routes, 
truck-specific toll costs are added into a route’s overall calculation. Determine 
whether it's more cost-effective to take a toll route, or a non-toll route with a 
few additional miles, before routing a vehicle.  
 

 PC*MILER|Streets — PC*MILER|Streets is street-level routing, mileage 
and mapping software designed to provide dock-to-dock driving directions 
over truck-specific routes.  It includes all the features and functionality of 
PC*MILER plus an enhanced street-level routing network, map database, and 
street address database. Ensure that your vehicles and loads get to the right 
place using the most precise truck-specific route possible, taking into 
consideration truck-preferred and truck-restricted roads. PC*MILER|Streets 
data is available for the U.S. and Canada and, with PC*MILER|Worldwide, 
for Argentina/Brazil, Europe, and Australia/New Zealand. 
 

 PC*MILER|HazMat — PC*MILER|HazMat generates point to point and 
street-level routes, mileage and driving directions for hauling hazardous 
materials and dangerous goods in the U.S. and Canada. Federal government 
mandates state that shippers and carriers are to implement security plans 
regarding the transport of hazardous materials. A major step in that process is 
providing drivers with routes and mileage that ensure compliance with these 
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federal, state/province and local restrictions and route designations. To ensure 
fleet and driver safety, PC*MILER|HazMat identifies where drivers should 
legally be traveling for the particular type of hazardous commodity they are 
hauling.  
 

 PC*MILER|Fuel Optimization — (Available with PC*MILER|Connect, 
PC*MILER Web and/or PC*MILER Web Services only)  PC*MILER|Fuel 
Optimization determines where to purchase the most cost-effective fuel and 
tell drivers where to find it.  With PC*MILER|Fuel Optimization, optimized 
fuel purchase plans based on daily fuel prices are seamlessly integrated into 
PC*MILER’s routes, reports and driving directions.  The optimized fuel plan 
provides purchasing information within the fleet’s fueling networks, 
indicating where to make fuel purchases and how much fuel to buy at a given 
location.  With fuel prices constantly changing, optimized fuel purchase plans 
can save 4 to 11 cents per gallon — a conservative average annual savings of 
$1,100 per truck per year. 
 

 PC*MILER|Worldwide — PC*MILER|Worldwide is point-to-point routing, 
mileage and mapping software that generates routes, distances, maps and 
driving directions over the entire international highway network. Employ the 
functionality of PC*MILER across worldwide data coverage, including North 
America, South America, Europe, Africa, Asia, and Oceania.  Additionally, 
street-level address data modules are available for Argentina/Brazil, Europe, 
and Australia/New Zealand. 
 

 PC*MILER|FuelTax — PC*MILER|FuelTax fully automates fuel and 
mileage tax tracking, calculation and reporting. The software includes easy-
to-use tax forms and rates for all jurisdictions, and generates post-operations 
analysis reports that help identify fuel purchase and trip conflicts in self-
audits. PC*MILER|FuelTax can be used as a stand-alone product or integrated 
with PC*MILER to automatically generate distances within the provided trip 
sheets.  
 

 PC*MILER|Rail — PC*MILER|Rail is the rail and logistics industry's 
leading routing, mileage and mapping software. Widely used in fuel surcharge 
calculation, equipment management, rail car mileage auditing, carrier 
selection, rate determination and negotiation, and ad valorem tax reporting, 
PC*MILER|Rail determines actual operating or fuel surcharge routes and 
mileage using station/state abbreviations or railroad industry codes. Through 
ALK’s close working relationship with all major railroads, PC*MILER|Rail 
features the most accurate digital representation of the North American rail 
network. 
 

 PC*MILER Navigator — PC*MILER Navigator is the first all-in-one GPS 
navigation system specifically designed for company drivers, owner 
operators, and leased operators to provide industry-standard PC*MILER 
directions in the cab.  Powered by ALK’s award-winning CoPilot mobile 
navigation technology, PC*MILER Navigator is changing the way 



  

 
 Chapter 7: About ALK Technologies, Inc. 89 

commercial truck drivers work, making it possible for spoken street-level 
directions to be generated anywhere within seconds. 
 

 CoPilot® Truck — CoPilot Truck offers an easy to use, intuitive interface 
with spoken turn-by-turn directions and easy to follow, non-distracting 
guidance displays. Unlike standard car navigation systems, it calculates 
efficient routes based on your vehicle profile information, routing parameters 
and load type, including hazardous materials.  Running conveniently on a 
wide range of smartphones, tablets and laptops, CoPilot Truck uses street-
level ALK Digital Maps™ enhanced with industry standard PC*MILER 
truck-specific attributes featuring 3.52 million commercial truck restrictions 
and allowances. With powerful multi-stop routing it effortlessly provides the 
optimal route for any itinerary, while automatically avoiding commercial 
truck restrictions to increase efficiency, reduce mileage and help avoid costly 
fines and vehicle damage. 

 
 

CONNECTIVITY and INTERFACE PRODUCTS 
   
 PC*MILER|Connect — PC*MILER|Connect seamlessly interfaces 

PC*MILER routes, mileage and reports with third-party and custom systems, 
such as transportation and logistics management software systems. Client 
applications are able to retrieve PC*MILER distances, detailed driving 
directions, drive times, state-by-state mileage summaries, stop optimization 
functionalities and more. 
 

 Multi-Version Switch (MVS) — Multi-Version Switch is a high-end 
function of PC*MILER|Connect that serves as an integration tool designed to 
simultaneously support multiple versions of PC*MILER that are installed on 
one server or on several different servers.  Instead of manually querying data 
from each individual version, the Multi-Version Switch functions as the main 
connection point to programmatically gain access to the version of choice. 
 

 PC*MILER Web Services — PC*MILER Web Services is an integration 
tool designed to efficiently fulfill all PC*MILER routing, mileage and 
mapping transactions in a simple hardware and software-agnostic system 
interface to any computing platform. It offers a standardized way of 
integrating PC*MILER with Web Services, .NET, or Web-based applications 
using XML (Extensible Markup Language) and SOAP (Simple Object Access 
Protocol) over an Internet Protocol Backbone – all developed in Microsoft 
.NET. 
 

 PC*MILER|Mapping — PC*MILER|Mapping seamlessly interfaces 
PC*MILER routes and geographic data on maps for integration with real-time 
dispatch and operations analysis programs. PC*MILER|Mapping allows you 
to include commands in spreadsheets, databases and custom systems to obtain 
a visual overview of your data.  
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 PC*MILER|Spreadsheets — PC*MILER|Spreadsheets gives you the ability 
to access PC*MILER features and functionality from within your own 
spreadsheet software. Generate point-to-point or street-level mileage and 
drive times within a spreadsheet program, and then use built-in functions to 
summarize and analyze your data. PC*MILER|Spreadsheets provides a 
seamless interface with PC*MILER and Microsoft® Excel®, allowing you to 
perform customized data analyses. 
 

 PC*MILER|BatchPro — PC*MILER|BatchPro is a batch-processing tool 
that permits the simultaneous processing of large volumes of lanes (set as 
origin/destination pairs) entered as city/state combinations, ZIP or Postal 
Codes, or latitude/longitude coordinates rather than entering routes 
individually. It gives you the ability to generate routes, mileage, as well as 
cost and time information per route. 
 

 PC*MILER|TCP/IP — PC*MILER|TCP/IP is an integration tool that 
provides an interface to PC*MILER|Connect running in a Windows® 
environment to an application residing on another platform. Through a 
TCP/IP network, client applications can access a text-based interface to call 
PC*MILER|Connect's features and functionality. The interface opens cross 
platform communications in a thread-safe manner, giving you the flexibility to 
transmit the output of PC*MILER|Connect to multiple networks within your 
organization.  

   

POSTAL CODE & SPLC ADD-ON DATA MODULES 

 Canadian Postal Codes — Enhance the PC*MILER database with six-digit 
Canadian Postal Codes.  Enables search and display of corresponding 
city/province names to enter them as stops along a route. 
 

 Standard Point Location Codes (SPLC) — Add SPLC to the PC*MILER 
database to generate routes for rating and freight bill auditing.  A SPLC 
provides each point originating freight and each point receiving freight in 
North America with a unique code number that identifies the point by its 
geographic location. 

 
 

1-800-377-MILE 
www.alk.com 

ALK Technologies, Inc. 
457 North Harrison Street 

Princeton, New Jersey 08540 
U.S.A. 
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     Abbreviations for States/Provinces 
in the U.S. and Canada 

 
 

The list below can be used as a reference for route entry.  All states/provinces that 
have at least one active railroad are listed.  For Mexican estados, see Appendix B. 

 
 

State Name Abbreviation FIPS 

Alabama AL 01 

Alaska AK 02 

Arizona AZ 04 

Arkansas AR 05 

California CA 06 

Colorado CO 08 

Connecticut CT 09 

Delaware DE 10 

District of Columbia DC 11 

Florida FL 12 

Georgia GA 13 

Idaho ID 16 

Illinois IL 17 

Indiana IN 18 

Iowa IA 19 

Kansas KS 20 

Kentucky KY 21 

Louisiana LA 22 

Maine ME 23 

Maryland MD 24 

Massachusetts MA 25 

Michigan MI 26 

Minnesota MN 27 

Mississippi MS 28 

Missouri MO 29 

Montana MT 30 

Nebraska NE 31 

Nevada NV 32 
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New Hampshire NH 33 

New Jersey NJ 34 

New Mexico NM 35 

New York NY 36 

North Carolina NC 37 

North Dakota ND 38 

Ohio OH 39 

Oklahoma OK 40 

Oregon OR 41 

Pennsylvania PA 42 

Rhode Island RI 44 

South Carolina SC 45 

South Dakota SD 46 

Tennessee TN 47 

Texas TX 48 

Utah UT 49 

Vermont VT 50 

Virginia VA 51 

Washington WA 53 

West Virginia WV 54 

Wisconsin WI 55 

Wyoming WY 56 

   

Alberta AB 84 

British Columbia BC 83 

Manitoba MB 86 

New Brunswick NB 89 

Newfoundland & 
Labrador 

NF 92 

Northwest Territory NT 82 

Nova Scotia NS 91 

Ontario ON 87 

Prince Edward Island PE 90 

Quebec PQ 88 

Saskatchewan SK 85 
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Abbreviations for Mexican Estados 

 
 
PC*MILER|Rail now requires Mexican estado abbreviations to be entered when 
entering Mexican locations on a route.  All estados that have at least one active 
railroad are listed.  
 
 
 

Abbrev. Estado FIPS 

AG Aguascalientes 94 
BJ Baja California 95 
BS Baja California Sur 96 
CP Campeche 97 
CH Chiapas 98 
CI Chihuahua 99 
CU Coahuila 100 
CL Colima 101 
DF Distrito Federal 102 
DG Durango 103 
GJ Guanajuato 104 
HG Hidalgo 106 
JA Jalisco 107 
EM Mexico (Estado) 108 
MH Michoacan 109 
MR Morelos 110 
NA Nayarit 111 
NL Nuevo Leon 112 
OA Oaxaca 113 
PU Puebla 114 
QA Queretaro 115 
SL San Luis Potosi 117 
SI Sinaloa 118 
SO Sonora 119 
TA Tabasco 120 
TM Tamaulipas 121 
TL Tlaxcala 122 
VL Veracruz 123 
YC Yucatan 124 
ZT Zacatecas 125 
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Fuel Surcharge Railroad Reference 
 
 
Fuel surcharge calculations are now required by the recent Surface Transportation 
Board ruling STB Ex Parte No. 661.  The railroads listed below have chosen 
PC*MILER|Rail Practical miles as their standard for fuel surcharge calculations. 
All other major railroads chose PC*MILER|Rail Shortest miles as the standard.  
 
Therefore, PC*MILER|Rail uses Shortest miles by default when Fuel Surcharge 
routes are generated but uses Practical routing for the railroads listed below. 
 
 
SCAC RRN Routing Option 
 
CLP  169 Practical 
CN  103 Practical 
GMRC  314 Practical 
KCS  400 Practical 
MPLI  984 Practical 
NYOG  585 Practical 
TCWR  768 Practical 
VTR  817 Practical 
WACR  812 Practical 
WSOR  879 Practical 
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Railroads Sorted by SCAC 
 

 
SCAC  RAILROAD NAME 

AA  ANN ARBOR RAILROAD 

AB  AKRON BARBERTON CLUSTER RAILWAY COMPANY 

ABL  ALAMEDA BELT LINE 

ABR  ATHENS LINE LLC, THE 

ABS  ALABAMA SOUTHERN RAILROAD 

ABWR  ALABAMA WARRIOR RAILWAY, LLC. 

ACJR  ASHTABULA CARSON & JEFFERSON RAILROAD 

ACWR  ABERDEEN CAROLINA & WESTERN RAILWAY CO 

ADBF  ADRIAN & BLISSFIELD RAIL ROAD COMPANY 

AERC  ALBANY & EASTERN RAILROAD COMPANY 

AF  ALABAMA & FLORIDA RAILWAY CO 

AFR  AMADOR FOOTHILLS RAILROAD 

AGCR  ALAMO GULF COAST RAILROAD COMPANY 

AGR  ALABAMA & GULF COAST RAILWAY LLC 

AIKR  AIKEN RAILWAY COMPANY, LLC 

AKDN  ACADIANA RAILWAY COMPANY 

AKMD  ARKANSAS MIDLAND RAILROAD CO INC 

ALAB  ALABAMA RAILROAD CO INC 

ALM  ARKANSAS LOUISIANA & MISSISSIPPI RAILROAD COMPANY 

ALS  ALTON & SOUTHERN RAILWAY COMPANY 

ALT  AIRLAKE TERMINAL RAILWAY COMPANY 

AM  ARKANSAS AND MISSOURI RAILROAD CO 

AMTK  AMTRAK‐NATIONAL RAILROAD PASSENGER CORPORATION 

AN  AN RAILWAY LLC 

ANR  ANGELINA & NECHES RIVER RAILROAD COMPANY 

AO  APPALACHIAN & OHIO RAILROAD INC 

AOK  ARKANSAS‐OKLAHOMA RAILROAD INC 

AOR  THE ALIQUIPPA & OHIO RIVER RAILROAD COMPANY 

APA  APACHE RAILWAY COMPANY 

APD  ALBANY PORT DISTRICT 

APNC  APPANOOSE COUNTY COMMUNITY RAILROAD INC 

APR  ALBERTA PRAIRIE RAILWAY 

AR  ABERDEEN AND ROCKFISH RAILROAD COMPANY 

ARA  ARCADE AND ATTICA RAILROAD CORPORATION 

ARC  ALEXANDER RAILROAD COMPANY 

ARE  A & R LINE INC 

ARR  ALASKA RAILROAD CORPORATION 
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SCAC  RAILROAD NAME 

ARS  ARKANSAS SOUTHERN RAILROAD 

ARZC  ARIZONA & CALIFORNIA RAILROAD CO 

ASR  ALLEGHENY SOUTHERN RAILROAD INC 

ASRY  ASHLAND RAILWAY CO 

ATLT  AT & L RAILROAD CO INC 

ATN  ALABAMA & TENNESSEE RIVER RAILWAY LLC 

ATW  ATLANTIC & WESTERN RAILWAY, L P 

AUT  AUTAUGA NORTHERN RAILROAD LLC 

AVR  ALLEGHENY VALLEY RAILROAD COMPANY 

AWRR  AUSTIN WESTERN RAILROAD 

AWRY  ADAMS WARNOCK RAILWAY, INC. 

AWW  ALGERS WINSLOW AND WESTERN RAILWAY COMPANY 

AZCR  ARIZONA CENTRAL RAILROAD INC 

AZER  ARIZONA EASTERN RAILWAY COMPANY 

BAYL  BAY LINE RAILROAD L L C, THE 

BB  BUCKINGHAM BRANCH RAILROAD COMPANY 

BCLR  BAY COLONY RAILROAD CORPORATION 

BCR  BAY COAST RAILROAD 

BCRY  BARRIE‐COLLINGWOOD RAILWAY 

BDR  MCM RAIL SERVICES, LLC D/B/A BALTIMORE INDUSTRIAL RAILROAD 

BDRV  BELVIDERE & DELAWARE RIVER RAILWAY COMPANY INC 

BDTL  BALLARD TERMINAL RAILROAD CO LLC 

BDW  BIGHORN DIVIDE & WYOMING RAILROAD INC 

BEEM  BEECH MOUNTAIN RAILROAD COMPANY 

BGS  BIG SKY RAIL CORP 

BH  B&H RAIL CORP 

BHP  BHP NEVADA RAILROAD COMPANY 

BHR  BROOKHAVEN RAIL, LLC 

BHRR  BIRMINGHAM TERMINAL RAILWAY LLC 

BHWY  BOOT HILL & WESTERN RAILWAY CO LC 

BJRR  BAJA CALIFORNIA RAILROAD INC 

BJRY  BURLINGTON JUNCTION RAILWAY 

BKRR  BATTEN KILL RAILROAD INC 

BLMR  BLUE MOUNTAIN RAILROAD INC 

BLOL  BLOOMER LINE, THE 

BLR  BLACKLANDS RAILROAD THE 

BML  BELFAST AND MOOSEHEAD LAKE RAILROAD COMPANY 

BNG  BLACKWELL NORTHERN GATEWAY RAILROAD COMPANY 

BNML  BURLINGTON NORTHERN (MANITOBA) LTD 

BNSF  BNSF RAILWAY COMPANY 

BOCT  BALTIMORE AND OHIO CHICAGO TERMINAL RAILROAD CO 

BOP  BORDER PACIFIC RAILROAD CO 

BPRR  BUFFALO & PITTSBURGH RAILROAD INC 
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SCAC  RAILROAD NAME 

BRAN  BRANDON RAILROAD LLC 

BRC  BELT RAILWAY COMPANY OF CHICAGO 

BRG  BROWNSVILLE AND RIO GRANDE INTERNATIONAL RR 

BRR  BATTLE RIVER RAILWAY NGC INC 

BRW  BLACK RIVER & WESTERN CORPORATION 

BSDA  BI‐STATE DEVELOPMENT AGENCY 

BSOR  BUFFALO SOUTHERN RAILROAD INC 

BSR  BIG SPRING RAIL SYSTEM, INC. 

BSVY  BOONE & SCENIC VALLEY RAILROAD 

BTR  BOUNDARY TRAIL RAILWAY COMPANY INC. 

BVRR  BOISE VALLEY RAILROAD, INC. 

BVRY  BRANDYWINE VALLEY RAILROAD COMPANY 

BXN  BAUXITE & NORTHERN RAILWAY COMPANY 

CA  CHESAPEAKE & ALBEMARLE 

CAGY  COLUMBUS AND GREENVILLE RAILWAY 

CALA  CAROLINA SOUTHERN RAILROAD COMPANY, THE 

CBNS  CAPE BRETON & CENTRAL NOVA SCOTIA RAILWAY 

CBR  COOS BAY RAILROAD OPERATING CO., LLC 

CBRW  COLUMBIA BASIN RAILROAD COMPANY INC 

CBRY  COPPER BASIN RAILWAY INC 

CCH  COLUMBUS & CHATTAHOOCHEE RAILROAD, INC 

CCKY  CHATTOOGA & CHICKAMAUGA RAILWAY CO 

CCPN  CORPUS CHRISTI TERMINAL RAILROAD INC 

CCRA  CAMP CHASE INDUSTRIAL RAILROAD CORPORATION 

CCRL  CLEVELAND COMMERCIAL RAILROAD COMPANY LLC 

CCRR  CLAREMONT CONCORD RAILROAD CORPORATION 

CCT  CENTRAL CALIFORNIA TRACTION COMPANY 

CCUO  CHICAGO‐CHEMUNG RAILROAD CORP 

CEIW  CENTRAL INDIANA & WESTERN RAILROAD CO INC 

CEMR  CENTRAL MANITOBA RAILWAY INC 

CERA  CENTRAL RAILROAD COMPANY OF INDIANAPOLIS 

CF  CAPE FEAR RAILWAYS INC 

CFE  CHICAGO FT WAYNE & EASTERN A DIVISION OF CENTRAL RAILROAD OF INDIANAPOLIS INC 

CFL  C F LANAUDIERE INC 

CFNR  CALIFORNIA NORTHERN RAILROAD COMPANY LP 

CFWR  CANEY FORK AND WESTERN RR 

CGR  CG RAILWAY INC 

CHAT  CHATTAHOOCHEE BAY RAILROAD INC 

CHB  CLEVELAND HARBOR BELT RAILROAD, LLC 

CHR  CHESTNUT RIDGE RAILWAY COMPANY 

CHRC  CHAPARRAL RAILROAD COMPANY INC 

CHRR  CHESAPEAKE RAILROAD COMPANY 

CHS  CHARLOTTE SOUTHERN RAILROAD COMPANY 
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CI  CAMBRIA AND INDIANA RAILROAD COMPANY 

CIC  CEDAR RAPIDS & IOWA CITY RAILWAY COMPANY 

CIND  CENTRAL RAILROAD OF INDIANA 

CIR  CITY OF ROCHELLE ILLINOIS 

CIRR  CHATTAHOOCHEE INDUSTRIAL RAILROAD 

CIRY  CENTRAL ILLINOIS RAILROAD COMPANY 

CKIN  CHESAPEAKE AND INDIANA RAILROAD COMPANY INC 

CLC  COLUMBIA & COWLITZ RAILWAY LLC 

CLCY  CHESSIE LOGISTICS CO., LLC 

CLNA  CAROLINA COASTAL RAILWAY INC 

CLP  CLARENDON AND PITTSFORD RAILROAD COMPANY, THE 

CM  CENTRAL MONTANA RAIL INC 

CMPA  MADISON RAILROAD (A DIV OF CITY OF MADISON PORT AUTHORITY) 

CMR  CENTRAL MIDLAND RAILWAY COMPANY 

CMRR  COMSTOCK MOUNTAIN LION RAILROAD, INC. 

CMSL  CAPE MAY SEASHORE LINES 

CN  CANADIAN NATIONAL RAILWAYS 

CNAT  CN AQUATRAIN 

CNOW  COLUMBIA & NORTHERN RAILWAY CO 

CNUR  C & NC RAILROAD CORPORATION 

CNYK  CENTRAL NEW YORK RAILROAD CORPORATION 

CNZR  CENTRAL NEW ENGLAND RAILROAD CO INC 

COEH  CONECUH VALLEY RAILWAY LLC 

COER  CRAB ORCHARD & EGYPTIAN RAILWAY A DIVISION OF PROGRESSIVE RAIL IN 

COP  CITY OF PRINEVILLE RAILWAY 

CORP  CENTRAL OREGON & PACIFIC RAILROAD INC 

CORY  COLUMBIA & READING RAILWAY CO 

CPDR  CAROLINA PIEDMONT DIVISION SOUTH CAROLINA CENTRAL RAILROAD COMPANY INC 

CPMY  COOPERSVILLE AND MARNE RAILWAY COMPANY 

CPR  CATERPARROTT RAILNET, LLC 

CPRS  CANADIAN PACIFIC RAILWAY 

CRL  CHICAGO RAIL LINK 

CSCD  CASCADE AND COLUMBIA RIVER RAILROAD COMPANY 

CSKR  C & S RAILROAD CORPORATION 

CSO  CONNECTICUT SOUTHERN RAILROAD INC 

CSR  CAMDEN & SOUTHERN RAILROAD INC 

CSS  CHICAGO SOUTHSHORE & SOUTH BEND RAILROAD 

CSXT  CSX TRANSPORTATION 

CT  COLUMBIA TERMINAL 

CTM  CHICAGO TERMINAL RAILROAD 

CTN  CANTON RAILROAD COMPANY 

CTR  CLINTON TERMINAL RAILROAD COMPANY 

CTRR  CLOQUET TERMINAL RAILROAD COMPANY INC 
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CTRW  CARLTON TRAIL RAILWAY COMPANY 

CUOH  COLUMBUS & OHIO RAILROAD COMPANY 

CVR  CIMARRON VALLEY RAILROAD L C 

CVRC  PROGRESSIVE RAIL INC D/B/A CANNON VALLEY RAILROAD COMPANY 

CVYR  CADDO VALLEY RAILROAD COMPANY 

CW  COLORADO & WYOMING RWY CO 

CWA  CENTRAL WASHINGTON RAILROAD COMPANY 

CWCY  CALDWELL COUNTY RAILROAD COMPANY 

CWR  CWRR INC 

CWRO  CLEVELAND WORKS RAILWAY COMPANY 

CWRY  COMMONWEALTH RAILWAY INC 

CZRY  CARRIZO GORGE RAILWAY INC 

DAIR  D & I RAILROAD COMPANY 

DAKS  DAKOTA SHORT LINE 

DALT  DALLAS TERMINAL RAILWAY 

DC  DELRAY CONNECTING RAILROAD COMPANY 

DCLR  DELAWARE COAST LINE RR CO 

DCON  DETROIT CONNECTING RAILROAD COMPANY 

DCRR  DUBOIS COUNTY RAILROAD 

DGNO  DALLAS GARLAND & NORTHEASTERN RAILROAD INC 

DGVR  DURBIN & GREENBRIER VALLEY RAILROAD INC 

DL  DELAWARE‐LACKAWANNA RAILROAD CO INC 

DLWR  DEPEW LANCASTER & WESTERN RAILROAD CO INC 

DMM  DANSVILLE AND MOUNT MORRIS RAILROAD COMPANY, THE 

DMVW  DAKOTA MISSOURI VALLEY & WESTERN RAILROAD INC 

DN  DAKOTA NORTHERN RAILROAD INC 

DQE  DEQUEEN & EASTERN RAILROAD LLC 

DR  DARDANELLE & RUSSELLVILLE RAILROAD COMPANY 

DRIR  DENVER ROCK ISLAND RAILROAD 

DSC  DRAKE SWITCHING COMPANY, LLC 

DSRC  DAKOTA SOUTHERN RAILWAY COMPANY 

DSRR  DELTA SOUTHERN RAILROAD COMPANY 

DT  DECATUR JUNCTION RAILWAY COMPANY 

DV  DELAWARE VALLEY RAILWAY COMPANY INC 

DVR  DEVCO RY (CAPE BRETON DEVELOPMENT CORP) 

DVS  DELTA VALLEY & SOUTHERN RAILWAY COMPANY 

EACH  EAST CAMDEN & HIGHLAND RR CO 

EARY  EASTERN ALABAMA RAILWAY 

EBG  EASTERN BERKS GATEWAY RAILROAD COMPANY 

EBSR  EAST BROOKFIELD & SPENCER RAILROAD LLC 

ECBR  EAST COOPER AND BERKELEY RAILROAD COMPANY 

ECO  ECORAIL INC 

ECTB  EAST CHATTANOOGA BELT RAILWAY COMPANY 



  

 

 PC*MILER|Rail User’s Guide 100 

SCAC  RAILROAD NAME 

EDW  EL DORADO AND WESSON RAILWAY COMPANY 

EE  ELLIS & EASTERN COMPANY 

EEC  EAST ERIE COMMERCIAL RAILROAD 

EFRR  EFFINGHAM RAILROAD COMPANY 

EIRC  EASTERN ILLINOIS RAILROAD COMPANY 

EIRR  EASTERN IDAHO RAILROAD INC 

EJR  EAST JERSEY RAILROAD AND TERMINAL COMPANY 

ELKR  ELK RIVER RAILROAD INC 

ELS  ESCANABA AND LAKE SUPERIOR RAILROAD COMPANY 

EMHR  EAST MAHANOY & HAZELTON RAILROAD COMPANY 

EMRY  EASTERN MAINE RAILWAY COMPANY 

ENR  E & N RAILWAY COMPANY (1998) LTD 

ESPN  EAST PENN RAILROAD LLC 

ETL  ESSEX TERMINAL RAILWAY COMPANY THE 

ETRY  EAST TENNESSEE RAILWAY, L P 

EV  EVERETT RAILROAD 

EVWR  EVANSVILLE WESTERN RAILWAY INC 

EWG  EASTERN WASHINGTON GATEWAY RAILROAD COMPANY 

EWR  ELKHART & WESTERN RAILROAD CO 

FC  FULTON COUNTY RAILROAD INC 

FCCM  COMPANIA DE FERROCARRILES CHIAPAS MAYAB SA DE CV 

FCEN  FLORIDA CENTRAL RAILROAD CO 

FCR  FULTON COUNTY RAILWAY LLC 

FCRD  FIRST COAST RAILROAD INC 

FEC  FLORIDA EAST COAST RAILWAY, LLC 

FGLK  FINGER LAKES RAILWAY CORP 

FIR  FLATS INDUSTRIAL RAILROAD COMPANY 

FMID  FLORIDA MIDLAND RAILROAD CO INC 

FMRC  FARMRAIL CORPORATION 

FNOR  FLORIDA NORTHERN RAILROAD COMPANY INC 

FP  FORDYCE AND PRINCETON RAILROAD CO 

FRR  FALLS ROAD RAILROAD CO INC 

FRVT  FORE RIVER TRANSPORTATION CORPORATION 

FSR  FORT SMITH RAILROAD CO 

FSRR  FERROSUR S A DE C V 

FWCR  FLORIDA WEST COAST RAILROAD INC 

FWDB  FORT WORTH & DALLAS BELT RAILROAD 

FWWR  FORT WORTH & WESTERN RAILROAD 

FXE  FERROCARRIL MEXICANO S A DE C V 

GC  GEORGIA CENTRAL RAILWAY L P 

GCK  GEORGES CREEK RAILWAY 

GCW  GARDEN CITY WESTERN RAILWAY COMPANY, THE 

GDLK  GRAND ELK RAILROAD, LLC. 
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GET  GETTYSBURG & NORTHERN RAILROAD CO 

GEXR  GODERICH‐EXETER RAILWAY COMPANY LTD 

GFR  GRAND FORKS RAILWAY COMPANY 

GFRR  GEORGIA & FLORIDA RAILNET INC 

GITM  GOLDEN ISLES TERMINAL RAILROAD INC 

GLC  GREAT LAKES CENTRAL RAILROAD 

GLSR  GLOSTER SOUTHERN RAILROAD COMPANY 

GMR  GEORGIA MIDLAND RAILROAD INC 

GMRC  GREEN MOUNTAIN RAILROAD CORPORATION 

GNBC  GRAINBELT CORPORATION 

GNPR  GNP RLY INC. 

GNRR  GEORGIA NORTHEASTERN RAILROAD CO 

GR  GRAND RAPIDS EASTERN RAILROAD INC 

GRD  GARDENDALE RAILROAD, INC 

GRLW  GREENVILLE & WESTERN RAILWAY COMPANY LLC 

GRNW  GREAT NORTHWEST RAILROAD INC 

GRR  GEORGETOWN RAILROAD COMPANY 

GRW  GARY RAILWAY COMPANY 

GRWR  GREAT WALTON RAILROAD CO, THE 

GRYR  GRENADA RAILWAY LLC 

GS  GEORGIA SOUTHERN RAILWAY CO. 

GSM  GREAT SMOKEY MOUNTAINS RAILWAY INC 

GSWR  GEORGIA SOUTHWESTERN RAILROAD INC 

GTR  GREAT RIVER RAILROAD 

GTRA  GOLDEN TRIANGLE RAILROAD LLC 

GU  GRAFTON AND UPTON RAILROAD COMPANY 

GVSR  GALVESTON RAILROAD LP 

GWR  GREAT WESTERN RAILWAY OF COLORADO LLC 

GWRC  GEORGIA WOODLANDS RAILROAD CO 

GWRS  GREAT WESTERN RAILWAY LTD 

GWWE  GATEWAY EASTERN RAILWAY COMPANY 

HAL  HILTON & ALBANY RAILOAD, INC. 

HB  HAMPTON & BRANCHVILLE RAILROAD COMPANY 

HBRY  HUDSON BAY RAILWAY COMPANY 

HCRR  HONEY CREEK RAILROAD INC 

HCRY  HURON CENTRAL RAILWAY INC 

HE  HOLLIS & EASTERN R R CO 

HESR  HURON AND EASTERN RAILWAY COMPANY INC 

HIRR  HAINESPORT INDUSTRIAL RAILROAD LLC 

HLSC  HAMPTON RAILWAY INC 

HMCR  HUNTSVILLE & MADISON COUNTY RAILROAD AUTHORITY 

HN  HUTCHINSON AND NORTHERN RAILWAY COMPANY, THE 

HOB  HENDERSON OVERTON BRANCH 
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HOG  HEART OF GEORGIA RAILROAD INC 

HOS  HOOSIER SOUTHERN RAILROAD 

HPTD  HIGH POINT THOMASVILLE & DENTON RAILROAD COMPANY 

HR  HERITAGE RAILROAD CORP 

HRR  HONDO RAILWAY LLC 

HRRC  HOUSATONIC RAILROAD COMPANY INC 

HRS  HOLLIDAYSBURG AND ROARING SPRING RAILROAD COMPANY 

HRT  HARTWELL RAILROAD COMPANY 

HSRR  HARDIN SOUTHERN RAILROAD INC 

HTR  HEART OF TEXAS RAILROAD, LP 

IAIS  IOWA INTERSTATE RAILROAD LTD 

IANR  IOWA NORTHERN RAILROAD 

IANW  IOWA NORTHWESTERN RAILROAD 

IARR  IOWA RIVER RAILROAD INC 

IATR  IOWA TRACTION RAILWAY COMPANY 

IBT  INTERNATIONAL BRIDGE AND TERMINAL COMPANY, THE 

ICRK  INDIAN CREEK RAILROAD COMPANY 

IERR  INDIANA EASTERN RAILROAD LLC 

IHB  INDIANA HARBOR BELT RAILROAD COMPANY 

ILW  ILLINOIS WESTERN RAILROAD COMPANY 

IMRR  ILLINOIS & MIDLAND RAILROAD INC 

IN  INDIANA NORTHEASTERN RAILROAD COMPANY INC 

INPR  IDAHO NORTHERN & PACIFIC RAILROAD COMPANY 

INRD  INDIANA RAIL ROAD CORPORATION 

IORY  INDIANA & OHIO RAILWAY COMPANY 

IR  ILLINOIS RAILNET INC 

ISR  IOWA SOUTHERN RAILROAD COMPANY 

ISRR  INDIANA SOUTHERN RAILROAD COMPANY INC 

ISW  INDIANA SOUTHWESTERN RAILWAY CO 

JAIL  JACKSON & LANSING RAILROAD COMPANY 

JKL  J K LINE INC 

JVRR  JUNIATA VALLEY RAILROAD COMPANY 

KAW  KAW RIVER RAILROAD 

KBSR  KANKAKEE BEAVERVILLE AND SOUTHERN RAILROAD COMPANY 

KCS  KANSAS CITY SOUTHERN RAILWAY COMPANY 

KCSM  KANSAS CITY SOUTHERN DE MEXICO S DE R L DE C V 

KCTL  KANSAS CITY TRANSPORTATION CO LLC 

KE  KANSAS EASTERN RAILROAD INC 

KFR  KETTLE FALLS INTERNATIONAL RAILWAY LLC 

KGTR  KINGMAN TERMINAL RAILROAD, LLC 

KJR  KISKI JUNCTION RAILROAD 

KJRY  KEOKUK JUNCTION RAILWAY 

KKRR  KNOX & KANE RAILROAD COMPANY 
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KNOR  KLAMATH NORTHERN RAILWAY COMPANY 

KO  KANSAS & OKLAHOMA RAILROAD INC 

KPR  KELOWNA PACIFIC RAILWAY LTD 

KRL  KASGRO RAIL LINES 

KRR  KIAMICHI RAILROAD COMPANY LLC 

KSRY  KOSCIUSKO SOUTHWESTERN RAILWAY 

KT  KENTUCKY AND TENNESSEE RAILWAY 

KTR  KENDALLVILLE TERMINAL RAILWAY CO 

KWT  KWT RAILWAY INC 

KXHR  KNOXVILLE & HOLSTON RIVER RAILROAD CO INC 

KYLE  KYLE RAILROAD COMPANY 

LAJ  LOS ANGELES JUNCTION RAILWAY COMPANY 

LAL  LIVONIA, AVON & LAKEVILLE RAILROAD CORPORATION 

LAS  LOUISIANA SOUTHERN RAILROAD 

LBR  LOWVILLE AND BEAVER RIVER RAILROAD COMPANY THE 

LC  LANCASTER & CHESTER RAILROAD, LLC. 

LCR  LAKE COUNTY RAILROAD 

LCRI  LONG CREEK RAILROAD COMPANY INC 

LDRR  LOUISIANA & DELTA RAILROAD INC 

LER  LOGANSPORT & EEL RIVER SHORT‐LINE CO INC 

LFCD  LINEA COAHUILA DURANGO SA DE CV 

LI  LONG ISLAND RAILROAD COMPANY 

LINC  LEWIS & CLARK RAILWAY CO 

LIRC  LOUISVILLE & INDIANA RAILROAD COMPANY 

LIRR  LAPEER INDUSTRIAL RAILROAD COMPANY 

LKRR  LITTLE KANAWHA RIVER RAIL INC 

LLR  LAKE LINE RAILROAD INC. 

LMIC  LAKE MICHIGAN AND INDIANA RAILROAD COMPANY 

LMR  LAST MOUNTAIN RAILWAY 

LNAL  LOUISVILLE NEW ALBANY & CORYDON RAILROAD 

LNVT  LANDISVILLE TERMINAL & TRANSFER COMPANY 

LNW  LOUISIANA AND NORTH WEST RAILROAD COMPANY, THE 

LRPA  LITTLE ROCK PORT RAILROAD 

LRS  LAURINBURG AND SOUTHERN RAILROAD COMPANY 

LRWN  LITTLE ROCK & WESTERN RAILWAY, L P 

LRWY  LEHIGH RAILWAY, LLC. 

LRY  LRY LLC. 

LS  LUZERNE AND SUSQUEHANNA RAILWAY COMPANY 

LSI  LAKE SUPERIOR & ISHPEMING RAILROAD COMPANY 

LSRC  LAKE STATE RAILWAY COMPANY 

LT  LAKE TERMINAL RAILROAD COMPANY, THE 

LVR  LANDISVILLE RAILROAD, LLC 

LVRB  LEHIGH VALLEY RAIL MANAGEMENT LLC ‐ BETHLEHEM DIVISION 
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LVRC  LAMOILLE VALLEY RAILROAD COMPANY 

LVRJ  LEHIGH VALLEY RAIL MANAGEMENT LLC ‐ JOHNSTOWN DIVISION 

LVRR  LYCOMING VALLEY RAILROAD COMPANY 

LVSW  LONGVIEW SWITCHING COMPANY 

LW  LOUISVILLE AND WADLEY RAILWAY COMPANY 

LXVR  LUXAPALILA VALLEY RAILROAD INC 

MAA  MAGMA ARIZONA RAILROAD COMPANY 

MAL  MICHIGAN AIR‐LINE RAILWAY CO 

MAN  MANNING RAIL, INC 

MAUP  MANATEE COUNTY PORT AUTHORITY 

MAW  MAUMEE & WESTERN RAILROAD CORPORATION 

MC  MASSACHUSETTS COASTAL RAILROAD LLC 

MCER  MASSACHUSETTS CENTRAL RAILROAD CORPORATION 

MCLR  MCLAUGHLIN LINE RAILROAD 

MCR  MCCLOUD RAILWAY COMPANY 

MCSA  MOSCOW, CAMDEN & SAN AUGUSTINE RAILROAD 

MD  C&J RAILROAD COMPANY D/B/A MISSISSIPPI DELTA RAILROAD 

MDDE  MARYLAND AND DELAWARE RAILROAD COMPANY 

MDS  MERIDIAN SOUTHERN RAILWAY LLC 

MDW  MINNESOTA DAKOTA & WESTERN RAILWAY COMPANY 

ME  MORRISTOWN & ERIE RAILWAY INC 

MERR  MORRISTOWN & ERIE RAILWAY INC D/B/A MAINE EASTERN RAILROAD 

MET  MODESTO AND EMPIRE TRACTION COMPANY 

METW  MUNICIPALITY OF EAST TROY WISCONSIN 

MGRI  MG RAIL INC 

MH  MT HOOD RAILROAD CO 

MHC  MOHALL CENTRAL RAILROAD INC 

MHWA  MOHAWK ADIRONDACK & NORTHERN RAILROAD CORP 

MIDH  MIDDLETOWN & HUMMELSTOWN RAILROAD COMPANY 

MJ  MANUFACTURERS JUNCTION RAILWAY COMPANY 

MMA  MONTREAL MAINE AND ATLANTIC RAILWAY LTD 

MMID  MARYLAND MIDLAND RAILWAY INC 

MMRR  MID‐MICHIGAN RAILROAD INC 

MMT  MISSION MOUNTAIN RAILROAD 

MNA  MISSOURI & NORTHERN ARKANSAS RAILROAD COMPANY INC 

MNBR  M&B RAILROAD LLC 

MNC  MOTIVE RAIL INC D/B/A MISSOURI NORTH CENTRAL RAILROAD 

MNJ  MIDDLETOWN & NEW JERSEY RAILWAY LLC 

MNN  MINNESOTA NORTHERN RAILROAD INC 

MNNR  MINNESOTA COMMERCIAL RAILWAY CO 

MNR  MAINE NORTHERN RAILWAY COMPANY 

MPLI  MINNESOTA PRAIRIE LINE INC 

MQT  MARQUETTE RAIL LLC 
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MRI  MOHALL RAILROAD INC 

MRL  MONTANA RAIL LINK INC 

MS  MICHIGAN SHORE RAILROAD INC 

MSCI  MISSISSIPPI CENTRAL RAILROAD COMPANY 

MSE  MISSISSIPPI EXPORT RAILROAD COMPANY 

MSN  BALLARD TERMINAL RAILROAD COMPANY LLC D/B/A MEEKER SOUTHERN RAILROAD 

MSO  MICHIGAN SOUTHERN RAILROAD CO INC 

MSR  MISSISSIPPI SOUTHERN RAILROAD 

MSRW  MISSISSIPPIAN RAILWAY COOPERATIVE INC 

MSTR  MASSENA TERMINAL RAILROAD COMPANY, THE 

MSV  MISSISSIPPI & SKUNA VALLEY RAILROAD LLC 

MSWY  MINNESOTA SOUTHERN RAILWAY INC 

MTNR  MISSISSIPPI TENNESSEE RAILROAD LLC 

MVP  MISSOURI & VALLEY PARK RAILROAD CORP 

MVRY  MAHONING VALLEY RAILWAY COMPANY, THE 

MVT  MT VERNON TERMINAL RAILWAY INC 

NAUG  NAUGATUCK RAILROAD COMPANY INC 

NBER  NITTANY & BALD EAGLE RAILROAD CO 

NBSR  NEW BRUNSWICK SOUTHERN RAILWAY COMPANY LIMITED 

NCIR  NEW CASTLE INDUSTRIAL RAILROAD 

NCPR  NORTH CAROLINA PORTS RAILWAY COMMISSION 

NCRC  NEBRASKA CENTRAL RAILROAD COMPANY 

NCRL  NC RAILROAD INC 

NCVA  NORTH CAROLINA & VIRGINIA RAILROAD CO INC 

NCYR  NASH COUNTY RAILROAD CORP 

NDCR  N D C RAILROAD COMPANY 

NECR  NEW ENGLAND CENTRAL RAILROAD INC 

NEGS  NEW ENGLAND SOUTHERN RAILROAD CO INC 

NENE  NEBRASKA NORTHEASTERN RAILWAY COMPANY 

NERR  NASHVILLE AND EASTERN RAILROAD CORP 

NFTS  THE NELSON AND FT. SHEPPARD RAILWAY CORPORATION 

NHCR  NEW HAMPSHIRE CENTRAL RAILROAD INC 

NHN  NEW HAMPSHIRE NORTHCOAST CORP 

NHRR  NEW HOPE & IVYLAND RAILROAD 

NHVT  NEW HAMPSHIRE AND VERMONT RAILROAD COMPANY 

NJRC  NEW JERSEY RAIL CARRIER LLC 

NKCR  NEBRASKA KANSAS & COLORADO RAILNET INC 

NLA  NORTH LOUISIANA & ARKANSAS RAILROAD 

NLR  NORTHERN LINES RAILWAY LLC 

NMGR  NEW MEXICO GATEWAY RAILROAD LLC 

NNW  NEBRASKA NORTHWESTERN RAILROAD INC. 

NOGC  NEW ORLEANS & GULF COAST RAILWAY COMPANY INC 

NOKL  NORTHWESTERN OKLAHOMA RAILROAD COMPANY 
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NOPB  NEW ORLEANS PUBLIC BELT RAILROAD 

NOW  NORTHERN OHIO & WESTERN RAILWAY LTD 

NPB  NORFOLK & PORTSMOUTH BELT LINE RAILROAD COMPANY 

NPR  NORTHERN PLAINS RAILROAD INC 

NRI  NEBKOTA RAILWAY INC 

NS  NORFOLK SOUTHERN RAILWAY COMPANY (NORFOLK SOUTHERN) 

NSHR  NORTH SHORE RAILROAD CO 

NSR  NEWBURGH & SOUTH SHORE RAILROAD COMPANY 

NTRY  NIMISHILLEN & TUSCARAWAS LLC 

NTZR  NATCHEZ RAILWAY LLC. 

NVRR  NAPA VALLEY RAILROAD CO 

NWP  NORTHWESTERN PACIFIC RAILROAD COMPANY 

NWR  NASHVILLE & WESTERN RAILROAD CORP 

NYA  NEW YORK & ATLANTIC RAILWAY COMPANY 

NYGL  NEW YORK & GREENWOOD LAKE RAILWAY 

NYLE  NEW YORK & LAKE ERIE RAILROAD 

NYNJ  NEW YORK NEW JERSEY RAIL LLC 

NYOG  NEW YORK & OGDENSBURG RAILWAY COMPANY INC 

NYSW  NEW YORK SUSQUEHANNA AND WESTERN RAILWAY CORP 

OAR  OLD AUGUSTA RAILROAD LLC 

OCTL  OIL CREEK & TITUSVILLE LINES 

OERR  OREGON EASTERN RAILROAD 

OHCR  OHIO CENTRAL RAILROAD CO 

OHIC  OHI‐RAIL CORPORATION 

OHIO  OHIO TERMINAL RAILWAY COMPANY 

OHPA  OHIO & PENNSYLVANIA RAILROAD COMPANY 

OHRY  OWEGO & HARFORD RAILWAY INC 

OKAN  OKANAGAN VALLEY RAILWAY COMPANY 

OLB  OMAHA LINCOLN AND BEATRICE RAILWAY COMPANY 

OLO  ONTARIO L'ORIGNAL RAILWAY INC 

OLYR  OLYMPIC RAILROAD CO, THE 

OMID  ONTARIO MIDLAND RAILROAD CORPORATION 

ONCT  ONTARIO CENTRAL RAILROAD CORPORATION 

ONT  ONTARIO NORTHLAND RAILWAY (ONTARIO NORTHLAND TRANS COMMISSION) 

OPE  OREGON PACIFIC & EASTERN RAILWAY COMPANY 

OPR  OREGON PACIFIC RAILROAD CO 

OPT  ORANGE PORT TERMINAL RAILWAY 

ORC  OGEECHEE RAILROAD COMPANY 

OSRR  OHIO SOUTHERN RAILROAD CO 

OTCO  OWENSVILLE TERMINAL CO INC 

OTT  OTTUMWA TERMINAL RAILROAD CO 

OTVR  OTTERTAIL VALLEY RAILROAD CO INC 

OUCH  OUACHITA RAILROAD 
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OVR  OHIO VALLEY RAILROAD COMPANY 

OVRR  OZARK VALLEY RAILROAD INC 

PAL  PADUCAH & LOUISVILLE RAILWAY 

PAM  PITTSBURGH ALLEGHENY & MCKEES ROCKS RR CO 

PAS  PAN AM SOUTHERN, LLC. 

PBR  PATAPSCO & BACK RIVERS RAILROAD COMPANY 

PBVR  PORT BIENVILLE RAILROAD 

PCC  PALOUSE RIVER & COULEE CITY RAILROAD INC 

PCN  POINT COMFORT & NORTHERN RAILWAY COMPANY 

PDRR  PEE DEE RIVER RAILROAD CORP 

PGR  PROGRESSIVE RAIL INC 

PHL  PACIFIC HARBOR LINE INC 

PHRR  PORT HARBOR RAILROAD INC 

PI  PADUCAH & ILLINOIS RAILROAD COMPANY 

PICK  PICKENS RAILWAY COMPANY 

PJR  PORT JERSEY RAILROAD CO 

PKHP  PICKENS RAILWAY COMPANY 

PN  PENNSYLVANIA NORTHEASTERN RAILROAD, LLC 

PNR  PANHANDLE NORTHERN RAILROAD COMPANY 

PNRW  PIEDMONT & NORTHERN RAILWAY 

PNW  PRESCOTT AND NORTHWESTERN RAILROAD COMPANY 

PNWR  PORTLAND & WESTERN RAILROAD INC 

POHC  THE PITTSBURGH & OHIO CENTRAL RAILROAD COMPANY 

POTB  PORT OF TILLAMOOK BAY RAILROAD 

POVA  PEND OREILLE VALLEY RAILROAD (PORT OF PEND OREILLE) 

PRV  PEARL RIVER VALLEY RAILROAD COMPANY 

PRY  PIONEER INDUSTRIAL RAILWAY CO 

PSAP 
THE PUGET SOUND & PACIFIC RAILROAD COMPANY A DIVISION OF THE ARIZONA & 
CALIFORNIA RAILROAD CO LP 

PSC  PYCO INDUSTRIES INC 

PSCC  PENNSYLVANIA & SOUTHERN RAILWAY LLC 

PSWR  PENNSYLVANIA SOUTHWESTERN RAILROAD INC 

PT  PENINSULA TERMINAL COMPANY 

PTC  PLAINVIEW TERMINAL COMPANY 

PTR  PORT TERMINAL RAILROAD OF SOUTH CAROLINA 

PTRA  PORT TERMINAL RAILROAD ASSOCIATION 

PTRC  PORTLAND TERMINAL RAILROAD COMPANY 

PUCC  PORT UTILITIES COMMISSION OF CHARLESTON SC 

PVJR  PORTLAND VANCOUVER JUNCTION RAILROAD LLC 

PVRR  PIONEER VALLEY RAILROAD COMPANY 

PVS  PECOS VALLEY PERMIAN RAILROAD LLC DBA PECOS VALLEY SOUTHERN RAILW 

PW  PROVIDENCE AND WORCESTER RAILROAD COMPANY 

QCR  QUEBEC CENTRAL RAILWAY COMPANY 
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QGRY  QUEBEC GATINEAU RAILWAY INC 

QRR  QUINCY RAILROAD COMPANY 

RARW  RARUS RAILWAY COMPANY 

RBMN  READING BLUE MOUNTAIN & NORTHERN RAILROAD COMPANY 

RCRR  RED COAT ROAD & RAIL LTD 

RCRY  RARITAN CENTRAL RAILWAY LLC 

RJCC  R J CORMAN RAILROAD COMPANY/CENTRAL KENTUCKY LINES 

RJCK  R J CORMAN RAILROAD COMPANY/TENNESSEE TERMINAL LLC 

RJCL  R J CORMAN RAILROAD COMPANY/CLEVELAND LINE 

RJCM  R J CORMAN RAILROAD COMPANY/MEMPHIS LINE 

RJCN  R J CORMAN RAILROAD COMPANY/ALLENTOWN LINES INC 

RJCP  R J CORMAN RAILROAD COMPANY/PENNSYLVANIA LINES INC 

RJCR  R J CORMAN RAILROAD CORPORATION/BARDSTOWN LINE 

RJCV  R J CORMAN RAILROAD COMPANY/WV LINE 

RJCW  R J CORMAN RAILROAD COMPANY/WESTERN OHIO LINE 

RL  RUTLAND LINE INC 

RLHH  RAILINK SOUTHERN ONTARIO 

RLK  RAILINK OTTAWA VALLEY 

RMRR  ROCKY MOUNTAIN RAILCAR AND RAILROAD INC 

RNA  RIPLEY & NEW ALBANY RAILROAD COMPANY 

RPP  RUSK, PALESTINE, & PACIFIC RAILROAD, LLC 

RPRC  RICHMOND PACIFIC RAILROAD CORPORATION 

RRC  REDMONT RAILWAY COMPANY INC 

RRRR  ROCK & RAIL INC 

RRVW  RED RIVER VALLEY & WESTERN RAILROAD CO 

RS  ROBERVAL AND SAGUENAY RAILWAY COMPANY, THE 

RSM  RAILROAD SWITCHING SERVICE OF MISSOURI INC 

RSNR  RED SPRINGS & NORTHERN RAILROAD CO 

RSOR  RICEBORO SOUTHERN RAILWAY LLC 

RSP  ROSCOE SNYDER & PACIFIC RAILWAY COMPANY 

RSR  ROCHESTER & SOUTHERN RAILROAD INC 

RSS  ROCKDALE SANDOW & SOUTHERN RAILROAD COMPANY 

RVPR  RIVERPORT RAILROAD LLC 

RVSC  RIO VALLEY SWITCHING COMPANY 

RVT  ROGUE VALLEY TERMINAL RAILROAD CORPORATION 

SAC  SAN ANTONIO CENTRAL RAILROAD, LLC 

SAN  SANDERSVILLE RAILROAD COMPANY 

SAPT  SAVANNAH PORT TERMINAL RAILROAD INC 

SAV  SACRAMENTO VALLEY RAILROAD 

SAW  SOUTH PLAINS SWITCHING LTD CO 

SBG  SAVAGE BINGHAM & GARFIELD RAILROAD COMPANY 

SBLN  STERLING BELT LINE RAILWAY 

SBRR  STOURBRIDGE RAILROAD COMPANY 
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SBVR  SOUTH BRANCH VALLEY RAIL ROAD 

SC  SANTA CRUZ AND MONTEREY BAY RAILWAY COMPANY 

SCBG  SANTA CRUZ BIG TREES & PACIFIC RAILWAY CO 

SCIH  SOUTH CHICAGO & INDIANA HARBOR RAILWAY COMPANY 

SCRF  SOUTH CAROLINA CENTRAL RAILROAD CO INC 

SCS  SQUAW CREEK SOUTHERN RAILROAD 

SCTR  SCTRR LLC 

SCXF  SOUTH CENTRAL FLORIDA EXPRESS INC 

SCXY  ST CROIX VALLEY RAILROAD COMPANY 

SDIY  SAN DIEGO & IMPERIAL VALLEY RAILROAD CO INC 

SE  SEMO PORT RAILROAD INC 

SERA  SIERRA RAILROAD COMPANY 

SFG  SOCIETE DU CHEMIN DE FER DE LA GASPESIE 

SFR  SOUTHERN FREIGHT RAILROAD 

SFS  SANTA FE SOUTHERN RAILWAY 

SGLR  SEMINOLE GULF RAILWAY L P 

SH  STEELTON & HIGHSPIRE RAILROAD COMPANY 

SIND  SOUTHERN INDIANA RAILWAY INC 

SJVR  SAN JOAQUIN VALLEY RAILROAD CO 

SKOL  SOUTH KANSAS & OKLAHOMA RAILROAD INC 

SL  SALT LAKE CITY SOUTHERN RAILROAD COMPANY INC 

SLAL  SOUTH PLAINS LAMESA RAILROAD LTD 

SLC  SAN LUIS CENTRAL RAILROAD COMPANY 

SLGG  S & L RAILROAD LLC 

SLGW  SALT LAKE GARFIELD AND WESTERN RAILWAY COMPANY 

SLQ  ST LAWRENCE & ATLANTIC RAILROAD (QUEBEC) INC 

SLR  ST LAWRENCE & ATLANTIC RAILROAD CO 

SLRG  SAN LUIS & RIO GRANDE RAILROAD INC 

SLRS  SMS RAIL SERVICE INC 

SLWC  STILLWATER CENTRAL RAILROAD COMPANY INC 

SM  SAINT MARYS RAILROAD COMPANY 

SMA  SAN MANUEL ARIZONA RAILROAD COMPANY 

SMNR  SOUTHERN MANITOBA RAILWAY INC 

SMRR  SISSETON MILBANK RAILROAD 

SMV  SANTA MARIA VALLEY RAILROAD COMPANY 

SMW  ST MARYS RAILWAY WEST LLC 

SNC  SARATOGA & NORTH CREEK RAILWAY 

SNR  SUNFLOUR RAILROAD INC 

SNY  SMS RAIL LINES OF NEW YORK LLC 

SOM  SOMERSET RAILROAD CORPORATION 

SORA  SOUTHERN RAILS COOPERATIVE LIMITED 

SPSR 
SAN PEDRO RAILROAD OPERATING CO LLC D/B/A SAN PEDRO & SOUTHWESTERN 
RAILROAD COMPANY 
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SQVR  SEQUATCHIE VALLEY RAILROAD INC 

SRC  STRASBURG RAILROAD COMPANY 

SRN  SABINE RIVER & NORTHERN RAILROAD COMPANY 

SRNJ  SOUTHERN RAILROAD COMPANY OF NEW JERSEY 

SRRR  SWAN RANCH RAILROAD LLC 

SRY  SOUTHERN RAILWAY OF BRITISH COLUMBIA LTD 

SS  SAND SPRINGS RAILWAY COMPANY 

SSC  SOUTHERN SWITCHING COMPANY 

SSR  S&S SHORTLINE RAILROAD 

ST  ST RAIL SYSTEM 

STE  STOCKTON TERMINAL AND EASTERN RAILROAD 

STMA  ST MARIES RIVER RAILROAD COMPANY 

STR  SHAWNEE TERMINAL RAILWAY COMPANY INC 

STRT  STEWARTSTOWN RAILROAD CO 

STS  SANTA TERESA SOUTHERN RAILROAD, LLC 

SUN  SUNSET RAILWAY COMPANY 

SVI  SOUTHERN RAILWAY OF VANCOUVER ISLAND LIMITED 

SVRR  SHAMOKIN VALLEY RAILROAD COMPANY 

SW  SOUTHWESTERN RAILROAD COMPANY INC 

SWP  SOUTHWEST PENNSYLVANIA RAILROAD COMPANY 

TASD  TERMINAL RAILWAY ALABAMA STATE DOCKS 

TBRY  THERMAL BELT RAILWAY 

TC  TEMPLE & CENTRAL TEXAS RAILWAY, INC. 

TCB  TEXAS CENTRAL BUSINESS LINES CORPORATION 

TCG  TUCSON CORNELIA & GILA BEND RAILROAD COMPANY 

TCKR  TURTLE CREEK INDUSTRIAL RAILROAD INC 

TCRY  TRI‐CITY RAILROAD COMPANY 

TCT  TEXAS CITY TERMINAL RAILWAY COMPANY 

TCWR  TWIN CITIES & WESTERN RAILROAD 

TFVM  TERMINAL FERROVIARIA DEL VALLE DE MEXICO SA DE CV 

TI  TURNERS ISLAND LLC 

TIBR  TIMBERROCK RAILROAD COMPANY INC 

TIRL  TONAWANDA ISLAND RAILROAD INC 

TKEN  TENNKEN RAILROAD COMPANY INC 

TLE  MIDWEST RAIL, LLC DBA TOLEDO, LAKE ERIE AND WESTERN RAILWAY 

TMBL  TACOMA MUNCIPAL BELT LINE RAILWAY 

TMSS  TOWANDA AND MONROETON SHIPPERS LIFELINE, INC. 

TMUS  TRANSMEX/USA INC 

TN  TEXAS & NORTHERN 

TNER  TEXAS NORTHEASTERN DIVISION MID‐MICHIGAN RAILROAD INC 

TNHR  THREE NOTCH RAILWAY LLC 

TNMR  TEXAS‐NEW MEXICO DIVISION (AUSTIN & NORTHWESTERN RAILROAD COMPANY INC) 

TPW  TOLEDO PEORIA & WESTERN RAILWAY CORPORATION 
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TR  TOMAHAWK RAILWAY L P 

TRC  TRONA RAILWAY COMPANY 

TRIN  TRINIDAD RAILWAY INC 

TRMW  TACOMA RAIL MOUNTAIN DIVISION 

TRR  THUNDER RAIL LTD 

TRRA  TERMINAL RAILROAD ASSOCIATION OF ST LOUIS 

TRRY  TRILLIUM RAILWAY CO LTD 

TRV  TORCH RIVER RAIL INC. 

TSE  TEXAS SOUTH‐EASTERN RAILROAD COMPANY 

TSRR  TENNESSEE SOUTHERN RAILROAD CO INC 

TSU  TULSA‐SAPULPA UNION RAILWAY COMPANY L L C 

TTIS  TRANSKENTUCKY TRANSPORTATION RAILROAD CO INC 

TTR  TALLEYRAND TERMINAL RAILROAD COMPANY INC 

TVRR  TULARE VALLEY RAILROAD COMPANY 

TXGN  TEXAS GONZALES & NORTHERN RAILWAY COMPANY 

TXNW  TEXAS NORTH WESTERN RAILWAY COMPANY 

TXOR  TEXAS AND OKLAHOMA RAILROAD COMPANY 

TXPF  TEXAS PACIFICO TRANSPORTATION LTD 

TXR  TEXAS ROCK CRUSHER RAILWAY COMPANY 

TYBR  TYBURN RAILROAD, LLC 

TZPR  TAZEWELL & PEORIA RAILROAD INC 

UCIR  UNION COUNTY INDUSTRIAL RAILROAD COMPANY 

UCRY  UTAH CENTRAL RAILWAY COMPANY 

UMP  UPPER MERION AND PLYMOUTH RAILROAD COMPANY 

UP  UNION PACIFIC RAILROAD COMPANY 

URR  UNION RAILROAD COMPANY 

USNY  U.S. RAIL OF NEW YORK, LLC 

USR  UTAH SOUTHERN RAILROAD COMPANY LLC 

USRP  U.S. RAIL CORPORATION LLC 

UTAH  UTAH RAILWAY COMPANY 

VCRR  VENTURA COUNTY RAILROAD COMPANY 

VR  VALDOSTA RAILWAY L P 

VRR  VAUGHN RAILROAD COMPANY 

VRRC  VANDALIA RAILROAD COMPANY 

VSOR  VICKSBURG SOUTHERN RAILROAD INC 

VSR  V AND S RAILWAY INC 

VSRR  VIRGINIA SOUTHERN RAILROAD DIVISION NORTH CAROLINA & VIRGINIA RAILROAD 

VST  V&S RAILWAY INC D/B/A TOWNER RAILWAY 

VTR  VERMONT RAILWAY INC 

VVRR  VERMILION VALLEY RAILROAD COMPANY INC 

WACR  WASHINGTON COUNTY RAILROAD CORPORATION 

WBCR  WABASH CENTRAL RAILROAD CORPORATION 

WCLR  WACCAMAW COASTLINE RAILROAD CO INC 
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WCOR  WELLSBORO & CORNING RAILROAD LLC 

WE  WHEELING & LAKE ERIE RAILWAY COMPANY 

WFS  WEST ISLE LINE INC 

WGCR  WIREGRASS CENTRAL RAILWAY LLC 

WHOE  WALKING HORSE & EASTERN RAILROAD CO INC 

WHRC  WINDSOR & HANTSPORT RAILWAY CO 

WIR  WASHINGTON & IDAHO RAILWAY INC 

WKRL  WESTERN KENTUCKY RAILWAY LLC 

WMI  WEST MICHIGAN RAILROAD CO 

WN  PROGRESSIVE RAIL INC D/B/A WISCONSIN NORTHERN RAILROAD 

WNFR  KANAWHA RAIL CORP 

WNYP  WESTERN NEW YORK & PENNSYLVANIA RAILROAD LLC 

WPRR  WILLAMETTE & PACIFIC RAILROAD INC 

WRRC  WESTERN RAILROAD COMPANY 

WRS  WESTERN RAIL SWITCHING INC 

WSOR  WISCONSIN & SOUTHERN RAILROAD COMPANY 

WSR  WARREN & SALINE RIVER RAILROAD COMPANY 

WSRY  WINAMAC SOUTHERN RAILWAY COMPANY 

WSS  WINSTON‐SALEM SOUTHBOUND RAILWAY COMPANY (CSX TRANSPORTATION) 

WTA  WICHITA TERMINAL ASSOCIATION 

WTCO  WESTERN TRANSPORTATION CO 

WTJR  WICHITA TILLMAN & JACKSON RAILWAY COMPANY INC 

WTLC  WEST TEXAS AND LUBBOCK RAILWAY COMPANY 

WTNN  WEST TENNESSEE RAILROAD CORP 

WTRM  WARREN & TRUMBULL RAILROAD COMPANY, THE 

WTRY  WILMINGTON TERMINAL RAILROAD INC 

WURR  WALLOWA UNION RAILROAD AUTHORITY 

WVC  WEST VIRGINIA CENTRAL RAILROAD 

WVR  WILLAMETTE VALLEY RAILWAY COMPANY INC 

WW  WINCHESTER AND WESTERN RAILROAD COMPANY 

WWRC  WILMINGTON & WESTERN RAILWAY CORP 

WYEC  WYE TRANSPORTATION CO 

YARR  YOUNGSTOWN & AUSTINTOWN RAILROAD CO 

YB  YOUNGSTOWN BELT RAILROAD COMPANY, THE 

YCR  YCR CORP 

YRC  YORK RAILWAY COMPANY 

YRPL  YELM ROY PRAIRIE LINE 

YSRR  YOUNGSTOWN & SOUTHEASTERN RAILROAD COMPANY INC 

YSVR  YELLOWSTONE VALLEY RAILROAD INC 

YVRR  YADKIN VALLEY RAILROAD COMPANY 

YVT  YAKIMA VALLEY TRANSPORTATION COMPANY 

YW  YREKA WESTERN RAILROAD COMPANY 
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A & R LINE INC  ARE 

ABERDEEN AND ROCKFISH RAILROAD COMPANY  AR 

ABERDEEN CAROLINA & WESTERN RAILWAY CO  ACWR 

ACADIANA RAILWAY COMPANY  AKDN 

ADAMS WARNOCK RAILWAY, INC.  AWRY 

ADRIAN & BLISSFIELD RAIL ROAD COMPANY  ADBF 

AIKEN RAILWAY COMPANY, LLC  AIKR 

AIRLAKE TERMINAL RAILWAY COMPANY  ALT 

AKRON BARBERTON CLUSTER RAILWAY COMPANY  AB 

ALABAMA & FLORIDA RAILWAY CO  AF 

ALABAMA & GULF COAST RAILWAY LLC  AGR 

ALABAMA & TENNESSEE RIVER RAILWAY LLC  ATN 

ALABAMA RAILROAD CO INC  ALAB 

ALABAMA SOUTHERN RAILROAD  ABS 

ALABAMA WARRIOR RAILWAY, LLC.  ABWR 

ALAMEDA BELT LINE  ABL 

ALAMO GULF COAST RAILROAD COMPANY  AGCR 

ALASKA RAILROAD CORPORATION  ARR 

ALBANY & EASTERN RAILROAD COMPANY  AERC 

ALBANY PORT DISTRICT  APD 

ALBERTA PRAIRIE RAILWAY  APR 

ALEXANDER RAILROAD COMPANY  ARC 

ALGERS WINSLOW AND WESTERN RAILWAY COMPANY  AWW 

ALIQUIPPA & OHIO RIVER RAILROAD COMPANY  AOR 

ALLEGHENY SOUTHERN RAILROAD INC  ASR 

ALLEGHENY VALLEY RAILROAD COMPANY  AVR 

ALTON & SOUTHERN RAILWAY COMPANY  ALS 

AMADOR FOOTHILLS RAILROAD  AFR 

AMTRAK‐NATIONAL RAILROAD PASSENGER CORPORATION  AMTK 

AN RAILWAY LLC  AN 

ANGELINA & NECHES RIVER RAILROAD COMPANY  ANR 

ANN ARBOR RAILROAD  AA 

APACHE RAILWAY COMPANY  APA 

APPALACHIAN & OHIO RAILROAD INC  AO 

APPANOOSE COUNTY COMMUNITY RAILROAD INC  APNC 

ARCADE AND ATTICA RAILROAD CORPORATION  ARA 

ARIZONA & CALIFORNIA RAILROAD CO  ARZC 

E A
p
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ARIZONA CENTRAL RAILROAD INC  AZCR 

ARIZONA EASTERN RAILWAY COMPANY  AZER 

ARKANSAS AND MISSOURI RAILROAD CO  AM 

ARKANSAS LOUISIANA & MISSISSIPPI RAILROAD COMPANY  ALM 

ARKANSAS MIDLAND RAILROAD CO INC  AKMD 

ARKANSAS SOUTHERN RAILROAD  ARS 

ARKANSAS‐OKLAHOMA RAILROAD INC  AOK 

ASHLAND RAILWAY CO  ASRY 

ASHTABULA CARSON & JEFFERSON RAILROAD  ACJR 

AT & L RAILROAD CO INC  ATLT 

ATHENS LINE LLC, THE  ABR 

ATLANTIC & WESTERN RAILWAY, L P  ATW 

AUSTIN WESTERN RAILROAD  AWRR 

AUTAUGA NORTHERN RAILROAD LLC  AUT 

B&H RAIL CORP  BH 

BAJA CALIFORNIA RAILROAD INC  BJRR 

BALLARD TERMINAL RAILROAD CO LLC  BDTL 

BALLARD TERMINAL RAILROAD COMPANY LLC D/B/A MEEKER SOUTHERN 
RAILROAD  MSN 

BALTIMORE AND OHIO CHICAGO TERMINAL RAILROAD CO  BOCT 

BARRIE‐COLLINGWOOD RAILWAY  BCRY 

BATTEN KILL RAILROAD INC  BKRR 

BATTLE RIVER RAILWAY NGC INC  BRR 

BAUXITE & NORTHERN RAILWAY COMPANY  BXN 

BAY COAST RAILROAD  BCR 

BAY COLONY RAILROAD CORPORATION  BCLR 

BAY LINE RAILROAD L L C, THE  BAYL 

BEECH MOUNTAIN RAILROAD COMPANY  BEEM 

BELFAST AND MOOSEHEAD LAKE RAILROAD COMPANY  BML 

BELT RAILWAY COMPANY OF CHICAGO  BRC 

BELVIDERE & DELAWARE RIVER RAILWAY COMPANY INC  BDRV 

BHP NEVADA RAILROAD COMPANY  BHP 

BIG SKY RAIL CORP  BGS 

BIG SPRING RAIL SYSTEM, INC.  BSR 

BIGHORN DIVIDE & WYOMING RAILROAD INC  BDW 

BIRMINGHAM TERMINAL RAILWAY LLC  BHRR 

BI‐STATE DEVELOPMENT AGENCY  BSDA 

BLACK RIVER & WESTERN CORPORATION  BRW 

BLACKLANDS RAILROAD THE  BLR 

BLACKWELL NORTHERN GATEWAY RAILROAD COMPANY  BNG 

BLOOMER LINE, THE  BLOL 

BLUE MOUNTAIN RAILROAD INC  BLMR 

BNSF RAILWAY COMPANY  BNSF 
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BOISE VALLEY RAILROAD, INC.  BVRR 

BOONE & SCENIC VALLEY RAILROAD  BSVY 

BOOT HILL & WESTERN RAILWAY CO LC  BHWY 

BORDER PACIFIC RAILROAD CO  BOP 

BOUNDARY TRAIL RAILWAY COMPANY INC.  BTR 

BRANDON RAILROAD LLC  BRAN 

BRANDYWINE VALLEY RAILROAD COMPANY  BVRY 

BROOKHAVEN RAIL, LLC  BHR 

BROWNSVILLE AND RIO GRANDE INTERNATIONAL RR  BRG 

BUCKINGHAM BRANCH RAILROAD COMPANY  BB 

BUFFALO & PITTSBURGH RAILROAD INC  BPRR 

BUFFALO SOUTHERN RAILROAD INC  BSOR 

BURLINGTON JUNCTION RAILWAY  BJRY 

BURLINGTON NORTHERN (MANITOBA) LTD  BNML 

C & NC RAILROAD CORPORATION  CNUR 

C & S RAILROAD CORPORATION  CSKR 

C F LANAUDIERE INC  CFL 

C&J RAILROAD COMPANY D/B/A MISSISSIPPI DELTA RAILROAD  MD 

CADDO VALLEY RAILROAD COMPANY  CVYR 

CALDWELL COUNTY RAILROAD COMPANY  CWCY 

CALIFORNIA NORTHERN RAILROAD COMPANY LP  CFNR 

CAMBRIA AND INDIANA RAILROAD COMPANY  CI 

CAMDEN & SOUTHERN RAILROAD INC  CSR 

CAMP CHASE INDUSTRIAL RAILROAD CORPORATION  CCRA 

CANADIAN NATIONAL RAILWAYS  CN 

CANADIAN PACIFIC RAILWAY  CPRS 

CANEY FORK AND WESTERN RR  CFWR 

CANTON RAILROAD COMPANY  CTN 

CAPE BRETON & CENTRAL NOVA SCOTIA RAILWAY  CBNS 

CAPE FEAR RAILWAYS INC  CF 

CAPE MAY SEASHORE LINES  CMSL 

CARLTON TRAIL RAILWAY COMPANY  CTRW 

CAROLINA COASTAL RAILWAY INC  CLNA 

CAROLINA PIEDMONT DIVISION SOUTH CAROLINA CENTRAL RAILROAD 
COMPANY INC  CPDR 

CAROLINA SOUTHERN RAILROAD COMPANY, THE  CALA 

CARRIZO GORGE RAILWAY INC  CZRY 

CASCADE AND COLUMBIA RIVER RAILROAD COMPANY  CSCD 

CATERPARROTT RAILNET, LLC  CPR 

CEDAR RAPIDS & IOWA CITY RAILWAY COMPANY  CIC 

CENTRAL CALIFORNIA TRACTION COMPANY  CCT 

CENTRAL ILLINOIS RAILROAD COMPANY  CIRY 

CENTRAL INDIANA & WESTERN RAILROAD CO INC  CEIW 
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CENTRAL MANITOBA RAILWAY INC  CEMR 

CENTRAL MIDLAND RAILWAY COMPANY  CMR 

CENTRAL MONTANA RAIL INC  CM 

CENTRAL NEW ENGLAND RAILROAD CO INC  CNZR 

CENTRAL NEW YORK RAILROAD CORPORATION  CNYK 

CENTRAL OREGON & PACIFIC RAILROAD INC  CORP 

CENTRAL RAILROAD COMPANY OF INDIANAPOLIS  CERA 

CENTRAL RAILROAD OF INDIANA  CIND 

CENTRAL WASHINGTON RAILROAD COMPANY  CWA 

CG RAILWAY INC  CGR 

CHAPARRAL RAILROAD COMPANY INC  CHRC 

CHARLOTTE SOUTHERN RAILROAD COMPANY  CHS 

CHATTAHOOCHEE BAY RAILROAD INC  CHAT 

CHATTAHOOCHEE INDUSTRIAL RAILROAD  CIRR 

CHATTOOGA & CHICKAMAUGA RAILWAY CO  CCKY 

CHESAPEAKE & ALBEMARLE  CA 

CHESAPEAKE AND INDIANA RAILROAD COMPANY INC  CKIN 

CHESAPEAKE RAILROAD COMPANY  CHRR 

CHESSIE LOGISTICS CO., LLC  CLCY 

CHESTNUT RIDGE RAILWAY COMPANY  CHR 

CHICAGO FT WAYNE & EASTERN A DIVISION OF CENTRAL RAILROAD OF 
INDIANAPOLIS INC  CFE 

CHICAGO RAIL LINK  CRL 

CHICAGO SOUTHSHORE & SOUTH BEND RAILROAD  CSS 

CHICAGO TERMINAL RAILROAD  CTM 

CHICAGO‐CHEMUNG RAILROAD CORP  CCUO 

CIMARRON VALLEY RAILROAD L C  CVR 

CITY OF PRINEVILLE RAILWAY  COP 

CITY OF ROCHELLE ILLINOIS  CIR 

CLAREMONT CONCORD RAILROAD CORPORATION  CCRR 

CLARENDON AND PITTSFORD RAILROAD COMPANY, THE  CLP 

CLEVELAND COMMERCIAL RAILROAD COMPANY LLC  CCRL 

CLEVELAND HARBOR BELT RAILROAD, LLC  CHB 

CLEVELAND WORKS RAILWAY COMPANY  CWRO 

CLINTON TERMINAL RAILROAD COMPANY  CTR 

CLOQUET TERMINAL RAILROAD COMPANY INC  CTRR 

CN AQUATRAIN  CNAT 

COLORADO & WYOMING RWY CO  CW 

COLUMBIA & COWLITZ RAILWAY LLC  CLC 

COLUMBIA & NORTHERN RAILWAY CO  CNOW 

COLUMBIA & READING RAILWAY CO  CORY 

COLUMBIA BASIN RAILROAD COMPANY INC  CBRW 

COLUMBIA TERMINAL  CT 
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COLUMBUS & CHATTAHOOCHEE RAILROAD, INC  CCH 

COLUMBUS & OHIO RAILROAD COMPANY  CUOH 

COLUMBUS AND GREENVILLE RAILWAY  CAGY 

COMMONWEALTH RAILWAY INC  CWRY 

COMPANIA DE FERROCARRILES CHIAPAS MAYAB SA DE CV  FCCM 

COMSTOCK MOUNTAIN LION RAILROAD, INC.  CMRR 

CONECUH VALLEY RAILWAY LLC  COEH 

CONNECTICUT SOUTHERN RAILROAD INC  CSO 

COOPERSVILLE AND MARNE RAILWAY COMPANY  CPMY 

COOS BAY RAILROAD OPERATING CO., LLC  CBR 

COPPER BASIN RAILWAY INC  CBRY 

CORPUS CHRISTI TERMINAL RAILROAD INC  CCPN 

CRAB ORCHARD & EGYPTIAN RAILWAY A DIVISION OF PROGRESSIVE RAIL INC  COER 

CSX TRANSPORTATION  CSXT 

CWRR INC  CWR 

D & I RAILROAD COMPANY  DAIR 

DAKOTA MISSOURI VALLEY & WESTERN RAILROAD INC  DMVW 

DAKOTA NORTHERN RAILROAD INC  DN 

DAKOTA SHORT LINE  DAKS 

DAKOTA SOUTHERN RAILWAY COMPANY  DSRC 

DALLAS GARLAND & NORTHEASTERN RAILROAD INC  DGNO 

DALLAS TERMINAL RAILWAY  DALT 

DANSVILLE AND MOUNT MORRIS RAILROAD COMPANY, THE  DMM 

DARDANELLE & RUSSELLVILLE RAILROAD COMPANY  DR 

DECATUR JUNCTION RAILWAY COMPANY  DT 

DELAWARE COAST LINE RR CO  DCLR 

DELAWARE VALLEY RAILWAY COMPANY INC  DV 

DELAWARE‐LACKAWANNA RAILROAD CO INC  DL 

DELRAY CONNECTING RAILROAD COMPANY  DC 

DELTA SOUTHERN RAILROAD COMPANY  DSRR 

DELTA VALLEY & SOUTHERN RAILWAY COMPANY  DVS 

DENVER ROCK ISLAND RAILROAD  DRIR 

DEPEW LANCASTER & WESTERN RAILROAD CO INC  DLWR 

DEQUEEN & EASTERN RAILROAD LLC  DQE 

DETROIT CONNECTING RAILROAD COMPANY  DCON 

DEVCO RY (CAPE BRETON DEVELOPMENT CORP)  DVR 

DRAKE SWITCHING COMPANY, LLC  DSC 

DUBOIS COUNTY RAILROAD  DCRR 

DURBIN & GREENBRIER VALLEY RAILROAD INC  DGVR 

E & N RAILWAY COMPANY (1998) LTD  ENR 

EAST BROOKFIELD & SPENCER RAILROAD LLC  EBSR 

EAST CAMDEN & HIGHLAND RR CO  EACH 

EAST CHATTANOOGA BELT RAILWAY COMPANY  ECTB 
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EAST COOPER AND BERKELEY RAILROAD COMPANY  ECBR 

EAST ERIE COMMERCIAL RAILROAD  EEC 

EAST JERSEY RAILROAD AND TERMINAL COMPANY  EJR 

EAST MAHANOY & HAZELTON RAILROAD COMPANY  EMHR 

EAST PENN RAILROAD LLC  ESPN 

EAST TENNESSEE RAILWAY, L P  ETRY 

EASTERN ALABAMA RAILWAY  EARY 

EASTERN BERKS GATEWAY RAILROAD COMPANY  EBG 

EASTERN IDAHO RAILROAD INC  EIRR 

EASTERN ILLINOIS RAILROAD COMPANY  EIRC 

EASTERN MAINE RAILWAY COMPANY  EMRY 

EASTERN WASHINGTON GATEWAY RAILROAD COMPANY  EWG 

ECORAIL INC  ECO 

EFFINGHAM RAILROAD COMPANY  EFRR 

EL DORADO AND WESSON RAILWAY COMPANY  EDW 

ELK RIVER RAILROAD INC  ELKR 

ELKHART & WESTERN RAILROAD CO  EWR 

ELLIS & EASTERN COMPANY  EE 

ESCANABA AND LAKE SUPERIOR RAILROAD COMPANY  ELS 

ESSEX TERMINAL RAILWAY COMPANY THE  ETL 

EVANSVILLE WESTERN RAILWAY INC  EVWR 

EVERETT RAILROAD  EV 

FALLS ROAD RAILROAD CO INC  FRR 

FARMRAIL CORPORATION  FMRC 

FERROCARRIL MEXICANO S A DE C V  FXE 

FERROSUR S A DE C V  FSRR 

FINGER LAKES RAILWAY CORP  FGLK 

FIRST COAST RAILROAD INC  FCRD 

FLATS INDUSTRIAL RAILROAD COMPANY  FIR 

FLORIDA CENTRAL RAILROAD CO  FCEN 

FLORIDA EAST COAST RAILWAY, LLC  FEC 

FLORIDA MIDLAND RAILROAD CO INC  FMID 

FLORIDA NORTHERN RAILROAD COMPANY INC  FNOR 

FLORIDA WEST COAST RAILROAD INC  FWCR 

FORDYCE AND PRINCETON RAILROAD CO  FP 

FORE RIVER TRANSPORTATION CORPORATION  FRVT 

FORT SMITH RAILROAD CO  FSR 

FORT WORTH & DALLAS BELT RAILROAD  FWDB 

FORT WORTH & WESTERN RAILROAD  FWWR 

FULTON COUNTY RAILROAD INC  FC 

FULTON COUNTY RAILWAY LLC  FCR 

GALVESTON RAILROAD LP  GVSR 

GARDEN CITY WESTERN RAILWAY COMPANY, THE  GCW 
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GARDENDALE RAILROAD, INC  GRD 

GARY RAILWAY COMPANY  GRW 

GATEWAY EASTERN RAILWAY COMPANY  GWWE 

GEORGES CREEK RAILWAY  GCK 

GEORGETOWN RAILROAD COMPANY  GRR 

GEORGIA & FLORIDA RAILNET INC  GFRR 

GEORGIA CENTRAL RAILWAY L P  GC 

GEORGIA MIDLAND RAILROAD INC  GMR 

GEORGIA NORTHEASTERN RAILROAD CO  GNRR 

GEORGIA SOUTHERN RAILWAY CO.  GS 

GEORGIA SOUTHWESTERN RAILROAD INC  GSWR 

GEORGIA WOODLANDS RAILROAD CO  GWRC 

GETTYSBURG & NORTHERN RAILROAD CO  GET 

GLOSTER SOUTHERN RAILROAD COMPANY  GLSR 

GNP RLY INC.  GNPR 

GODERICH‐EXETER RAILWAY COMPANY LTD  GEXR 

GOLDEN ISLES TERMINAL RAILROAD INC  GITM 

GOLDEN TRIANGLE RAILROAD LLC  GTRA 

GRAFTON AND UPTON RAILROAD COMPANY  GU 

GRAINBELT CORPORATION  GNBC 

GRAND ELK RAILROAD, LLC.  GDLK 

GRAND FORKS RAILWAY COMPANY  GFR 

GRAND RAPIDS EASTERN RAILROAD INC  GR 

GREAT LAKES CENTRAL RAILROAD  GLC 

GREAT NORTHWEST RAILROAD INC  GRNW 

GREAT RIVER RAILROAD  GTR 

GREAT SMOKEY MOUNTAINS RAILWAY INC  GSM 

GREAT WALTON RAILROAD CO, THE  GRWR 

GREAT WESTERN RAILWAY LTD  GWRS 

GREAT WESTERN RAILWAY OF COLORADO LLC  GWR 

GREEN MOUNTAIN RAILROAD CORPORATION  GMRC 

GREENVILLE & WESTERN RAILWAY COMPANY LLC  GRLW 

GRENADA RAILWAY LLC  GRYR 

HAINESPORT INDUSTRIAL RAILROAD LLC  HIRR 

HAMPTON & BRANCHVILLE RAILROAD COMPANY  HB 

HAMPTON RAILWAY INC  HLSC 

HARDIN SOUTHERN RAILROAD INC  HSRR 

HARTWELL RAILROAD COMPANY  HRT 

HEART OF GEORGIA RAILROAD INC  HOG 

HEART OF TEXAS RAILROAD, LP  HTR 

HENDERSON OVERTON BRANCH  HOB 

HERITAGE RAILROAD CORP  HR 

HIGH POINT THOMASVILLE & DENTON RAILROAD COMPANY  HPTD 
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HILTON & ALBANY RAILOAD, INC.  HAL 

HOLLIDAYSBURG AND ROARING SPRING RAILROAD COMPANY  HRS 

HOLLIS & EASTERN R R CO  HE 

HONDO RAILWAY LLC  HRR 

HONEY CREEK RAILROAD INC  HCRR 

HOOSIER SOUTHERN RAILROAD  HOS 

HOUSATONIC RAILROAD COMPANY INC  HRRC 

HUDSON BAY RAILWAY COMPANY  HBRY 

HUNTSVILLE & MADISON COUNTY RAILROAD AUTHORITY  HMCR 

HURON AND EASTERN RAILWAY COMPANY INC  HESR 

HURON CENTRAL RAILWAY INC  HCRY 

HUTCHINSON AND NORTHERN RAILWAY COMPANY, THE  HN 

IDAHO NORTHERN & PACIFIC RAILROAD COMPANY  INPR 

ILLINOIS & MIDLAND RAILROAD INC  IMRR 

ILLINOIS RAILNET INC  IR 

ILLINOIS WESTERN RAILROAD COMPANY  ILW 

INDIAN CREEK RAILROAD COMPANY  ICRK 

INDIANA & OHIO RAILWAY COMPANY  IORY 

INDIANA EASTERN RAILROAD LLC  IERR 

INDIANA HARBOR BELT RAILROAD COMPANY  IHB 

INDIANA NORTHEASTERN RAILROAD COMPANY INC  IN 

INDIANA RAIL ROAD CORPORATION  INRD 

INDIANA SOUTHERN RAILROAD COMPANY INC  ISRR 

INDIANA SOUTHWESTERN RAILWAY CO  ISW 

INTERNATIONAL BRIDGE AND TERMINAL COMPANY, THE  IBT 

IOWA INTERSTATE RAILROAD LTD  IAIS 

IOWA NORTHERN RAILROAD  IANR 

IOWA NORTHWESTERN RAILROAD  IANW 

IOWA RIVER RAILROAD INC  IARR 

IOWA SOUTHERN RAILROAD COMPANY  ISR 

IOWA TRACTION RAILWAY COMPANY  IATR 

J K LINE INC  JKL 

JACKSON & LANSING RAILROAD COMPANY  JAIL 

JUNIATA VALLEY RAILROAD COMPANY  JVRR 

KANAWHA RAIL CORP  WNFR 

KANKAKEE BEAVERVILLE AND SOUTHERN RAILROAD COMPANY  KBSR 

KANSAS & OKLAHOMA RAILROAD INC  KO 

KANSAS CITY SOUTHERN DE MEXICO S DE R L DE C V  KCSM 

KANSAS CITY SOUTHERN RAILWAY COMPANY  KCS 

KANSAS CITY TRANSPORTATION CO LLC  KCTL 

KANSAS EASTERN RAILROAD INC  KE 

KASGRO RAIL LINES  KRL 

KAW RIVER RAILROAD  KAW 
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KELOWNA PACIFIC RAILWAY LTD  KPR 

KENDALLVILLE TERMINAL RAILWAY CO  KTR 

KENTUCKY AND TENNESSEE RAILWAY  KT 

KEOKUK JUNCTION RAILWAY  KJRY 

KETTLE FALLS INTERNATIONAL RAILWAY LLC  KFR 

KIAMICHI RAILROAD COMPANY LLC  KRR 

KINGMAN TERMINAL RAILROAD, LLC  KGTR 

KISKI JUNCTION RAILROAD  KJR 

KLAMATH NORTHERN RAILWAY COMPANY  KNOR 

KNOX & KANE RAILROAD COMPANY  KKRR 

KNOXVILLE & HOLSTON RIVER RAILROAD CO INC  KXHR 

KOSCIUSKO SOUTHWESTERN RAILWAY  KSRY 

KWT RAILWAY INC  KWT 

KYLE RAILROAD COMPANY  KYLE 

LAKE COUNTY RAILROAD  LCR 

LAKE LINE RAILROAD INC.  LLR 

LAKE MICHIGAN AND INDIANA RAILROAD COMPANY  LMIC 

LAKE STATE RAILWAY COMPANY  LSRC 

LAKE SUPERIOR & ISHPEMING RAILROAD COMPANY  LSI 

LAKE TERMINAL RAILROAD COMPANY, THE  LT 

LAMOILLE VALLEY RAILROAD COMPANY  LVRC 

LANCASTER & CHESTER RAILROAD, LLC.  LC 

LANDISVILLE RAILROAD, LLC  LVR 

LANDISVILLE TERMINAL & TRANSFER COMPANY  LNVT 

LAPEER INDUSTRIAL RAILROAD COMPANY  LIRR 

LAST MOUNTAIN RAILWAY  LMR 

LAURINBURG AND SOUTHERN RAILROAD COMPANY  LRS 

LEHIGH RAILWAY, LLC.  LRWY 

LEHIGH VALLEY RAIL MANAGEMENT LLC ‐ BETHLEHEM DIVISION  LVRB 

LEHIGH VALLEY RAIL MANAGEMENT LLC ‐ JOHNSTOWN DIVISION  LVRJ 

LEWIS & CLARK RAILWAY CO  LINC 

LINEA COAHUILA DURANGO SA DE CV  LFCD 

LITTLE KANAWHA RIVER RAIL INC  LKRR 

LITTLE ROCK & WESTERN RAILWAY, L P  LRWN 

LITTLE ROCK PORT RAILROAD  LRPA 

LIVONIA, AVON & LAKEVILLE RAILROAD CORPORATION  LAL 

LOGANSPORT & EEL RIVER SHORT‐LINE CO INC  LER 

LONG CREEK RAILROAD COMPANY INC  LCRI 

LONG ISLAND RAILROAD COMPANY  LI 

LONGVIEW SWITCHING COMPANY  LVSW 

LOS ANGELES JUNCTION RAILWAY COMPANY  LAJ 

LOUISIANA & DELTA RAILROAD INC  LDRR 

LOUISIANA AND NORTH WEST RAILROAD COMPANY, THE  LNW 
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LOUISIANA SOUTHERN RAILROAD  LAS 

LOUISVILLE & INDIANA RAILROAD COMPANY  LIRC 

LOUISVILLE AND WADLEY RAILWAY COMPANY  LW 

LOUISVILLE NEW ALBANY & CORYDON RAILROAD  LNAL 

LOWVILLE AND BEAVER RIVER RAILROAD COMPANY THE  LBR 

LRY LLC.  LRY 

LUXAPALILA VALLEY RAILROAD INC  LXVR 

LUZERNE AND SUSQUEHANNA RAILWAY COMPANY  LS 

LYCOMING VALLEY RAILROAD COMPANY  LVRR 

M&B RAILROAD LLC  MNBR 

MADISON RAILROAD (A DIV OF CITY OF MADISON PORT AUTHORITY)  CMPA 

MAGMA ARIZONA RAILROAD COMPANY  MAA 

MAHONING VALLEY RAILWAY COMPANY, THE  MVRY 

MAINE NORTHERN RAILWAY COMPANY  MNR 

MANATEE COUNTY PORT AUTHORITY  MAUP 

MANNING RAIL, INC  MAN 

MANUFACTURERS JUNCTION RAILWAY COMPANY  MJ 

MARQUETTE RAIL LLC  MQT 

MARYLAND AND DELAWARE RAILROAD COMPANY  MDDE 

MARYLAND MIDLAND RAILWAY INC  MMID 

MASSACHUSETTS CENTRAL RAILROAD CORPORATION  MCER 

MASSACHUSETTS COASTAL RAILROAD LLC  MC 

MASSENA TERMINAL RAILROAD COMPANY, THE  MSTR 

MAUMEE & WESTERN RAILROAD CORPORATION  MAW 

MCCLOUD RAILWAY COMPANY  MCR 

MCLAUGHLIN LINE RAILROAD  MCLR 

MCM RAIL SERVICES, LLC D/B/A BALTIMORE INDUSTRIAL RAILROAD  BDR 

MERIDIAN SOUTHERN RAILWAY LLC  MDS 

MG RAIL INC  MGRI 

MICHIGAN AIR‐LINE RAILWAY CO  MAL 

MICHIGAN SHORE RAILROAD INC  MS 

MICHIGAN SOUTHERN RAILROAD CO INC  MSO 

MIDDLETOWN & HUMMELSTOWN RAILROAD COMPANY  MIDH 

MIDDLETOWN & NEW JERSEY RAILWAY LLC  MNJ 

MID‐MICHIGAN RAILROAD INC  MMRR 

MIDWEST RAIL, LLC DBA TOLEDO, LAKE ERIE AND WESTERN RAILWAY  TLE 

MINNESOTA COMMERCIAL RAILWAY CO  MNNR 

MINNESOTA DAKOTA & WESTERN RAILWAY COMPANY  MDW 

MINNESOTA NORTHERN RAILROAD INC  MNN 

MINNESOTA PRAIRIE LINE INC  MPLI 

MINNESOTA SOUTHERN RAILWAY INC  MSWY 

MISSION MOUNTAIN RAILROAD  MMT 

MISSISSIPPI & SKUNA VALLEY RAILROAD LLC  MSV 
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MISSISSIPPI CENTRAL RAILROAD COMPANY  MSCI 

MISSISSIPPI EXPORT RAILROAD COMPANY  MSE 

MISSISSIPPI SOUTHERN RAILROAD  MSR 

MISSISSIPPI TENNESSEE RAILROAD LLC  MTNR 

MISSISSIPPIAN RAILWAY COOPERATIVE INC  MSRW 

MISSOURI & NORTHERN ARKANSAS RAILROAD COMPANY INC  MNA 

MISSOURI & VALLEY PARK RAILROAD CORP  MVP 

MODESTO AND EMPIRE TRACTION COMPANY  MET 

MOHALL CENTRAL RAILROAD INC  MHC 

MOHALL RAILROAD INC  MRI 

MOHAWK ADIRONDACK & NORTHERN RAILROAD CORP  MHWA 

MONTANA RAIL LINK INC  MRL 

MONTREAL MAINE AND ATLANTIC RAILWAY LTD  MMA 

MORRISTOWN & ERIE RAILWAY INC  ME 

MORRISTOWN & ERIE RAILWAY INC D/B/A MAINE EASTERN RAILROAD  MERR 

MOSCOW, CAMDEN & SAN AUGUSTINE RAILROAD  MCSA 

MOTIVE RAIL INC D/B/A MISSOURI NORTH CENTRAL RAILROAD  MNC 

MT HOOD RAILROAD CO  MH 

MT VERNON TERMINAL RAILWAY INC  MVT 

MUNICIPALITY OF EAST TROY WISCONSIN  METW 

N D C RAILROAD COMPANY  NDCR 

NAPA VALLEY RAILROAD CO  NVRR 

NASH COUNTY RAILROAD CORP  NCYR 

NASHVILLE & WESTERN RAILROAD CORP  NWR 

NASHVILLE AND EASTERN RAILROAD CORP  NERR 

NATCHEZ RAILWAY LLC.  NTZR 

NAUGATUCK RAILROAD COMPANY INC  NAUG 

NC RAILROAD INC  NCRL 

NEBKOTA RAILWAY INC  NRI 

NEBRASKA CENTRAL RAILROAD COMPANY  NCRC 

NEBRASKA KANSAS & COLORADO RAILNET INC  NKCR 

NEBRASKA NORTHEASTERN RAILWAY COMPANY  NENE 

NEBRASKA NORTHWESTERN RAILROAD INC.  NNW 

NELSON AND FT. SHEPPARD RAILWAY CORPORATION  NFTS 

NEW BRUNSWICK SOUTHERN RAILWAY COMPANY LIMITED  NBSR 

NEW CASTLE INDUSTRIAL RAILROAD  NCIR 

NEW ENGLAND CENTRAL RAILROAD INC  NECR 

NEW ENGLAND SOUTHERN RAILROAD CO INC  NEGS 

NEW HAMPSHIRE AND VERMONT RAILROAD COMPANY  NHVT 

NEW HAMPSHIRE CENTRAL RAILROAD INC  NHCR 

NEW HAMPSHIRE NORTHCOAST CORP  NHN 

NEW HOPE & IVYLAND RAILROAD  NHRR 

NEW JERSEY RAIL CARRIER LLC  NJRC 
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NEW MEXICO GATEWAY RAILROAD LLC  NMGR 

NEW ORLEANS & GULF COAST RAILWAY COMPANY INC  NOGC 

NEW ORLEANS PUBLIC BELT RAILROAD  NOPB 

NEW YORK & ATLANTIC RAILWAY COMPANY  NYA 

NEW YORK & GREENWOOD LAKE RAILWAY  NYGL 

NEW YORK & LAKE ERIE RAILROAD  NYLE 

NEW YORK & OGDENSBURG RAILWAY COMPANY INC  NYOG 

NEW YORK NEW JERSEY RAIL LLC  NYNJ 

NEW YORK SUSQUEHANNA AND WESTERN RAILWAY CORP  NYSW 

NEWBURGH & SOUTH SHORE RAILROAD COMPANY  NSR 

NIMISHILLEN & TUSCARAWAS LLC  NTRY 

NITTANY & BALD EAGLE RAILROAD CO  NBER 

NORFOLK & PORTSMOUTH BELT LINE RAILROAD COMPANY  NPB 

NORFOLK SOUTHERN RAILWAY COMPANY (NORFOLK SOUTHERN)  NS 

NORTH CAROLINA & VIRGINIA RAILROAD CO INC  NCVA 

NORTH CAROLINA PORTS RAILWAY COMMISSION  NCPR 

NORTH LOUISIANA & ARKANSAS RAILROAD  NLA 

NORTH SHORE RAILROAD CO  NSHR 

NORTHERN LINES RAILWAY LLC  NLR 

NORTHERN OHIO & WESTERN RAILWAY LTD  NOW 

NORTHERN PLAINS RAILROAD INC  NPR 

NORTHWESTERN OKLAHOMA RAILROAD COMPANY  NOKL 

NORTHWESTERN PACIFIC RAILROAD COMPANY  NWP 

OGEECHEE RAILROAD COMPANY  ORC 

OHIO & PENNSYLVANIA RAILROAD COMPANY  OHPA 

OHIO CENTRAL RAILROAD CO  OHCR 

OHIO SOUTHERN RAILROAD CO  OSRR 

OHIO TERMINAL RAILWAY COMPANY  OHIO 

OHIO VALLEY RAILROAD COMPANY  OVR 

OHI‐RAIL CORPORATION  OHIC 

OIL CREEK & TITUSVILLE LINES  OCTL 

OKANAGAN VALLEY RAILWAY COMPANY  OKAN 

OLD AUGUSTA RAILROAD LLC  OAR 

OLYMPIC RAILROAD CO, THE  OLYR 

OMAHA LINCOLN AND BEATRICE RAILWAY COMPANY  OLB 

ONTARIO CENTRAL RAILROAD CORPORATION  ONCT 

ONTARIO L'ORIGNAL RAILWAY INC  OLO 

ONTARIO MIDLAND RAILROAD CORPORATION  OMID 

ONTARIO NORTHLAND RAILWAY (ONTARIO NORTHLAND TRANS 
COMMISSION)  ONT 

ORANGE PORT TERMINAL RAILWAY  OPT 

OREGON EASTERN RAILROAD  OERR 

OREGON PACIFIC & EASTERN RAILWAY COMPANY  OPE 
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OREGON PACIFIC RAILROAD CO  OPR 

OTTERTAIL VALLEY RAILROAD CO INC  OTVR 

OTTUMWA TERMINAL RAILROAD CO  OTT 

OUACHITA RAILROAD  OUCH 

OWEGO & HARFORD RAILWAY INC  OHRY 

OWENSVILLE TERMINAL CO INC  OTCO 

OZARK VALLEY RAILROAD INC  OVRR 

PACIFIC HARBOR LINE INC  PHL 

PADUCAH & ILLINOIS RAILROAD COMPANY  PI 

PADUCAH & LOUISVILLE RAILWAY  PAL 

PALOUSE RIVER & COULEE CITY RAILROAD INC  PCC 

PAN AM SOUTHERN, LLC.  PAS 

PANHANDLE NORTHERN RAILROAD COMPANY  PNR 

PATAPSCO & BACK RIVERS RAILROAD COMPANY  PBR 

PEARL RIVER VALLEY RAILROAD COMPANY  PRV 

PEE DEE RIVER RAILROAD CORP  PDRR 

PECOS VALLEY PERMIAN RAILROAD LLC DBA PECOS VALLEY SOUTHERN RAILW  PVS 

PEND OREILLE VALLEY RAILROAD (PORT OF PEND OREILLE)  POVA 

PENINSULA TERMINAL COMPANY  PT 

PENNSYLVANIA & SOUTHERN RAILWAY LLC  PSCC 

PENNSYLVANIA NORTHEASTERN RAILROAD, LLC  PN 

PENNSYLVANIA SOUTHWESTERN RAILROAD INC  PSWR 

PICKENS RAILWAY COMPANY  PICK 

PICKENS RAILWAY COMPANY  PKHP 

PIEDMONT & NORTHERN RAILWAY  PNRW 

PIONEER INDUSTRIAL RAILWAY CO  PRY 

PIONEER VALLEY RAILROAD COMPANY  PVRR 

PITTSBURGH & OHIO CENTRAL RAILROAD COMPANY  POHC 

PITTSBURGH ALLEGHENY & MCKEES ROCKS RR CO  PAM 

PLAINVIEW TERMINAL COMPANY  PTC 

POINT COMFORT & NORTHERN RAILWAY COMPANY  PCN 

PORT BIENVILLE RAILROAD  PBVR 

PORT HARBOR RAILROAD INC  PHRR 

PORT JERSEY RAILROAD CO  PJR 

PORT OF TILLAMOOK BAY RAILROAD  POTB 

PORT TERMINAL RAILROAD ASSOCIATION  PTRA 

PORT TERMINAL RAILROAD OF SOUTH CAROLINA  PTR 

PORT UTILITIES COMMISSION OF CHARLESTON SC  PUCC 

PORTLAND & WESTERN RAILROAD INC  PNWR 

PORTLAND TERMINAL RAILROAD COMPANY  PTRC 

PORTLAND VANCOUVER JUNCTION RAILROAD LLC  PVJR 

PRESCOTT AND NORTHWESTERN RAILROAD COMPANY  PNW 

PROGRESSIVE RAIL INC  PGR 



  

 

 PC*MILER|Rail User’s Guide 126 

RAILROAD NAME  SCAC 

PROGRESSIVE RAIL INC D/B/A CANNON VALLEY RAILROAD COMPANY  CVRC 

PROGRESSIVE RAIL INC D/B/A WISCONSIN NORTHERN RAILROAD  WN 

PROVIDENCE AND WORCESTER RAILROAD COMPANY  PW 

PUGET SOUND & PACIFIC RAILROAD COMPANY A DIVISION OF THE ARIZONA 
& CALIFORNIA RAILROAD CO LP  PSAP 

PYCO INDUSTRIES INC  PSC 

QUEBEC CENTRAL RAILWAY COMPANY  QCR 

QUEBEC GATINEAU RAILWAY INC  QGRY 

QUINCY RAILROAD COMPANY  QRR 

R J CORMAN RAILROAD COMPANY/ALLENTOWN LINES INC  RJCN 

R J CORMAN RAILROAD COMPANY/CENTRAL KENTUCKY LINES  RJCC 

R J CORMAN RAILROAD COMPANY/CLEVELAND LINE  RJCL 

R J CORMAN RAILROAD COMPANY/MEMPHIS LINE  RJCM 

R J CORMAN RAILROAD COMPANY/PENNSYLVANIA LINES INC  RJCP 

R J CORMAN RAILROAD COMPANY/TENNESSEE TERMINAL LLC  RJCK 

R J CORMAN RAILROAD COMPANY/WESTERN OHIO LINE  RJCW 

R J CORMAN RAILROAD COMPANY/WV LINE  RJCV 

R J CORMAN RAILROAD CORPORATION/BARDSTOWN LINE  RJCR 

RAILINK OTTAWA VALLEY  RLK 

RAILINK SOUTHERN ONTARIO  RLHH 

RAILROAD SWITCHING SERVICE OF MISSOURI INC  RSM 

RARITAN CENTRAL RAILWAY LLC  RCRY 

RARUS RAILWAY COMPANY  RARW 

READING BLUE MOUNTAIN & NORTHERN RAILROAD COMPANY  RBMN 

RED COAT ROAD & RAIL LTD  RCRR 

RED RIVER VALLEY & WESTERN RAILROAD CO  RRVW 

RED SPRINGS & NORTHERN RAILROAD CO  RSNR 

REDMONT RAILWAY COMPANY INC  RRC 

RICEBORO SOUTHERN RAILWAY LLC  RSOR 

RICHMOND PACIFIC RAILROAD CORPORATION  RPRC 

RIO VALLEY SWITCHING COMPANY  RVSC 

RIPLEY & NEW ALBANY RAILROAD COMPANY  RNA 

RIVERPORT RAILROAD LLC  RVPR 

ROBERVAL AND SAGUENAY RAILWAY COMPANY, THE  RS 

ROCHESTER & SOUTHERN RAILROAD INC  RSR 

ROCK & RAIL INC  RRRR 

ROCKDALE SANDOW & SOUTHERN RAILROAD COMPANY  RSS 

ROCKY MOUNTAIN RAILCAR AND RAILROAD INC  RMRR 

ROGUE VALLEY TERMINAL RAILROAD CORPORATION  RVT 

ROSCOE SNYDER & PACIFIC RAILWAY COMPANY  RSP 

RUSK, PALESTINE, & PACIFIC RAILROAD, LLC  RPP 

RUTLAND LINE INC  RL 

S & L RAILROAD LLC  SLGG 
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S&S SHORTLINE RAILROAD  SSR 

SABINE RIVER & NORTHERN RAILROAD COMPANY  SRN 

SACRAMENTO VALLEY RAILROAD  SAV 

SAINT MARYS RAILROAD COMPANY  SM 

SALT LAKE CITY SOUTHERN RAILROAD COMPANY INC  SL 

SALT LAKE GARFIELD AND WESTERN RAILWAY COMPANY  SLGW 

SAN ANTONIO CENTRAL RAILROAD, LLC  SAC 

SAN DIEGO & IMPERIAL VALLEY RAILROAD CO INC  SDIY 

SAN JOAQUIN VALLEY RAILROAD CO  SJVR 

SAN LUIS & RIO GRANDE RAILROAD INC  SLRG 

SAN LUIS CENTRAL RAILROAD COMPANY  SLC 

SAN MANUEL ARIZONA RAILROAD COMPANY  SMA 

SAN PEDRO RAILROAD OPERATING CO LLC D/B/A SAN PEDRO & 
SOUTHWESTERN RAILROAD COMPANY  SPSR 

SAND SPRINGS RAILWAY COMPANY  SS 

SANDERSVILLE RAILROAD COMPANY  SAN 

SANTA CRUZ AND MONTEREY BAY RAILWAY COMPANY  SC 

SANTA CRUZ BIG TREES & PACIFIC RAILWAY CO  SCBG 

SANTA FE SOUTHERN RAILWAY  SFS 

SANTA MARIA VALLEY RAILROAD COMPANY  SMV 

SANTA TERESA SOUTHERN RAILROAD, LLC  STS 

SARATOGA & NORTH CREEK RAILWAY  SNC 

SAVAGE BINGHAM & GARFIELD RAILROAD COMPANY  SBG 

SAVANNAH PORT TERMINAL RAILROAD INC  SAPT 

SCTRR LLC  SCTR 

SEMINOLE GULF RAILWAY L P  SGLR 

SEMO PORT RAILROAD INC  SE 

SEQUATCHIE VALLEY RAILROAD INC  SQVR 

SHAMOKIN VALLEY RAILROAD COMPANY  SVRR 

SHAWNEE TERMINAL RAILWAY COMPANY INC  STR 

SIERRA RAILROAD COMPANY  SERA 

SISSETON MILBANK RAILROAD  SMRR 

SMS RAIL LINES OF NEW YORK LLC  SNY 

SMS RAIL SERVICE INC  SLRS 

SOCIETE DU CHEMIN DE FER DE LA GASPESIE  SFG 

SOMERSET RAILROAD CORPORATION  SOM 

SOUTH BRANCH VALLEY RAIL ROAD  SBVR 

SOUTH CAROLINA CENTRAL RAILROAD CO INC  SCRF 

SOUTH CENTRAL FLORIDA EXPRESS INC  SCXF 

SOUTH CHICAGO & INDIANA HARBOR RAILWAY COMPANY  SCIH 

SOUTH KANSAS & OKLAHOMA RAILROAD INC  SKOL 

SOUTH PLAINS LAMESA RAILROAD LTD  SLAL 

SOUTH PLAINS SWITCHING LTD CO  SAW 
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SOUTHERN FREIGHT RAILROAD  SFR 

SOUTHERN INDIANA RAILWAY INC  SIND 

SOUTHERN MANITOBA RAILWAY INC  SMNR 

SOUTHERN RAILROAD COMPANY OF NEW JERSEY  SRNJ 

SOUTHERN RAILS COOPERATIVE LIMITED  SORA 

SOUTHERN RAILWAY OF BRITISH COLUMBIA LTD  SRY 

SOUTHERN RAILWAY OF VANCOUVER ISLAND LIMITED  SVI 

SOUTHERN SWITCHING COMPANY  SSC 

SOUTHWEST PENNSYLVANIA RAILROAD COMPANY  SWP 

SOUTHWESTERN RAILROAD COMPANY INC  SW 

SQUAW CREEK SOUTHERN RAILROAD  SCS 

ST CROIX VALLEY RAILROAD COMPANY  SCXY 

ST LAWRENCE & ATLANTIC RAILROAD (QUEBEC) INC  SLQ 

ST LAWRENCE & ATLANTIC RAILROAD CO  SLR 

ST MARIES RIVER RAILROAD COMPANY  STMA 

ST MARYS RAILWAY WEST LLC  SMW 

ST RAIL SYSTEM  ST 

STEELTON & HIGHSPIRE RAILROAD COMPANY  SH 

STERLING BELT LINE RAILWAY  SBLN 

STEWARTSTOWN RAILROAD CO  STRT 

STILLWATER CENTRAL RAILROAD COMPANY INC  SLWC 

STOCKTON TERMINAL AND EASTERN RAILROAD  STE 

STOURBRIDGE RAILROAD COMPANY  SBRR 

STRASBURG RAILROAD COMPANY  SRC 

SUNFLOUR RAILROAD INC  SNR 

SUNSET RAILWAY COMPANY  SUN 

SWAN RANCH RAILROAD LLC  SRRR 

TACOMA MUNCIPAL BELT LINE RAILWAY  TMBL 

TACOMA RAIL MOUNTAIN DIVISION  TRMW 

TALLEYRAND TERMINAL RAILROAD COMPANY INC  TTR 

TAZEWELL & PEORIA RAILROAD INC  TZPR 

TEMPLE & CENTRAL TEXAS RAILWAY, INC.  TC 

TENNESSEE SOUTHERN RAILROAD CO INC  TSRR 

TENNKEN RAILROAD COMPANY INC  TKEN 

TERMINAL FERROVIARIA DEL VALLE DE MEXICO SA DE CV  TFVM 

TERMINAL RAILROAD ASSOCIATION OF ST LOUIS  TRRA 

TERMINAL RAILWAY ALABAMA STATE DOCKS  TASD 

TEXAS & NORTHERN  TN 

TEXAS AND OKLAHOMA RAILROAD COMPANY  TXOR 

TEXAS CENTRAL BUSINESS LINES CORPORATION  TCB 

TEXAS CITY TERMINAL RAILWAY COMPANY  TCT 

TEXAS GONZALES & NORTHERN RAILWAY COMPANY  TXGN 

TEXAS NORTH WESTERN RAILWAY COMPANY  TXNW 
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TEXAS NORTHEASTERN DIVISION MID‐MICHIGAN RAILROAD INC  TNER 

TEXAS PACIFICO TRANSPORTATION LTD  TXPF 

TEXAS ROCK CRUSHER RAILWAY COMPANY  TXR 

TEXAS SOUTH‐EASTERN RAILROAD COMPANY  TSE 

TEXAS‐NEW MEXICO DIVISION (AUSTIN & NORTHWESTERN RAILROAD 
COMPANY INC)  TNMR 

THERMAL BELT RAILWAY  TBRY 

THREE NOTCH RAILWAY LLC  TNHR 

THUNDER RAIL LTD  TRR 

TIMBERROCK RAILROAD COMPANY INC  TIBR 

TOLEDO PEORIA & WESTERN RAILWAY CORPORATION  TPW 

TOMAHAWK RAILWAY L P  TR 

TONAWANDA ISLAND RAILROAD INC  TIRL 

TORCH RIVER RAIL INC.  TRV 

TOWANDA AND MONROETON SHIPPERS LIFELINE, INC.  TMSS 

TRANSKENTUCKY TRANSPORTATION RAILROAD CO INC  TTIS 

TRANSMEX/USA INC  TMUS 

TRI‐CITY RAILROAD COMPANY  TCRY 

TRILLIUM RAILWAY CO LTD  TRRY 

TRINIDAD RAILWAY INC  TRIN 

TRONA RAILWAY COMPANY  TRC 

TUCSON CORNELIA & GILA BEND RAILROAD COMPANY  TCG 

TULARE VALLEY RAILROAD COMPANY  TVRR 

TULSA‐SAPULPA UNION RAILWAY COMPANY L L C  TSU 

TURNERS ISLAND LLC  TI 

TURTLE CREEK INDUSTRIAL RAILROAD INC  TCKR 

TWIN CITIES & WESTERN RAILROAD  TCWR 

TYBURN RAILROAD, LLC  TYBR 

U.S. RAIL CORPORATION LLC  USRP 

U.S. RAIL OF NEW YORK, LLC  USNY 

UNION COUNTY INDUSTRIAL RAILROAD COMPANY  UCIR 

UNION PACIFIC RAILROAD COMPANY  UP 

UNION RAILROAD COMPANY  URR 

UPPER MERION AND PLYMOUTH RAILROAD COMPANY  UMP 

UTAH CENTRAL RAILWAY COMPANY  UCRY 

UTAH RAILWAY COMPANY  UTAH 

UTAH SOUTHERN RAILROAD COMPANY LLC  USR 

V AND S RAILWAY INC  VSR 

V&S RAILWAY INC D/B/A TOWNER RAILWAY  VST 

VALDOSTA RAILWAY L P  VR 

VANDALIA RAILROAD COMPANY  VRRC 

VAUGHN RAILROAD COMPANY  VRR 

VENTURA COUNTY RAILROAD COMPANY  VCRR 



  

 

 PC*MILER|Rail User’s Guide 130 

RAILROAD NAME  SCAC 

VERMILION VALLEY RAILROAD COMPANY INC  VVRR 

VERMONT RAILWAY INC  VTR 

VICKSBURG SOUTHERN RAILROAD INC  VSOR 

VIRGINIA SOUTHERN RAILROAD DIVISION NORTH CAROLINA & VIRGINIA 
RAILROAD  VSRR 

WABASH CENTRAL RAILROAD CORPORATION  WBCR 

WACCAMAW COASTLINE RAILROAD CO INC  WCLR 

WALKING HORSE & EASTERN RAILROAD CO INC  WHOE 

WALLOWA UNION RAILROAD AUTHORITY  WURR 

WARREN & SALINE RIVER RAILROAD COMPANY  WSR 

WARREN & TRUMBULL RAILROAD COMPANY, THE  WTRM 

WASHINGTON & IDAHO RAILWAY INC  WIR 

WASHINGTON COUNTY RAILROAD CORPORATION  WACR 

WELLSBORO & CORNING RAILROAD LLC  WCOR 

WEST ISLE LINE INC  WFS 

WEST MICHIGAN RAILROAD CO  WMI 

WEST TENNESSEE RAILROAD CORP  WTNN 

WEST TEXAS AND LUBBOCK RAILWAY COMPANY  WTLC 

WEST VIRGINIA CENTRAL RAILROAD  WVC 

WESTERN KENTUCKY RAILWAY LLC  WKRL 

WESTERN NEW YORK & PENNSYLVANIA RAILROAD LLC  WNYP 

WESTERN RAIL SWITCHING INC  WRS 

WESTERN RAILROAD COMPANY  WRRC 

WESTERN TRANSPORTATION CO  WTCO 

WHEELING & LAKE ERIE RAILWAY COMPANY  WE 

WICHITA TERMINAL ASSOCIATION  WTA 

WICHITA TILLMAN & JACKSON RAILWAY COMPANY INC  WTJR 

WILLAMETTE & PACIFIC RAILROAD INC  WPRR 

WILLAMETTE VALLEY RAILWAY COMPANY INC  WVR 

WILMINGTON & WESTERN RAILWAY CORP  WWRC 

WILMINGTON TERMINAL RAILROAD INC  WTRY 

WINAMAC SOUTHERN RAILWAY COMPANY  WSRY 

WINCHESTER AND WESTERN RAILROAD COMPANY  WW 

WINDSOR & HANTSPORT RAILWAY CO  WHRC 

WINSTON‐SALEM SOUTHBOUND RAILWAY COMPANY (CSX 
TRANSPORTATION)  WSS 

WIREGRASS CENTRAL RAILWAY LLC  WGCR 

WISCONSIN & SOUTHERN RAILROAD COMPANY  WSOR 

WYE TRANSPORTATION CO  WYEC 

YADKIN VALLEY RAILROAD COMPANY  YVRR 

YAKIMA VALLEY TRANSPORTATION COMPANY  YVT 

YCR CORP  YCR 

YELLOWSTONE VALLEY RAILROAD INC  YSVR 
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RAILROAD NAME  SCAC 

YELM ROY PRAIRIE LINE  YRPL 

YORK RAILWAY COMPANY  YRC 

YOUNGSTOWN & AUSTINTOWN RAILROAD CO  YARR 

YOUNGSTOWN & SOUTHEASTERN RAILROAD COMPANY INC  YSRR 

YOUNGSTOWN BELT RAILROAD COMPANY, THE  YB 

YREKA WESTERN RAILROAD COMPANY  YW 
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    Error Messages You May Encounter 
 

 
 
NETWORK DATA Messages SOLUTIONS 

Rail network data load failed. 
Unable to load network data files. 
Reinstall PC*MILER|Rail. 

  
INSTALLATION Messages SOLUTIONS 
Product installation error. Please reinstall 
PC*MILER|Rail. 

The file filermastr1.cfg is not found in 
Systems directory. Reinstall. 

Invalid registration file.  Please reinstall 
PC*MILER|Rail. 

Invalid registration file. Reinstall. 

You must upgrade to a full product before adding 
new features. 

Current product key does not support new 
features. Upgrade and reinstall 
PC*MILER|Rail. 

InstallShield has determined that you are not 
logged in on a User Account with Administrator 
privileges.  It is strongly recommended that you 
cancel this install and log in as a User with 
Administrator Privileges. 

This message will be generated if you are 
running Windows 7.  See the note in section 
2.5 under Step 1 on how to “Run as 
administrator”. 

  
LICENSE Messages SOLUTIONS 
You have [X] user licenses. There are already [X] 
people using the product. 

Maximum number of users exceeded. Any 
additional users will get this message. 

This Trial Version of PC*MILER|Rail has expired. 
The program will now exit. Please call an ALK 
Technologies Sales Executive at 1-800-377-6453 to 
purchase a full version.              

User's product license is expired. 

License expired. 
License no longer valid. 
Contact Technical Support 

Licensing error detected. Error Code: Error in licensing file. Reinstall. 
Failed to load License DLL. License DLL is not loaded. Reinstall. 
Internal error. Error in licensing file. Reinstall. 
Fatal Error: Error in licensing file. Reinstall. 

  
ROUTE WINDOW Messages SOLUTIONS 

No valid routes generated. 

AutoRouter is unable to find feasible routes 
between origin and destination with the 
current settings.  Try changing Terminal 
Switch RR’s option to Include in the 
Options dialog box. 

You need to type at least one character of the 
station name followed by a two-character state 

Occurs in two situations:  
1) User gives less than 3 alpha characters 

F A
p

p
en

d
ix
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abbreviation. in Station ST field.  2) User gives one 
character followed by a '*' and no state in 
Station ST field.  

You need to type at least the first three digits of the 
SPLC code followed by a * to invoke the SPLC 
spelling helper. 

User gives less than 3 digits followed by a 
'*' in Geocode field to invoke SPLC helper. 

Bad SPLC code: xxxxxx 
Invalid SPLC code. Use the SPLC helper. 
See above. 

You need to type at least the first three digits of the 
FSAC code followed by a ‘*’ to invoke the FSAC 
spelling helper. 

User gives less than 3 digits followed by a 
'*' in Geocode field to invoke FSAC helper.

Bad FSAC code: xxxxx 
Invalid FSAC code. Use the FSAC helper. 
See above. 

You need to type at least the first letter of the R260 
code followed by a ‘*’ to invoke the R260 spelling 
helper. 

Occurs in two situations: 
1) User gives just one alpha character in 
Geocode field. 2) User gives just '*' in 
Geocode field to invoke R260 spelling 
helper. 

Bad R260 code: xxxxx 
Invalid R260 code.  Use the R260 helper. 
See above. 

You need to type at least one letter of the 3-3-3 
station code followed immediately by an asterisk, 
and state abbreviation. 

Occurs in two situations: 
1) User gives less than 3 alpha characters 
in Geocode field. 2) User gives one 
character followed by a '*' and no state in 
Geocode field, to invoke 3-3-3 spelling 
helper.  

Bad 3-3-3 station code: 
Invalid 3-3-3 station code. Use the 3-3-3 
helper. See above. 

Bad state abbreviation: XY 
Invalid State. Press <F3> for a list of valid 
state abbreviations, or see Appendix A or B. 

Location/RR not found in Quanta-network. Report to ALK Technical Support. 

Stops are not ready to generate routes. 
User gives the origin and hits the 'Run' 
button. Stops/destination not given. 

Via stop is not valid. 
User gives invalid/incomplete geocode or 
station/state in Via field. 

Station name not found: 

User gives incorrect station but valid state 
abbreviation, or uses a comma between 
station name and state abbreviation 
(comma must be removed). Station name 
spelling should match Centralized Station 
Master registered name. Use the spelling 
helper (enter at least one letter of the 
station name, followed by an asterisk and 
the two-letter state abbreviation).  You may 
also contact ALK Technologies to obtain a 
list of registered names. 
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State abbreviation not found. 

Occurs in three situations: 
1) User gives incorrect state abbreviation 
with correct station name. 2) User gives 
incorrect station and state names. 3) User 
gives just the station name without state 
name. 
(Note: The last two characters are always 
recognized as the state abbreviation.) 

RR 'X' does not get to this location. 
(non-AutoRouter only) 

Occurs in three situations:  
1) User gives invalid RR name with a valid 
geocode or station/state name. 2) Railroad 
does not serve that geocode or station/state. 
3) Previous stop's RR does not get to the 
current stop. 

Inbound and Outbound Railroads do not junction at 
this location. 
(non-AutoRouter only) 

The junction interchange is not valid. Use 
the junction helper to find valid junction 
locations. 

Railroad stations are disconnected. 
(non-AutoRouter only) 

User deleted a necessary junction between 
two locations. Use junction helper to find a 
valid junction. 

  
EMAIL Messages SOLUTIONS 

Unable to load MAPI32.DLL, Error! 
DLL needed for sending a "Data 
Correction Email". Contact Technical 
Support. 

Cannot find MAPISendMail, Error! 
Program is unable to get the Process 
Address from DLL to send an email. 

Email has not been enabled with your 
PC*MILER|RAIL installation. 

Email has not been enabled on the user's 
PC. 

The specified attachment was not found. (self-explanatory message) 
The specified attachment could not be opened. (self-explanatory message) 
The type of a recipient was bad. (self-explanatory message) 
One or more unspecified errors occurred. (self-explanatory message) 
There was insufficient memory to proceed. (self-explanatory message) 
There was no default logon. (self-explanatory message) 
The text in the message is too large. (self-explanatory message) 
There are too many file attachments. (self-explanatory message) 
There are too many recipients. (self-explanatory message) 
A recipient did not appear in the address list. (self-explanatory message) 
The user canceled the process. (self-explanatory message) 
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CUSTOM PLACE Messages SOLUTIONS 

There is no data to print. 
Custom name list is empty and there are no 
items to print in the custom name list. 

MUST provide custom name and PC*MILER|Rail 
RR, Station State or Geocode. 

User has not provided either the custom 
name, or rail-road or station/state or 
geocode.  

Character '*' is not allowed in custom name. 
User searches for the custom name by 
giving "*". Do not use asterisk. 

Insufficient characters given for geocode lookup. 

Occurs in two situations:  
1) User gives less than 3 characters in 
Station ST field.  2) User gives one 
character followed by a '*' and no state in 
Station ST field, to invoke station/state 
spelling helper. 

Invalid place name (station/state or geocode not 
found). 

User gives invalid place name, station/state 
or geocode.  

Insufficient characters given for geocode lookup 
(in Geocode) 

User gives less than 3 digits followed by a 
"*" in geocode field to invoke SPLC 
helper. 

Bad location/railroad combination. 

This error occurs in two situations:  
1) User gives invalid RR name with a valid 
geocode or station/state name. 2) Railroad 
does not serve that geocode or station/state. 

  
RUN-TIME Messages SOLUTIONS 
Windows 7, XP, or Server 2008 displays the 
following message: “To help protect your 
computer, Windows has closed this program.” 

Follow these steps: 
Open the Start Menu 
Settings   
Control Panel   
System and Security 
System  
Advanced System Settings   
Advanced tab   
Performance Setting   
“Data Execution Prevention” tab   
Select “Turn on DEP for essential 
Windows programs and services only.” 
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Index 
 
 
3-3-3 location entry, 49 
3-3-3 search, 49 
 
A 

abbreviations list 
Mexican estados, 93 
states/provinces/estados, 32 
U.S. & Canada, 91 

adding new PC*MILER products, 23 
ALK Technologies, 86 
Auto Racks routing, 64 
AutoRouter, 37–39, 61–63 
 
B 

batch processing, 2 
Bulk commodity routing, 64 
 
C 

Canadian province abbreviations, 91 
car accounting, 45 
check for updates, 25 
Coal/Bulk routing, 64 
connectivity application, 2 
copying maps, 85 
custom station names, 57 
 
D 

data error correction, 53 
data error reporting, 25 
database for PC*MILER|Rail, 1 
deactivation, 24 
default options, 65 
delete station name, 51 
Detailed Geocode Report, 40, 75 
Detailed Route Report, 39 
disconnected railroad stations, 59 
duplicating a route, 70 
 
E 

error messages, 51, 132 
exclude/include railroads, 61 

 
F 

familized routing, 43–45 
framing in the map window, 83, 84 
FSAC location entry, 49 
FSAC search, 49 
fuel surcharge calculations, 94 
Fuel Surcharge routing, 64 
 
H 

haulage rights, 83 
Help files, 25 
 
I 

include/exclude railroads, 37, 61, 64 
insert/delete station names, 51 
inter-line route, 41 
Intermodal routing, 64 
Intermodal-Only Stations include/exclude, 

64 
 
J 

joint ownership of rail lines, 83 
Junction Helper, 58, 60 
 
K 

kilometers/miles, 64 
 
L 

Label RRs button, 81 
Label Stations button, 81 
license agreement, 1 
licensing information, 6 
 
M 

map labels, adding, 81, 83 
map window, 39, 78–85 

adding labels to the map, 81 
framing in, 84 
hiding/displaying features in, 79 
picking stops from, 79 
railroad display in, 82 
redrawing, 84 
shape points in, 84 
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zooming, 79 
menus 

File menu, 27 
Help menu, 32 
Reports menu, 30 
Tools menu, 30 
Windows menu, 31 

Mexican estados, 93 
mileage, 36, 38, 59, 73 

breakdown by railroad, 73 
breakdown by state, 73 

miles/kilometers, 64 
multiple freight stations, 47 
multi-user license, 1 
 
N 

new product installation, 23 
new route, 36 
 
O 

Options dialog box, 36, 63 
options, default, 65 
override files, 53 
ownership of rail lines on map, 83 
 
P 

PC*MILER|Rail-Connect, 2 
picking stops from the map, 79 
Practical route, 64 
printing a report, 77 
printing maps, 85 
printing routes, 36, 72 
 
R 

rail network, 1 
Railroad Display Control dialog, 82 
railroads 

display on map, 82 
including/excluding, 37, 61, 64 
ownership, 83 

railroads sorted by name, 113 
railroads sorted by SCAC, 95 
rate division calculations, 45 
redrawing the map, 84 
report memos, adding, 64 

reports, 73 
printing, 77 

requirements, 5–6 
right mouse button, 76 
route calculation, 42 
route duplication, 70 
route entry, 34–35, 37, 45–52 
route options, 36 
Rule 260 location entry, 50 
Rule 260 search, 50 
Run button, 36 
 
S 

saving a report, 77 
saving/loading routes, 70 
SCAC entry, 48 
SCAC list, 95 
SCACs listed, 32 
shortcut keys, 33 
Shortest route, 64 
single line route, 41 
spelling help, 46 
SPLC location entry, 47 
SPLC search, 48 
state/province/estado abbreviations, 32 
station-state location entry, 46 
switch move only railroads, 64 
system requirements, 5–6 
 
T 

TCP/IP, 2 
technical support, 25 
Terminal Switch RRs, 64 
trackage rights, 83 
 
U 

uninstalling, 24 
 
W 

window positioning, 31 
 
Z 

zooming the map view, 79 
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NOTES: 


